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Introduction 
 

Thanks for choosing the MPC Live. Fusing Akai Professional’s legendary MPC layout and workflow with multi-core 
processing power, MPC Live is an unrivaled instrument for music production. 

Introducing a new approach to music production with an ultra-fast and super-intuitive workflow, the MPC Live is 
powered by a radiant 7” color multi-touch display. Literally grab and pinch waveforms, draw midi events, adjust 
envelopes, chop samples, add effects and precisely set your controls using your fingertips. Combined with the 
classic MPC feel, sound and vastly improved pads, the MPC Live embodies the best elements of our past while 
taking music production tech into the future. 

 

Welcome to the MPC family. 

Akai Professional  

 
 
System Requirements & Product Support 
 

For the latest information about this product (system requirements, compatibility information, etc.) and product 
registration, visit akaipro.com. 

For additional support, visit akaipro.com/support. 

 
 
About This User Guide 
 

This manual should help you get familiar with using the MPC Live. For consistency, the terminology throughout is 
based on the MPC parameter names. We also used specific formatting to indicate particular topics of significance: 

 

Important/Note/Tip: Important or helpful information on a given topic. 

 

Names of buttons, controls, parameters, settings, and other options are written in bold characters throughout the manual. 

Examples: Press the Play Start button. 

Turn Q-Link Knob 4. 

Tap the Mute button. 

The Velocity ranges from 0 to 127. 

Set the Sample Play selector to One Shot. 

Tap BPM, and then use the numeric keypad to enter a 120 as the tempo. 

 

Some parts of this manual refer to other relevant chapters or sections, which are cited in bold, italic blue characters. 
Click the text to skip immediately to that section. 

Examples: Read the Important Notes section before proceeding. 

For more information about installing the necessary drivers and software, please see the Installation 
section. 

To learn more about using send effects, see General Features > Effects > Send/Return Effects. 

http://www.akaipro.com
http://www.akaipro.com/support
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Important Notes 
 

Read the included safety & warranty manual before using MPC Live. 

Before getting started and connecting devices to MPC Live or turning the hardware on/off, make sure all devices are 
switched off. 

To use MPC Live in Controller Mode (to control the MPC software): 

Before installing the MPC software, make sure your computer meets the system requirements described at 
akaipro.com. This applies whether you’ll use MPC software as your host software or as a plugin in another digital 
audio workstation (DAW). 

Before connecting MPC Live to your computer, install the drivers and software. Visit akaipro.com to download the 
latest versions. Refer to the Installation section for more information. 

 
 
Setup 
 
1. Connection 
 

Here is just an example of how to use MPC Live in your setup. Items not listed under Introduction > Box Contents 
of your included quickstart guide are sold separately. 

 

 
 
 
 
 

Remember to remove the protective film from the MPC Live touchscreen! 

To use MPC Live in Standalone Mode, just power it on! If this is the first time you’re using MPC Live, its battery will 
be only partially charged. We recommend connecting it to a power outlet, using the included power adapter, to 
charge it fully. You can use MPC Live as its battery charges. 

Note: We highly recommend checking akaipro.com for any available updates to the MPC Live software/firmware 
and/or drivers. 

To use MPC Live in Controller Mode, continue to Step 2. Installation. 

Computer TurntablePowered Monitors Power (optional)

SD Card USB 
drive

http://www.akaipro.com
http://www.akaipro.com
http://www.akaipro.com
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2. Installation 
 

To use MPC Live in Controller Mode (to control the MPC software), follow these steps to download and install 
the required drivers & software: 

 

1. Go to akaipro.com and register your product. If you don’t have an Akai Professional account yet, you will be 
prompted to create one. 

2. In your Akai Professional account, download the MPC software package. 

3. Open the file and double-click the installer application. 

4. Follow the on-screen instructions to complete the installation. 

Note: By default, the MPC software will be installed in [your hard drive]\Program Files\Akai Pro\MPC (Windows®) 
or Applications (Mac® OS X®). You can also create a shortcut on your Desktop. 

 

 

3. Getting Started 

 

1. Power on MPC Live. 

2. On your computer, open the MPC software. 

3. Follow the on-screen instructions to authorize your version of MPC. 

4. You will need an iLok account and iLok License Manager to complete this. You can create an account and 
download the license manager at ilok.com. 

Make a note of the PACE code in your account, and enter it when asked for it during the authorization/unlock 
process. 

5. On MPC Live, check the upper-right corner of the touchscreen: 

• If there is a monitor/cable icon under the battery icon, then MPC Live is already in 
Controller Mode. Continue to Step 6. 

• If there a chip icon under the battery icon, then MPC Live is in Standalone Mode. 
Follow these steps: 

i. Press Menu to enter the Menu. 

ii. Tap the MPC chip icon in the upper-right corner. 

iii. In the Enter Controller Mode window that appears, tap Controller Mode. 
Looking for computer may appear briefly in the touchscreen before MPC 
Live recognizes the USB connection as a controller. 

6. In the MPC software, click the Edit menu, and select Preferences. Click the Audio tab and select the sound 
card you want to use. Click OK when you are done. 

Important:  

We highly recommend using your MPC Live’s sound card (Akai Pro MPC Live ASIO). If you need to use the internal 
sound card on a Windows computer, we recommend downloading the latest ASIO4ALL driver at asio4all.com. 

To view the MPC software user guide, click the Help menu and select MPC User Manual. 
 

 

http://www.akaipro.com
http://www.ilok.com
http://www.asio4all.com
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Features 
 

This chapter explains the features and functions of your MPC Live. 

 
 
Top Panel 
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1. Touchscreen: This full-color multi-touch display shows information relevant to MPC Live’s current operation. 

Touch the display (and use the hardware controls) to control the MPC interface. See the later Touchscreen 
section to learn how to use some basic functions. 

2. Data Dial: Use this dial to scroll through the available menu options or adjust the parameter values of the 
selected field in the touchscreen. Pressing the dial also functions as an Enter button. 

3. Q-Link Knobs: Use these touch-sensitive knobs to adjust various parameters and settings. The knobs can control 
one group of parameters at a time. The lights below the Q-Link button indicate the currently selected column of Q-
Link knobs. Press the Q-Link button to change which parameter or group of parameters they currently control. 

4. Q-Link Button: Press this button to change which parameter or group of parameters the Q-Link knobs currently 
control (indicated by the lights above the Q-Link knobs). Each press will select the next column of Q-Link knobs. 

Press and hold Shift and then press this button to select the previous column of Q-Link knobs instead. 

Press and hold this button to show the QLink window over the touchscreen’s current contents. These are the same 
parameters and settings as what is shown in Q-Link Edit Mode. You can tap Q-Link Edit at the bottom of the 
window to enter Q-Link Edit Mode immediately (see Operation > Modes > Q-Link Edit Mode to learn about this). 

5. Pads: Use these pads to trigger drum hits or other samples. The pads are velocity-sensitive and pressure-
sensitive, which makes them very responsive and intuitive to play. The pads will light up different colors, 
depending on how hard you play them (ranging from yellow at a low velocity to red at the highest velocity). You 
can also customize their colors. 

6. Pad Bank Buttons: Press any of these buttons to access Pad Banks A–D. Press and hold Shift while pressing 
any of these buttons to access Pad Banks E–H. Alternatively, double-press one of these buttons. 

7. Note Repeat/Latch: Press and hold this button, and then press a pad to trigger that pad’s sample repeatedly. 
The rate is based on the current tempo and Time Correct settings. 

Press and hold Shift and then press this button to “latch” the Note Repeat feature. When latched, you do not 
have to hold the Note Repeat button for it to be activated. Press Note Repeat once more to unlatch it. 
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8. Full Level/Half Level: Press this button to activate/deactivate Full Level. When activated, the pads will always 
trigger their samples at the maximum velocity (127), regardless of the amount of force you use. 

Press and hold Shift and then press this button to activate/deactivate Half Level. When activated, the pads will 
always trigger their samples at half-velocity (64). 

9. 16 Level: Press this button to activate/deactivate 16 Level. When activated, the last pad that was hit will be 
temporarily copied to all 16 pads. The pads will now output the same note number as the initial pad, but a 
selectable parameter will be fixed at values that increase as the pad numbers increase (e.g., Pad 1 is the 
minimum, Pad 16 is the maximum), regardless of how hard you press them. In the screen that appears, use the 
Type selector to choose the parameter: Velocity, Tune, Filter, Layer, Attack, or Decay. See Operation > 
General Features > 16 Level to learn more. 

10. Erase: As a Sequence is playing, press and hold this button and then press a pad to delete the note event for 
that pad at the current playback position. This is a quick way to delete note events from your sequence without 
having to stop playback. See Operation > General Features > Erase to learn more. 

11. Shift: Press and hold this button to access some buttons’ secondary functions (indicated by grey writing). 

Double-press this button to see which buttons have secondary functions—the buttons will flash for a few 
seconds. 

12. Menu/Browse: Press this button to open the Menu. You can tap an option in the Menu to enter that mode, view, etc. 

Press and hold Shift and then press this button to view the Browser. You can use the Browser to locate and 
select programs, samples, sequences, etc. 

13. Main/Track: Press this button to enter Main Mode. 

Press and hold Shift and then press this button to enter the Track View. 

14. Undo/Redo: Press this button to undo your last action. Hold down Shift and press this button to redo the last 
action you undid. 

15. Copy/Delete: Press this button to copy one pad to another. When the From Pad field is selected, press the 
“source” pad (the pad you want to copy). When the To Pad graphic (of all pads) is selected, press the 
“destination” pad. You can select multiple destination pads, and you can select pads in different pad banks. Tap 
Do It to continue or Cancel to return to the previous screen. 

Press and hold Shift and press this button to delete. 

16. –/+: Press these buttons to decrease/increase the value of the selected field in the touchscreen. 

17. Play: Press this button to play the sequence from the audio pointer’s current position. 

18. Play Start: Press this button to play the sequence from its start point. 

19. Stop: Press this button to stop playback. You can double-press this button to silence audio that is still sounding 
once a note stops playing. Quickly pressing this button three times will act as a “MIDI panic” and shut off all 
voices and stop all audio processing. You can also press this button to abort the loading any files that are being 
loaded (e.g., if you select a project or program by accident). 

20. Rec: Press this button to record-arm the sequence. Press Play or Play Start to start recording. Recording in this 
way (as opposed to using Overdub) erases the events of the current sequence. After the sequence plays through 
once while recording, Overdub will be enabled. 

21. Overdub: Press this button to enable Overdub. When enabled, you can record events in a Sequence without 
overwriting any previously recorded events. You can enable Overdub before or during recording. 

22. Tap Tempo: Press this button in time with the desired tempo to enter a new tempo (in BPM). 
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Touchscreen 
 
Here is some general information about how to use the MPC Live touchscreen: 
 
 

 
 

x2

Tap a button or option to select it. Use the data dial or 
–/+ buttons to change its setting or value 

Double-tap a button to access advanced editing 
options. In some cases, this will show a numeric keypad
that you can use to enter a value (an alternative to the 
data dial or –/+ buttons). Tap the upper-left part of the
touchscreen to return to the previous view. 

 

 
 

 
 

Spread two fingers to zoom in (into a section of a
waveform, for example). Pinch two fingers to zoom out.
 

The top of the touchscreen shows the toolbar, which 
contains information about the current view (often the
name of the current track, sequence, audio pointer
position, etc.). Tap an item to select it. 

The bottom of the touchscreen shows various buttons that 
you can use in the current view. Tap a button to press it. 

To return to a previous view, either tap outside of the 
window currently in the touchscreen or tap the left 
arrow () in the upper-left part of the touchscreen. 
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Rear Panel 
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1. Power Input: Use the included power adapter to connect MPC Live to a power outlet. 

2. Power Switch: Turns MPC Live’s power on/off. 

3. Charging Indicator: This light (behind the vent) will turn on when MPC Live’s internal battery is charging (when 
the power input is connected to a power outlet). When the battery is fully charged or when it is disconnected 
from a power outlet, then this light will turn off. 

4. USB-B Port: Use the included USB cable to connect this USB 3.0 port to an available USB 3.0 port on your 
computer. This connection allows MPC Live to send/receive MIDI and audio data to/from the MPC software on 
your computer. It also allows any connected USB drives, SD cards, and drives connected to the internal SATA 
port to mount on your computer (i.e., your computer can access these storage devices that are connected to 
your MPC Live). 

5. USB-A Ports: Connect USB flash drives to these USB ports to access their files directly using MPC Live. MPC Live 
supports read and write capability for exFAT, FAT32, NTFS, and EXT4 file systems a well as read-only capability for 
HFS+ file systems. (We recommend using an exFAT file system as it is the most robust one supported by both 
Windows and Mac OS X.) 

6. SD Card Slot: Insert a standard SD/SDHC card into this slot to access its files directly using MPC Live. 

7. Rec Vol: Turn this knob to adjust the volume of the inputs. 

8. Master Vol: Turn this knob to adjust the volume of Outputs 1/2 and the phones output. 

9. Inputs (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TRS cables to connect these inputs to an audio source 
(mixer, synthesizer, drum machine, etc.). In Sample Record Mode, you can select whether you want to record 
either channel or both channels in stereo or in mono. To use these inputs, set the Line/Phono switch to Line. 

10. Inputs (RCA): Use a standard RCA stereo cable to connect these inputs to a phono-level audio source like a 
turntable. In Sample Record Mode, you can select whether you want to record either channel or both channels in 
stereo or in mono. To use these inputs, set the Line/Phono switch to Phono. 

11. Line/Phono Switch: Set this switch to the appropriate position, depending on which inputs you want to use. If 
you are using the RCA inputs, set this switch to Phono to provide the additional amplification needed for phono-
level signals. If you are using the 1/4” (6.35 mm) inputs, such as a keyboard or a sampler, set this switch to Line. 

12. Grounding Terminal: If using phono-level turntables with a grounding wire, connect the grounding wire to these 
terminals. If you experience a low “hum” or “buzz”, this could mean that your turntables are not grounded. 

Note: Some turntables have a grounding wire built into the RCA connection and, therefore, nothing needs to be 
connected to the grounding terminal. 

13. Outputs (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TRS cables to connect these outputs to your monitors, 
mixer, etc.). The Master L/R outputs are the same as Outputs 1/2. 

14. Phones (1/8” / 3.5 mm): Connect standard 1/8” (3.5 mm) stereo headphones to this output. 

15. MIDI In: Use a standard 5-pin MIDI cable to connect this input to the MIDI output of an external MIDI device 
(synthesizer, drum machine, etc.). 

16. MIDI Out: Use a standard 5-pin MIDI cable to connect this output to the MIDI input of an external MIDI device 
(synthesizer, drum machine, etc.). 

17. Kensington® Lock Slot: You can use this slot to secure your MPC Live to a table or other surface. 
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Tutorial / Basic Concepts 
 
This chapter should help you to familiarize yourself with some basic features in MPC Live. To get the most out of this 
chapter, we recommend reproducing each of the described steps. 

Important:  
MPC Live’s four Q-Link knobs control up to four parameters at a time—up to 16 within each screen. Whenever this 
manual instructs you to use the Q-Link knobs to adjust parameters, you can use the Q-Link button (above the Q-
Link knobs) to move through the four columns of four Q-Link knobs. 

Press and hold the Q-Link button to see an overview of all 16 Q-Link knobs and their parameters. You can then tap 
any column of knobs to select those four Q-Link knobs, and then release the Q-Link button. 

On the following pages we will create a short song to show you some of MPC Live’s most important features. 

 
 
Starting Up 
 
Make sure you have completed all of the steps described in Introduction > Setup. This includes: 

• Installing the most current drivers and software. 

• Connecting your MPC Live to a power source using the included power adapter and powering it on.  

• Opening and authorizing your MPC software. 

 
 
Creating a Drum Kit 
 
Let’s start by making a simple drum kit. 

 
Press Shift+Menu/Browse to show the Browser. Then, use the 
touchscreen to navigate to where your drum sounds are located: 

• To browse your files by location, tap Places on the 
left side of the touchscreen. Internal is the MPC Live’s 
internal drive. MPC Documents is a shortcut to the 
MPC Documents folder on the internal drive. If you 
have USB drives connected to MPC Live’s USB ports, 
they will appear in this column, as well. 

Important: MPC Live supports read and write capability 
for exFAT, FAT32, NTFS, and EXT4 file systems as well 
as read-only capability for HFS+ file systems. (We 
recommend using an exFAT file system as it is the most 
robust one supported by both Windows and Mac OS X.) 

• To browse your files by type, tap Content and then tap 
the type of file: Drums, Instruments, Clips, Samples, 
Demos, or My Files. 

• To move up one folder level, tap the folder/ icon in 
the upper-left corner. 

• To move through a list, swipe up or down, turn the 
data dial or use the –/+ buttons. 

• To select a file or folder, tap it once. 

• To enter a folder, double-tap it or tap Open in the 
lower-right corner. Alternatively, press the data dial to 
enter a selected folder. 

• To load a selected file, double-tap it, tap Load, or 
press the data dial. If the file is a sample, it will be 
loaded to the project’s sample pool. If the file is a 
project, it will be loaded in its entirety (you will be asked 
if you want to close your current project). 

• To load all files in a selected folder, press and hold 
Shift and then tap Load All in the lower-right corner. 
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• To delete a selected file, press and hold Shift and then tap Delete File at the bottom of the touchscreen. 

• To preview a selected sound, tap and hold Play () at the bottom of the touchscreen. 

• To enable or disable the audition function and set its volume level, tap Audition at the bottom of the 
touchscreen. In the screen that appears, tap Auto to enable or disable it, and tap and drag the level slider 
up or down to set the volume level. Tap Audition once more to hide the window. 

• To show the information for the current drive, press and hold Shift and then tap Drive Info at the bottom of 
the touchscreen. The drive’s information will appear in a new window. Tap OK to return to the previous screen. 

 

After loading samples for a drum kit into the sample pool, use 
the Sample Assign tab to assign a kick drum sound to a pad: 

1. Tap Sample Assign at the bottom of the touchscreen. 
This lets you view the pads and project’s sample pool. 

2. Press Pad 1 or tap Pad 1 in the touchscreen to select it. 
The pad will be lit green. 

3. Swipe the Sample Pool list up or down or use the data 
dial or –/+ buttons to move through it. 

4. To load a sample to the selected pad (Pad 1, in this 
case) tap it in the Sample Pool list or press the data dial. 
Now, you can press Pad 1 to play the kick drum sample. 

 

To create a simple drum kit, repeat the above steps for 
other pads. We recommend loading a snare drum, a closed 
hi-hat, and an open hi-hat. 

 
 
Creating a Drum Sequence 
 

Now that your drum kit is set up, let’s record a drum sequence. 

 

1. Press Menu to enter the Menu, and then tap Grid View. 

2. Press Tap Tempo repeatedly at the speed you want to 
record your sequence. MPC Live will detect the rate and 
adjust itself automatically. 

3. Press the Rec button to activate Record Mode. 

4. Press the Play button to start the actual recording. The 
pre-count will count one measure before MPC Live 
starts to record. We recommend recording only one 
sound (pad) at a time, especially if you are not familiar 
with playing drums on the pads. 

5. Play a simple bass drum pattern. The note events you 
just recorded will automatically be placed in the grid (in 
this case, on 16th notes). The initial measure length is 
two bars. After the two bars, the recording will enter 
Overdub Mode automatically; the sequence plays again 
from the beginning and keeps looping, allowing you to 
record further notes. Don’t stop the recording! 

6. Play the snare drum part, then a hi-hat part. 

7. When you’re done recording, press the Stop button. 

 

If you start recording again on this sequence, keep in mind that the pads you play in your new recording will automatically 
replace existing notes played with the same pads. To prevent this, you can start again from Step 1 but press the Overdub 
button instead of the Rec button. Overdub lets you record additional note events over the existing Sequence. 

The Undo button functions differently while in Record Mode. Normally, pressing Undo will undo just the last event. 
When there is an event to undo, the Undo button will be lit solid. While recording, the Undo button will flash. In this 
case, pressing Undo will erase all events from that recording (i.e., since Play or Play Start was pressed). 
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Saving & Renaming 
 

We recommend doing some renaming of your programs and samples before going further.  

The collection of drum samples you loaded earlier (and their respective pad assignments) are arranged into a 
program. When you load this program in the future, you will be able to use all of the samples that belong to it. 

Let’s rename the exisiting program as we’ll want to create more programs later on. 

 

To rename a program: 

1. Press Main to enter Main Mode. 

2. In the Program section in the lower part of the touchscreen, 
tap the cursor icon on the right edge. 

3. Use the virtual keyboard that appears to enter a new name 
(e.g., Drums), and then tap Do It. 

 

 

 

 

To rename your samples: 

1. Press Menu to show the Menu, and tap Sample Edit to enter Sample Edit Mode. 

2. The Sample field at the top of the touchscreen will show the name of a sample. Select a sample in one of the 
following ways: 

• When the Sample field is selected, use the data dial or –/+ buttons to change it. 

• Double-tap the Sample field and tap one in the list that appears. 

3. Tap the keyboard icon next to it to rename the current sample. 

4. Use the virtual keyboard that appears to enter a new name (e.g., Kick, Snare, etc.), and then tap Do It. 

Repeat Steps 2–4 to rename other samples. 

 

Now would be a good time to save your project. 

To save your project, press Menu to show the Menu, and tap 
the disk icon at the top of the touchscreen to open the Save 
window. In the Save window, do any of the following: 

To select the storage device you want to view, tap it in the 
Storage column on the left. Internal is the MPC Live’s 
internal drive. MPC Documents is a shortcut to the MPC 
Documents folder on the internal drive. If you have USB 
drives connected to MPC Live’s USB ports, they will appear 
in this column, as well. 

To enter a folder, double-tap it. Alternatively, turn the data 
dial or use the –/+ buttons to move through the list, and press 
the data dial to enter a folder. You can also tap one of the five 
folder buttons in the upper-right to jump immediately to those 
pre-assigned file paths (see Operation > Modes > Browser 
to learn how to do this). 

To create a new folder, tap New Folder, use the virtual keyboard that appears to enter a name, and then tap Do 
It. You will immediately enter the new folder. 

To move up one folder level, tap the folder/ icon. 

To name the file, tap the File Name field at the bottom of the touchscreen, and use the virtual keyboard that appears. 

To save the file, tap Save. 

To cancel and return to the Menu, tap Cancel. Alternatively, tap the  icon in the upper-left corner. 
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Editing Note Events 
 

In the grid, you can see your recorded notes 
(or note events) as a sequence. 

To enter Grid View, press Main, and then 
tap the grid icon on the left edge of the 
touchscreen. 

 

 

 

 

 

 

 

 

In the Grid View, you can do any of the following: 

• To zoom in or out, tap the magnifying-glass icon in the upper-right corner. Then, in the grid, spread two 
fingers apart or pinch two fingers together. You can do this for each axis, horizontal or vertical. 

• To automatically set the grid to view one pad bank and two bars, tap the grid-and-magnifying-glass 
icon in the lower-left corner. 

• To undo your last action, press Undo. 

• To redo the last action you undid, press Shift+Undo/Redo. 

• To enter a note, tap the pencil icon in the upper-right corner. Then, in the grid, tap a square. 

• To delete a note, tap the eraser icon in the upper-right corner. Then, in the grid, tap a note. 

• To select a single note, tap the select box in the upper-right corner. Then, in the grid, tap the note. 

To select all notes for a pad, press the desired pad. 

• To move the selected notes, tap Nudge at the bottom of the touchscreen, and then use the data dial or –
/+ buttons to shift the notes left or right. By default, you can position notes only by quantization values 
defined by the Time Correct value (learn about this feature in Operation > Modes > Main Mode). 

To move the selected notes without restricting (“snapping”) them to the quantization grid, tap and hold 
Don’t Snap in the lower-left corner of the touchscreen, and then use the data dial or –/+ buttons to shift the 
notes. In this case, each nudge is equivalent to four ticks. 

• To adjust the start point or end point of the selected notes (without changing their position), tap Edit 
Start at the bottom of the touchscreen, and then use the data dial or –/+ buttons. 

• To transpose the selected notes up or down, tap Transpose at the bottom of the touchscreen, and then 
use the data dial or –/+ buttons. 

• To switch to the previous or next track, press and hold Shift, and then tap Track – or Track + (respectively) 
at the bottom of the touchscreen. 

• To mute or solo the track, press and hold Shift, and then tap Mute or Solo (respectively) at the bottom of 
the touchscreen. 

• To open the Timing Correct window, press and hold Shift, and then tap TC at the bottom of the 
touchscreen. This feature is described in Operation > Modes > Main Mode. 

• To adjust the metronome settings, press and hold Shift, and then tap Click at the bottom of the 
touchscreen. This feature is described in Operation > Modes > Main Mode. 

• To adjust the velocity of the selected notes, tap Velocity at the bottom of the touchscreen, and then use 
the data dial or –/+ buttons. The numeric value will appear on the screen. 

• To show or hide the velocity lane, tap the up arrow (∧) button in the lower-right corner of the touchscreen 
to show the velocity lane below the grid. Each note’s velocity is represented by a vertical bar. The higher and 
more red the bar is, the higher the velocity is.  

Tap the up arrow (∧) button once more to show a taller version of the velocity lane after which it will turn into 
a down arrow (∨) button, which you can then tap to hide the velocity lane. 
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Making Basic Sound Edits 
 

Let’s make sure the samples are properly tuned and have good levels. 

Press Menu, and then tap Program Edit to enter Program Edit Mode. 

 

Press a pad to show its parameters in the touchscreen. 

To adjust its volume, tap and drag the Volume knob up 
or down. Alternatively, use the data dial or –/+ buttons. To 
make finer adjustments, double-tap the knob and adjust 
the larger version that appears. Tap anywhere else to 
return to the previous screen. 

To adjust its stereo panning, tap and drag the Pan knob 
up or down. Alternatively, use the data dial or –/+ buttons. 
To make finer adjustments, double-tap the knob and 
adjust the larger version that appears. Tap anywhere else 
to return to the previous screen. 

Adjust the level of each pad to suit your taste. We 
recommend spreading the panning of the bright sounds 
(e.g., cymbals, snare drum) a little. Additionally, you can tune 
the bass drum sound—tap the Samples tab so the first 
square under it is lit, and then adjust the Semi and Fine 
knobs next to the sample name. 

 

The snare drum may need some reverb to give it a more spatial sound.  

Tap Effects at bottom of the touchscreen to view the Insert Effects tab. Press the pad with your snare drum sound 
to select it. 

 
 
To add an effect: 

1. Double-tap the desired slot. A list of effects will appear.  

2. Swipe up or down to move through the list. 

3. To load an effect, double-tap it. Alternatively, tap it 
once and then tap Select or push the data dial. Let’s try 
Reverb Medium. 

4. To close the list, tap Close. 

 

To adjust the effect’s parameters, tap the pencil icon. 

To empty the effect slot, tap the trash can icon. Switch 
the effect on or off by tapping the On/Off button for the slot.  
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Creating a Bass Track 
 

Let’s try recording a bass line. Unlike a drum kit, it’s important to be able to play and record a bass sound 
chromatically, so this will be slightly different than setting up the drum kit. 

Adding a bass line over the drum part means we need to work on a new track. A track is simply a layer of a sequence. 
Each track uses a program within your project. You can work with multiple tracks in a single sequence (e.g., a drum 
track, a bass track, a piano track, etc.). When you play the sequence, all of them will play simultaneously.  

 

First, let’s make an empty track. 

 

To select a new track:  

1. Press Main to go back to Main Mode. 

2. Double-tap the Track field in the center-left part of the 
touchscreen, and then tap Track 2 (unused) in the list of 
tracks that appears. 

Alternatively, simply tap the Track + button at the 
bottom of the touchscreen until (unused) appears in the 
Track field. 

 

 

 

 

Let’s create a new program for this track to use. 

 

To create a new program:  

1. In the Track section in the middle of the touchscreen, 
tap the piano-keys icon. This will create a keygroup 
program for this track, which is necessary to play the 
bass sound chromatically with the pads. 

2. The Program field in the lower part of the touchscreen 
will display a new program name. 

3. In the Program section in the lower part of the 
touchscreen, tap the cursor icon on the right edge. 

4. Use the virtual keyboard that appears to enter a new 
name, and then tap Do It. 
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To load and edit a bass sound: 

1. Press Shift+Menu/Browse to show the Browser. Then, 
use the touchscreen to navigate to where your bass 
sounds are located, and load one to the project’s 
sample pool. (You can look at this earlier section if 
you forgot how to do this!) 

2. After loading a bass sample to the sample pool, don’t 
use the Sample Assign tab like you did when creating 
a drum program; keygroup programs are different. 

Instead, press Menu to view the Menu, and tap 
Program Edit to enter Program Edit Mode. 

3. In Program Edit Mode, tap the Samples tab at the 
bottom of the touchscreen to show the four layers of 
samples in the program. 

4. Double-tap the first Layer field and then tap your bass 
sample in the list on the left. Because you’re working 
with a keygroup program instead of a drum program, 
this sample is now playable across all pads. 

Tip: On your MPC Live, press the Pad Bank D button 
to switch to Pad Bank D and press Pad 13. You 
should hear the bass sample played back with its 
original pitch. You can use the other pads to play your 
sample chromatically.  

 

Let’s add a second layer and set the layers’ velocity 
ranges so the bass will sound different when played at a 
higher velocity (as a real bass would): 

1. Press Shift+Menu/Browse to show the Browser, select 
a different bass sample that sounds similar but a little 
bit brighter, and load it to the project’s sample pool. 

2. Return to Program Edit Mode, and in the Layer tab, 
double-tap the second Layer field, and select the new 
bass sample. Press a pad to hear both samples will 
sound at once. Maybe this new sound is interesting as 
it is, but let’s make some quick edits to get as close as 
we can to a real-life bass sound. 

3. Tap the Pan Velocity tab to show its parameters. 

4. Tap Layer 1’s Vel End knob and turn the data dial to 
set it to 80. Do the same to set Layer 2’s Vel Start 
slider to 81. 

Now when you press a pad, the lower velocities (0–80) 
will trigger the Layer 1 sample only, while higher 
velocities (81–127) will trigger the Layer 2 sample only. 
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Let’s record that bass line now. Prepare your recording as 
described earlier, and record some bass notes. You can 
edit your recording just like we’ve done earlier. 

 

 

 

 

 

 

 

 

Once you’ve recorded it, let’s tweak the sound a bit in the 
Filter section: 

1. In Program Edit Mode, tap the Filter Env tab to show 
its parameters. 

2. Double-tap the Type drop-down menu, and select a 
filter. Let’s try working with Lowpass 4 Pole. 

3. Tap the Cutoff or Reso (resonance) knob, and turn the 
data dial to adjust their settings until your bass sample 
sounds good to you. 

4. In the Amp Envelope section, tap the Attack or 
Release knob, and turn the data dial to adjust their 
settings. These control the overall level characteristics 
of the sound. 

 

 

Do you want to add an effect? Do this in the Effects tab: 

1. Tap the Effects tab to show the insert effects. 

2. Double-tap one of the Inserts slots to show a list of available effects. 

3. Double-tap the effect you want to add to your bass line, or click Close to cancel. 

To adjust the settings of the effect, click the pencil icon next to its slot to open a window that shows its 
parameters.  

To activate or deactivate all insert effects for that program, click the All On/All Off button in the upper-right 
corner. 

 

So far, we’ve created a simple drum sequence and a bass line to go with it. Repeat this process to create a second 
sequence. 
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Recording an Audio Track 
 

We’ve already created some MIDI tracks, so let’s record some actual audio for our next track: 

 

1. Press Main to go back to Main Mode. 

2. Tap the Audio tab at the bottom of the touchscreen. 
Audio 001 will appear in the Track field. 

3. If the channel strip is not already shown on the left 
side of the screen, tap Input Config (in the lower 
part of the touchscreen) or the small eye icon (in 
the upper-left part of the touchscreen) to show it. 

4. Connect a synthesizer or other line-level audio 
source to the 1/4” (6.35 mm) input/inputs on MPC 
Live’s rear panel, and set the Line/Phono selector 
to Line. 

5. Double-tap the first field (Input __) and select 
Input 1 or Input 1,2 (depending on your audio 
source) as the input source. 

6. If the second field is not set to Out 1,2, double-tap 
it and select that option as the output. 

7. Tap the Monitor button to cycle through its three states until it reads Auto (you will hear incoming audio while 
the track is record-enabled only). 

8. Turn the Rec Vol knob to set the input level while playing your audio source. You should now see the level in the 
meter. Make sure it does not exceed the maximum level (the meter should not be “peaking” constantly). 

9. If the Solo and Mute buttons are on, tap them so they are off. Also, tap the track automation button below 
them so it is off (not R/Read or W/Write). 

10. Tap the Rec Arm button next to the pan knob to record-enable the track. 

11. Press Rec or Overdub to record-arm MPC Live. 

12. To start recording, press Play or Play Start—then play your audio source! You should hear your existing 
sequence playing in the background. 

To stop recording, press Stop. 

 

Record another audio track for your other sequence: Select the other sequence in Main Mode, and create another 
audio track (Audio 002) to go with that sequence. 
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Creating a Song 
 

This section explains how to make a song out of your 
sequences. Before starting, make sure that you have 
recorded some sequences (which we described earlier). 

To enter Song Mode, make sure playback is stopped, 
press Menu, and then tap Song. You’ll see each of the 
sequences you’ve created in this project assigned to a 
pad. The sequence playlist is to the left of the pads. 

As a song plays, it moves through each step of the 
sequence playlist. Each step contains a sequence you 
assigned. 

Each step can be repeated, determined by the value in 
the Repeat column (the repeat icon). A Repeat value of 
1 means the sequence will play through only once. The 
Bars column on the right indicates the length of that 
step: [the number of bars in the sequence] x [the number 
of times it repeats]. 

Each step can be set to play its sequence at an independent tempo, determined by the value in the BPM column. 

Important: Each sequence has its own tempo, while the project itself may use a different master tempo. The BPM value 
for each sequence may be different from the master tempo. As long as playback is set to follow the master tempo, each 
sequence’s individual tempo will be ignored. By default, each project is set to use the sequence tempo, which you set 
back in the Creating a Drum Sequence chapter. We recommend tapping the Seq/Mst button at the top of the 
touchscreen (so the button displays Mst) and entering a master tempo to ensure all sequences use the same tempo. 

 

To insert a step at the current position, tap Insert. 

To delete the currently selected step, tap Delete. 

To set which sequence plays for a step, tap the step’s Sequence field, and then turn the data dial to select a 
sequence. 

To set how many times a sequence repeats, tap the step’s Repeat field (next to the sequence name), and then 
turn the data dial to select a number. 

 

 

Exporting the Song 
 

Want to share your new song? Just export it first. 

 

To export a song: 

1. While in Song Mode, tap Export at the bottom of 
the touchscreen.  

2. In the Audio Mixdown screen that appears, do the 
following: 

• Make sure the Start field is set to 1, and set 
the End field to the last bar of your song. 

• Tap the Audio Tail field and turn the data 
dial to set it to 2 seconds. 

• As you’ll likely share the song online, tap the 
mp3 file format option in the lower-left corner. 

3. Tap Export. Choose where you want to save the song. 

To name the song, tap the File Name field, and 
use the virtual keyboard that appears to enter a new 
name, and then tap Save to start exporting. 
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Other Features Explained 
 

This chapter describes various advanced features. For a fuller explanation of these features, please refer to their 
corresponding sections in the Operation chapter. 

 
 
Step Sequencer 
 

You’ve already learned how to record note events on a 
track, but you can quickly enter note events in the Step 
Sequencer by using the pads as “step buttons,” simulating 
the experience of a traditional step-sequencer-style drum 
machine. 

 

To enter the Step Sequencer, press Menu, and then tap 
Step Sequencer. Alternatively, in some modes, you can 
tap the steps icon on the left edge of the touchscreen. 

 

 

 

 

1. Let’s create a sequence on a new track. Tap the Track field in the upper-left corner, and then use the data dial or 
–/+ buttons to select an (unused) track. Alternatively, double-tap the Track field, and then tap a track to select it. 

2. Tap the Track Length field at the top of the touchscreen to set a length for the track, and then use the data dial 
or the –/+ buttons to select a length. If you select the minimum value, Sequence, the track will be however long 
your sequence is. 

Tip: This lets you maintain tracks of different lengths. For instance, you could play a 1-bar drum sequence 
repeatedly under a 4-bar bass line. 

3. Tap the Bar –/+ buttons at the bottom of the touchscreen to select the bar whose steps you want to create or 
edit. The bar number will appear in the Bar field in the upper-left corner. 

4. Tap the Pad –/+ buttons at the bottom of the touchscreen to select the pad whose steps want to create or edit. 
The pad number will appear in the Pad field in the upper-left corner.  

5. Press Play to start your sequence.  

6. Each pad represents a step in the bar. If the pad already has note events on the selected track, the 
corresponding pads (steps) will be lit with colors corresponding to their velocities.  

To enter a note at a step, press an unlit pad. The pad will light up with a color corresponding to its velocity. 

To delete the note from a step, press a lit pad. The pad will become unlit. 

To delete all notes from the entire bar, press and hold Shift, and then tap Clear Bar in the lower-right corner. 

 

See Operation > Modes > Step Sequencer to learn more about this feature. 
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Drum Loops & Chop Mode 
 

Modern music producers often use drum loops to add grit and nuance to programmed beats. This section explains 
how to use Sample Edit Mode to work with drum loops. 

Use the Browser to locate a drum loop, and then double-tap it to add it to the current program. The loop does not 
have to match the tempo of anything in the project. 
 

To enter Sample Edit Mode, press Menu, and then tap Sample Edit. 
 

1. Tap the Sample field at the top of the touchscreen, and 
then use the data dial or –/+ buttons to select the 
loaded drum loop. You can scroll through all loaded 
samples in the project. Alternatively, double-tap the 
Sample field, and then tap a sample to select it. 

2. Tap the Trim/Chop tab in the lower-left corner to switch 
between Trim Mode and Chop Mode. Select Chop 
Mode, which will let us cut the drum loop into slices. 

3. Tap Threshold, and then tap the Threshold field to the 
right of it. Use the data dial or –/+ buttons select a 
value. Alternatively, double-tap the Threshold field and 
use the numeric keypad that appears to enter a value. 
The lower the threshold, the more slices will be created. 
Be sure to select a value so that every transient peak of 
the drum loop has a corresponding a slice marker. 

Tip: Each slice will be automatically assigned to a pad: 
Pad A01 plays Slice 1, Pad A02 plays Slice 2, etc. Press 
each pad to play the slice with the same number. 

 

Let’s use this chopped sample to create a new program in which each of these slices is an individual sample. We 
can also automatically create corresponding note events to play back these slices sequentially. 
 

1. Press and hold Shift and then tap Convert at the 
bottom of the touchscreen to enter the Convert or 
Assign Slices window. 

2. Tap the Convert To field, and then use the data dial or –
/+ buttons to select New Program with New Samples. 

3. Make sure Crop Samples is checked. If it is not, tap it. 

4. Make sure Create New Program is checked. If it is 
not, tap it. 

5. Make sure Create Events is checked. If it is not, tap it. 

6. Tap the Bars field, and then use the data dial or –/+ 
buttons to select how many bars the entire sample 
should use in your program. 

7. Tap Do It to proceed. Each slice will be assigned to a 
pad, and each pad will have a recorded note event in the 
track. When you play that track, it will play each pad (each 
slice) in the original order. Press Menu and then tap Grid 
View to see how the sample appears in your sequence. 

8. Press Play and listen to how the drum loop matches 
your song tempo now. 

 

You can also edit the note events of the drum loop slices—enter Main Mode to do this. A new track with the note 
events playing their corresponding slices has been automatically created. Tap the TC/clock icon at the top of the 
touchscreen to use the Timing Correct window to quantize the note events so they fall on exact, even time intervals. 

You can also rearrange the note events, thus creating a new playback order for the slices. You can also edit each 
slice or sample in Program Edit Mode. You can add effects for slices or use the filter function to change the 
frequency range of a selected slice. There are almost no limits to what you can do. 

See Operation > Modes > Sample Edit Mode > Chop Mode to learn more about this feature. 
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Pad Muting & Track Muting 
 

Pad Mute Mode and Track Mute Mode let you silence different pads and tracks to see what the sequence sounds 
like without those samples or parts. 

 

To enter Pad Mute Mode, press Menu and then tap Pad 
Mute. 

 

1. Press Play to play the sequence. 

2. Tap the Program field at the top of the touchscreen, 
and then use the data dial or –/+ buttons to select 
your drum program. Alternatively, double-tap the 
Program field, and then tap a program to select it. 

3. Mute a pad by pressing it once or tapping it on the 
touchscreen. The muted pad will be lit red. You can 
mute multiple pads at the same time. 

See Operation > Modes > Pad Mute Mode to learn more 
about track mutes. 

 

 

You can also mute entire tracks by using the similar Track Mute function. 

 

To enter Track Mute Mode, press Menu and then tap 
Track Mute. 

 

1. Press Play to play the sequence. 

2. Tap the Sequence field at the top of the touchscreen, 
and then use the data dial or –/+ buttons to select the 
desired sequence. Alternatively, double-tap the 
Sequence field, and then tap a sequence to select it. 

3. Each pad is assigned to a track. Mute a track by 
pressing the corresponding pad or tapping it on the 
touchscreen. The pad will be lit red. You can mute 
multiple tracks at the same time. 

Tip: To mute a track only at precise note intervals 
(“quantizing” your mutes, essentially), tap Time Division to 
set a musical timing value. Tap the desired musical value 
(e.g., 1 Bar). Alternatively, use the data dial or –/+ buttons. 
Tap Close to close the page. Now, when you press a pad in 
Track Mute Mode, the mute will occur precisely at the 
beginning of the following time division (in this example, one 
bar). This lets you test musical combinations of patterns—
the preliminary stage to building a song structure. 

See Operation > Modes > Track Mute Mode to learn more 
about track mutes. 
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Sampling (Recording) 
 

This section describes recording new samples of your own, which you can use in your projects.  

Important: To record any audio, you need to connect an audio source to your MPC Live or to your computer’s audio 
interface. 

 

To open the Sampler, press Menu and then tap Sampler. 

 
1. Connect an audio source to the input/inputs of your 

MPC Live.  

2. Turn the Rec Vol knob to set the input level while playing 
your audio source. You should now see the level in the 
meter. Make sure it does not exceed the maximum level 
(the meter should not be “peaking” constantly). 

3. Tap and drag threshold slider to set the threshold. 
Alternatively, use the data dial or –/+ buttons. Set it to 
a fairly low level (e.g., -50 dB). 

4. Tap Arm to record-arm the Sampler.  

5. Play your audio source. The Sampler will start 
recording immediately when the input level reaches the 
threshold value. Alternatively, tap the round Record 
button to manually start recording. 

6. To stop recording, tap the round Stop button. The 
Keep or Discard Sample window will appear. 

 

In the Keep or Discard Sample window: 

To name the new sample, tap the Edit Name field and 
use the virtual keyboard to enter a name.  

To assign the new sample to a program, tap the 
Program field, and then use the data dial or –/+ buttons 
to select the desired program. Alternatively, double-tap 
the Program field, and then tap a program to select it. 

To assign the sample to a pad in the program, tap the 
Assign to Pad field, and then press the desired pad. 
Alternatively, use the data dial or –/+ buttons to select the 
desired pad number, or double-tap the Pad field, and then 
tap a pad number. 

To confirm your selections, tap Keep at the bottom of 
the touchscreen.  

To discard the recording and return to the previous 
screen, tap the Discard button. 

To play the recording, tap the Play button at the 
bottom of the touchscreen. 

 
See Operation > Modes > Sampler to learn more about this feature. 
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Sample Editing 
 

You may need to edit your newly recorded samples using Sample Edit Mode. 

 

To enter Sample Edit Mode, press Menu and then tap Sample Edit. 

 

In Sample Edit Mode: 

To switch between Trim Mode and Chop Mode, tap 
the Trim/Chop tab at the bottom of the touchscreen. In 
this example, use Trim Mode. 

To set the sample’s start point, press Q-Link to select 
the first bank of Q-Link knobs (the Start field will be 
outlined gold). Use the Q-Link knobs to adjust the start 
point with varying degrees of resolution. Alternatively, 
tap and drag the S marker in the waveform. 

To set the sample’s end point, press Q-Link to select 
the second bank of Q-Link knobs (the End field will be 
outlined gold). Use the Q-Link knobs to adjust the end 
point with varying degrees of resolution. Alternatively, 
tap and drag the E marker in the waveform. 

To hear your edits, press Pad 10 to play the sample 
from the start point to the end point. 

 

Let’s apply some processing to the sample. 

 

To open the Process Sample window, tap Process at the bottom of the touchscreen. 

 

1. Use the data dial or –/+ buttons to select the desired 
process in the Function field. Alternatively, tap 
Function or double-tap the Function field, and then 
tap the desired process. Let’s select Pitch Shift to 
change the overall pitch of your sample. This will 
transpose the sample without affecting its length. 

2. To set the pitch shift amount, tap and drag the knob 
in the center of the window up or down. Alternatively, 
use the data dial or –/+ buttons. To make finer 
adjustments, double-tap the knob and adjust the 
larger version that appears. Tap anywhere else to 
return to the previous screen. 

3. To confirm your selections, tap Do It. 

To cancel the process, tap Cancel. 

 

See Operation > Modes > Sample Edit Mode to learn more. 
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Recording Automation with the XY Pad 
 

Automating various parameters is a good way to add some 
motion and dynamism to your sequences.  

1. Press Menu to open the Menu, and then tap XYFX to 
enter XYFX Mode. 

2. Double-tap the XYFX Location field, and select 
Program. 

3. When you first enter this mode in a project, you will be 
prompted to “load” XYFX to the program. Tap Insert 
XYFX to do this. 

4. Tap Setup to show the Setup panel, which controls 
how the XY pad behaves. 

5. Double-tap the Preset field, and tap an effect to select 
it. (These are just the effects available in XYFX Mode, 
not all MPC effects.) Swipe up or down to view the 
entire list. 

6. Tap and drag any of the knobs (Attack, Release, or Wet/Dry) up or down to set their values as desired. Below 
them, you can see what parameter the X axis and Y axis control. 

Note: XYFX uses an envelope to control how quickly the effect crossfades between the dry signal and wet signal. 
The Attack knob determines how long it takes the completely dry signal to reach the wet signal (determined by 
the Wet/Dry knob) after you touch the XY pad. The Release knob determines how long it takes the wet signal 
(determined by the Wet/Dry knob) to return to the completely dry signal after you touch the XY pad. 

7. Tap the automation button in the upper-right corner to cycle through the available automation modes. Make 
sure it shows the red Write (W) option. 

8. Press Play Start to start recording. 

9. As you record, move your finger over the XY pad on the touchscreen. The changes in the sound are being 
recorded as automation of both the X axis and Y axis parameters. 

10. When you are done recording, press Stop. 

11. Tap the automation button in the upper-right corner to select the green Read (R) option. This ensures your 
track uses the automation you just recorded when you play it back. 

 

See Operation > Modes > XYFX Mode to learn more about using this feature. 

 
 
Using MPC Live as a Controller 
 

If you are using the MPC software on your computer, you can switch MPC Live into Controller Mode, allowing you 
to use it to control the software. The MPC software offers the same features and functionality as MPC Live in 
Standalone Mode but with some notable differences, which are discussed in Operation > General Features > 
Standalone vs. Controller Mode. 
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Operation 
 

This chapter explains the complete features and functions of your MPC Live.  

Important: 

• When accessing the secondary functions of buttons on your MPC Live, you can do this one of two ways: 
(1) pressing and holding Shift and then pressing the desired button or (2) double-pressing the desired 
button. This manual describes these operations using only the first option, but both are acceptable. 

• Almost every mode shown in the touchscreen has 1–6 buttons at the bottom. Each of these buttons 
select a different tab in that mode or perform a specific function in that mode. 

• When the left-most button at the bottom of the touchscreen shows an upward arrow (), it means 
there are additional buttons you can use when you press and hold Shift. Press and hold Shift to show 
the secondary buttons, and any of them, if desired. Release Shift to return to the previous buttons. 

• When a parameter is highlighted and has a red outline, this means that it is selected. You can then 
change it by turning the hardware’s data dial or using the –/+ buttons. If the parameter is a number, try 
double-tapping it to show a numeric keypad in the touchscreen, and use that to enter a specific value. 

• When the touchscreen shows a parameter or group of parameters with a gold outline (and sometimes 
a Q in the corner), this means that the current bank of Q-Link knobs will control those parameters or 
settings. Turn a Q-Link knob to adjust its corresponding parameter value or setting in that group. 
When the value has decimal places, you can sometimes press and hold Shift and then turn the Q-
Link knob to adjust the value by smaller increments. You can also press the Q-Link button to select 
another group of four parameters. 

• Press and hold the Q-Link button to see an overview of all 16 Q-Link knobs and their parameters. You 
can then tap any column of knobs to select those four Q-Link knobs, and then release the Q-Link button. 
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General Features 
 
Battery Usage 
 

Although you can power MPC Live by from a power outlet (using the included power adapter), you can use 
its internal battery, which typically has four hours of life, depending on CPU and how you’re using MPC Live. 

While powering MPC Live from its internal battery, the battery icon in upper-right corner of the touchscreen 
will show its current battery life. (The icon below it indicates whether MPC Live is in Standalone Mode or 
Controller Mode.) 

 

To view MPC Live’s system resources (battery life, CPU, 
and RAM usage), tap the battery icon in upper-right 
corner of the touchscreen. The System Resources window 
will appear, showing percentages to indicate the current 
battery life, CPU, and RAM usage (Mem). 

To delete samples from the project (to create more free 
RAM space for sampling time, audio recording, etc.), tap 
Purge. In the screen that appears, tap Unused Samples 
to delete all unused samples from the project, tap All 
Samples to delete all samples from the project, or tap 
Cancel to return to the previous screen. 

 

To charge MPC Live’s internal battery, connect its 
power input to a power outlet using the included power 
adapter. The charging indicator light (behind the vent on 
the rear panel) will turn on while charging. When the 
battery is fully charged or when it is disconnected from a 
power outlet, then this light will turn off. 

 

 

Control Types 
 

The MPC Live uses the following types of control elements: 

 

 

Knobs 

To set the value for a knob, do any of the following: 

• Tap and drag the knob up or down. 

• Tap the knob to select it, and then use the data dial or –/+ 
buttons to adjust the value.  

• Double-tap the knob or press the data dial (when the knob is 
selected) to show it in a larger screen. Tap and drag the larger 
version that appears, or use the data dial or –/+ buttons to adjust 
the value. Tap anywhere else to return to the previous screen. 

• Press and hold Shift while turning the data dial to adjust a value 
by smaller increments. 
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Parameter Values 

To set the value for a parameter, do either of the following: 

• Tap the field to select it, and then use the data dial or –/+ 
buttons to adjust the value. 

When the value has decimal places, you can sometimes press and 
hold Shift and then use the data dial or –/+ buttons to adjust the 
value by smaller increments. 

• Double-tap the field or hold your finger on it for a second. In the 
screen that appears, use the numeric keypad, the data dial, or 
the –/+ buttons to adjust the value. Alternatively, tap and drag 
the value up or down. 

You can also tap /2 to halve the value or x2 to double it. 

To confirm the value and remain on this screen, tap Apply. 

To confirm the value and return to the previous screen, tap Do It. 

To return to the previous screen without changing anything, 
tap the grey area in the upper-left corner of the touchscreen. 

 

 

Drop-Down Menus / Lists 

To select an option for a drop-down menu, do any of the following: 

• Tap the field to select it, and then use the data dial or –/+ buttons to select an option. 

• Double-tap the field. In the list that appears (examples below), tap the desired option. Alternatively, use the 
data dial or the –/+ buttons to select an option. 

In some windows, tap the relevant button at the bottom of the touchscreen to confirm your selection or to 
cancel without changing anything. 
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Selectors 

Selectors show all available options. One of them is always selected. The selected option 
is highlighted while the others are dark. 

To select an option, tap it. 

 

 

 

Buttons 

Buttons usually have two states: selected and deselected (active or inactive, respectively). 
Some may have more than two states. 

To switch between or cycle through a button’s states, do either of the following: 

• Tap it. 

• If it is outlined in red (and is not a mute button), use the data dial or –/+ buttons. 

 

 

 

 

 

 

 

 

 

 

Checkboxes 

Checkboxes have two states: checked and unchecked (enabled or disabled, respectively). 

To check or uncheck a checkbox, tap it. 

 

 

 

 

Tabs 

Some modes have buttons at the bottom of the touchscreen that let you cycle through 
several similar tabs. For instance, you could view the send level that is routed to each of 
four returns—each level is shown on a separate tab. With each tap, you will move to the 
next tab, indicated by the squares below it. 

To select a tab, tap it. Each time you tap it, it will select the next tab. 
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Sliders 

To adjust the position of a slider, do any of the following: 

• Tap and drag the slider to the desired position. 

• Tap the desired position (this works only on some sliders). 

• Tap the slider to select it, and then use the data dial or –/+ buttons to adjust the position (this works only on 
some sliders). 

• Double-tap the slider, and then tap and drag the larger version that appears, or use the data dial or –/+ 
buttons to adjust the value. Tap anywhere else to return to the previous screen. 

   

Envelopes 

To set the stages of an envelope, do either of the following: 

Tip: Tap the expand-rectangle icon above the envelope to show a closeup view. 

• Tap and drag a “handle” of an envelope stage in the desired direction. 

• Set the numeric value of an envelope stage by adjusting or entering it as a parameter value 
(described earlier). 

 
The Filter Envelope tab in Program Edit Mode. 

 

  
Closeup of an AD-type filter envelope. Closeup of an AHDS-type amp envelope. 
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Grid View Tools 

In Grid View, these four icons enable you to use different functions in the grid. Tap one 
to select its mode: 

 

Pencil: Draw Mode: 

To enter a note in an empty grid square, tap the grid square. 

To select a note, tap it. 

To move a note, tap and drag it to another grid square. 

To erase a note, double-tap it. 

 

Eraser: Erase Mode: 

To erase a note, tap it. 

 

Select Box: Select Mode: 

To select a note, tap it. 

To select multiple notes, tap and drag across the grid to create a box around them. 

To move a note, tap and drag it to another grid square. 

To move multiple notes, select them as described above, and tap and drag them. 

To erase multiple notes, select them as described above, and then select the Eraser tool and tap any of 
the selected notes. 

 

Magnifying Glass: Navigation Mode: 

To move to another part of the grid, tap and drag it. 

To zoom in or out, spread or pinch your fingers (respectively) on the grid. You can do this vertically, 
horizontally, or both at the same time. 

 



 

 
33 

 

 

Audio Edit Tools 

In Audio Edit Mode, these five icons enable you to use different functions in the 
waveform. Tap one to select its mode: 

 

Arrow: Select Mode: 

To select a track region, tap it. 

To move a track region, tap and drag it. 

To resize a track region, tap and drag the lower part of the region’s edge. 

 

Eraser: Erase Mode: 

To erase a track region, tap it. 

 

Scissors: Cut Mode: 

To split two track regions, tap it. 

 

Mute: Mute Mode: 

To mute or unmute a track region, tap it. 

 

Magnifying Glass: Navigation Mode: 

To move to another part of the waveform, tap and drag it. 

To zoom in or out, spread or pinch your fingers (respectively) on the waveform. You can do this vertically, 
horizontally, or both at the same time. 
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Programs 
 

About Programs 

 

Each track you create within a sequence is routed through a program. There are six 
types of programs, each of which determines how the track sounds or what it is used 
for. A single project can hold up to 128 programs. 

This chapter covers how to create each program type. 

To learn about editing your programs to your preference, see the Modes > Program 
Edit Mode chapter. 

 

 

A drum program uses one or more samples as its sound source. It contains (1) a list of samples and (2) 
the settings for each sample (i.e., pad assignments, loop points, pitch tuning, effects, etc.). Drum 
programs are used mostly for creating drum parts and quickly and easily assigning samples to pads. See 
Drum Programs for more information. 

 

A keygroup program uses one or more samples as its sound source. It contains It contains (1) a list of 
samples and (2) the settings for each sample (i.e., pitch tuning, effects, etc.). Keygroup programs are 
used to play samples chromatically with a MIDI keyboard or the MPC pads. See Keygroup Programs for 
more information. 

 

A clip program uses several samples that can be looped (clips). Each clip can be assigned to a pad, 
which you can press to trigger the clip according to a quantization setting. This lets you create intriguing, 
layered performances by launching different combinations of clips together. See Clip Programs for more 
information. 

 

A plugin program contains an instance of a plugin through which you can send your track’s MIDI data. 
See Plugin Programs for more information. 

Important: Plugin programs are available only while using MPC Live in Controller Mode with the desktop 
version of the MPC software. They are not available in Standalone Mode. 

 

A MIDI program lets you send your track’s MIDI data to an external MIDI device like a synth or drum 
machine. See MIDI Programs for more information. 

 

 

A CV program lets you send your track’s MIDI data to an external MIDI device that uses control voltage 
(CV), like a synth. Although this option is selectable, it is not available for MPC Live, which does not have 
CV outputs. See CV Programs for more information. 
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Drum Programs 
 

A drum program uses one or more samples as its sound source. It contains (1) a list of samples and (2) the settings 
for each sample (i.e., pad assignments, loop points, pitch tuning, effects, etc.). Drum programs are used mostly for 
creating drum parts and quickly and easily assigning samples to pads. 

 

To create a drum program: 

1. Press Main to enter Main Mode. 

2. Next to the Track field, tap the four-squares icon, which indicates a drum 
program. 

3. If the project does not contain a drum program yet, a new drum program 
(named Program, appended with a number) will be added automatically to 
the project and appear in the Program field below. 

If the project already contains a drum program, the first one will be selected 
automatically and appear in the Program field below. 

To create another drum program, tap the + icon above the Program field. 
A new drum program will be created and appended with a number (e.g., 
Program 002). 

To rename the program, tap the cursor icon on the right edge of the Program 
section. Use the virtual keyboard that appears to enter a new name, and then 
tap Do It to confirm or the grey bar at the top of the touchscreen to cancel. 

 

To load a sample into a drum program: 

1. Press Shift+Menu/Browse to show the Browser. Find and select a sample, and then tap Load to load it to the 
program. Repeat this for any other samples you want to load into the project. (See Modes > Browser to learn 
more about using the Browser specifically.) 

2. Tap Sample Assign to view the pads and project’s sample pool. 

3. Press or tap a pad to select it. The pad will be lit green. 

4. In the Sample Pool list, double-tap a sample to assign it to the pad. Alternatively, use the data dial or –/+ 
buttons to assign a sample and/or change the assigned sample. 

To clear the assigned sample from a selected pad, press the data dial. 

To assign samples to additional pads, repeat Steps 3–4. 

Tip: Remember that a drum program has 128 pads total—16 pads across eight banks. 
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Alternatively, assign samples in a drum program this way: 

1. Press Menu and then tap Program Edit to enter 
Program Edit Mode. 

2. Tap Samples. This lets you view the samples assigned 
to all four layers of the current keygroup as well as 
tuning and level parameters for each layer. 

3. Tap a pad to select it (and play its assigned samples, if 
any). The pad will be lit green. 

4. Tap the field for a layer, and then use the data dial or –
/+ buttons to select a sample. Alternatively, double-tap 
the field for a layer, and then tap a sample to select it. 

Tip: Press Q-Link to select the first bank, and then use 
the Q-Link knobs to quickly select a sample for each 
layer of the selected pad. 

Tip: Remember that a drum program has 128 pads 
total—16 pads across eight banks. 
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Keygroup Programs 

 

A keygroup program uses one or more samples as its sound source. It contains It contains (1) a list of samples and 
(2) the settings for each sample (i.e., pitch tuning, effects, etc.). Keygroup programs are used to play samples 
chromatically with a MIDI keyboard or the MPC pads. 

 

To create a keygroup program: 

1. Press Main to enter Main Mode. 

2. Next to the Track field, tap the piano-keys icon, which indicates a keygroup 
program. 

3. If the project does not contain a keygroup program yet, a new keygroup 
program (named Program, appended with a number) will be added 
automatically to the project and appear in the Program field below. 

If the project already contains a keygroup program, the first one will be selected 
automatically and appear in the Program field below. 

To create another keygroup program, tap the + icon above the Program 
field. A new keygroup program will be created and appended with a number 
(e.g., Program 002). 

To rename the program, tap the cursor icon on the right edge of the Program 
section. Use the virtual keyboard that appears to enter a new name, and then tap 
Do It to confirm or the grey bar at the top of the touchscreen to cancel. 

 

To assign samples in a keygroup program: 

1. Press Menu and then tap Program Edit to enter 
Program Edit Mode. 

2. Tap Samples. This lets you view the samples assigned 
to all four layers of the current keygroup as well as 
tuning and level parameters for each layer. 

3. Tap the Number of KG field, and then use the data dial 
or –/+ buttons to set the number of keygroups in the 
program (1–128). Alternatively, double-tap the Number 
of KG field, and then use the numeric keypad that 
appears to enter a value. 

4. Tap the Keygroup field, and then use the data dial or –
/+ buttons to select a keygroup. Alternatively, double-tap 
the Keygroup field, and then tap a keygroup to select it. 

5. Tap a pad to play the sample in the keygroup. The pad 
will be lit green. 

Tip: On your MPC Live, press the Pad Bank D button 
to and press Pad 13. You should hear the sample 
played back with its original pitch. You can use the 
other pads to play your sample chromatically.  

6. Tap the field for a layer, and then use the data dial or –/+ buttons to select a sample. Alternatively, double-tap 
the field for a layer, and then tap a sample to select it. 

Tip: Press Q-Link to select the first bank, and then use the Q-Link knobs to quickly select a sample for each 
layer of the selected pad. 

 

To create complex keygroup programs, you can add more keygroups (up to 128). This is useful when working with 
multi-samples (e.g., when programming a real piano). 

Tip: Remember that a keygroup program offers up to 128 keygroups, and each keygroup can hold up to four 
samples (Layers 1–4). This is a total of 512 samples. 



 

 
38 

 

 

Clip Programs 
 

A clip program uses several samples that can be looped 
(clips). Each clip can be assigned to a pad, which you can 
press to trigger the clip according to a quantization setting. 
This lets you create intriguing, layered performances by 
launching different combinations of clips together. 

By default, the 16 pads are divided into four columns of four 
pads. Each column represents a mute group; when a pad is 
playing a clip, all other pads in that same mute group are 
turned off. This enables you to launch a clip without having 
to manually stop other clips that are similar. For instance, 
pressing Pad 2 may launch a bass clip. You could then 
press Pad 6, which launches another bass clip and stops 
the clip on Pad 2. This way, you’ll never be playing two bass 
clips simultaneously.  

The four-columns pad configuration described above is just a default to make things easy (e.g., you could use the 
first column for drum clips, the second for bass clips, the third for keyboard clips, and the fourth for vocal clips.). You 
can use Program Edit Mode to assign pads to any combination of mute groups you want. 

 

To create a clip program: 

1. Press Main to enter Main Mode. 

2. Next to the Track field, tap the play-button icon, which indicates a clip program. 

3. If the project does not contain a clip program yet, a new clip program (named Clip, appended with a number) will 
be added automatically to the project and appear in the Program field below. 

If the project already contains a clip program, it will be selected automatically and appear in the Program field 
below. 

To create another clip program, tap the + icon above the Program field. A new clip program will be created 
and appended with a number (e.g., Clip 002). 

To rename the program, tap the cursor icon on the right edge of the Program section. Use the virtual keyboard that 
appears to enter a new name, and then tap Do It to confirm or the grey bar at the top of the touchscreen to cancel. 
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To load a clip into a clip program: 

1. Press Main to enter Main Mode. 

2. Tap Edit Clips to view the pads and clip settings. 

3. Press or tap a pad to select it (and play its assigned 
samples, if any). The pad in the touchscreen will be lit 
red, and its number will appear in the Pad field.  

4. Tap the Sample field, and then use the data dial or –/+ 
buttons to select a clip. Alternatively, double-tap the 
Sample field, and then tap a clip to select it. 

To clear the assigned clip from a selected pad, 
repeat Step 4, but select None. 

To assign clips to additional pads, repeat Steps 3–4. 

 

Alternatively, assign clips in a clip program this way: 

1. Press Shift+Menu/Browse to show the Browser. Find 
and select a clip, and then tap Load to load it to the 
program. Repeat this for any other clips you want to 
load into the project. (See Modes > Browser to learn 
more about using the Browser specifically.) 

2. Tap Sample Assign to view the pads and project’s 
sample pool. 

3. Tap Assign Mode so it is selected (tapping an item in 
the sample pool will now assign it automatically to the 
current pad). be lit green. 

4. In the Sample Pool list, tap a clip to assign it to the pad. 
Alternatively, use the data dial or –/+ buttons to assign 
a clip and/or change the assigned clip. 

To clear the assigned clip from a selected pad, press 
the data dial. 

To assign clips to additional pads, repeat Steps 4–5. 
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Plugin Programs 
 

A plugin program contains an instance of a plugin through which 
you can send your track’s MIDI data. This lets you use the same 
instance of a plugin with multiple tracks (rather than load an 
instance of a plugin on every track, which can be cumbersome and 
CPU-intensive). 

Important: Plugin programs are available only while using MPC Live 
in Controller Mode with the desktop version of the MPC software. 

 

To create a plugin program: 

1. Press Main to enter Main Mode. 

2. Next to the Track field, tap the plug icon, which indicates a plugin program. 

3. If the project does not contain a plugin program yet, a new plugin program (named Program, appended with a 
number) will be added automatically to the project and appear in the Program field below. 

If the project already contains a plugin program, the first one will be selected automatically and appear in the 
Program field below. 

To create another plugin program, tap the + icon above the Program field. A new plugin program will be 
created and appended with a number (e.g., Program 002). 

4. Double-tap the Plugin field. In the list that appears, tap the desired plugin. Alternatively, use the data dial or the 
–/+ buttons to select a plugin. 

To sort your plugins by type or maker, tap Type or Manufacturer. 

5. Tap Select to select the plugin, or tap Close to cancel. 

Note: You have to specify the disk directory where your plugins are located. This can be done in the software’s 
Preferences (in the Edit Menu). See the user guide in the MPC software to learn more: click the Help menu and 
select MPC User Manual. 

To select the MIDI channel the program will use, double-tap the MIDI Ch field. In the list that appears, tap the 
desired channel. Alternatively, use the data dial or the –/+ buttons to select a channel. Use this setting when you 
are working with a virtual instrument plugin that supports multi-mode. 

To select a preset in your plugin (if any), double-tap the Preset field. In the list that appears, tap the desired 
preset. Alternatively, use the data dial or the –/+ buttons to select a preset. 

To rename the program, tap the cursor icon on the right edge of the Program section. Use the virtual keyboard that 
appears to enter a new name, and then tap Do It to confirm or the grey bar at the top of the touchscreen to cancel. 

 

To adjust the volume and panning of a track using the plugin program: 

1. Press Menu and then tap Channel Mixer to enter the Channel Mixer. 

2. Double-tap the Mixer field in the upper-left corner, and then tap Midi Tracks. 

3. Tap the square that represents the track with the plugin program to select it. 

4. Tap and drag the volume slider or pan knob up or down to adjust it. After you do this once, you can adjust the 
volume and panning of the plugin program normally. 

Important: 

If you copy a sequence, the volume and pan values will be copied with that sequence. This is also true if you move to 
a new sequence and put the same plugin program on a new track. 

By default, some plugins do not support MIDI volume and pan. In this case, adjust volume levels and panning on the 
plugin program. 
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MIDI Programs 
 

A MIDI program lets you send your track’s MIDI data to an 
external MIDI device like a synth or drum machine.  

 

To create a MIDI program: 

1. Press Main to enter Main Mode. 

2. Next to the Track field, tap the MIDI-jack icon, which 
indicates a MIDI program. 

3. If the project does not contain a MIDI program yet, a 
new MIDI program will be added automatically to the 
project and appear in the Program field below. 

If the project already contains a MIDI program, it will be 
selected automatically and appear in the Program field 
below. 

To create another MIDI program, tap the + icon above 
the Program field. A new MIDI program will be created 
and appended with a number (e.g., Midi 002). 

4. There are five additional settings to configure for a MIDI program: the MIDI Port, program change message 
(Prog Ch), MIDI channel (MIDI Ch), Most Significant Byte (Bank MSB), and Least Significant Byte (Bank LSB). 
See this section to learn more. 

To configure each setting, double-tap its field. In the list that appears, tap the desired option. Alternatively, use 
the data dial or the –/+ buttons to select an option. 

Note: You also have to configure the MIDI ports in the software’s Preferences (in the Edit Menu). See the user 
guide in the MPC software to learn more: click the Help menu and select MPC User Manual. 

To rename the program, tap the cursor icon on the right edge of the Program section. Use the virtual keyboard that 
appears to enter a new name, and then tap Do It to confirm or the grey bar at the top of the touchscreen to cancel. 

 

To adjust the volume and panning of a track using the MIDI program: 

1. Press Menu and then tap Channel Mixer to enter the Channel Mixer. 

2. Double-tap the Mixer field in the upper-left corner, and then tap Midi Tracks. 

3. Tap the square that represents the track with the MIDI program to select it. 

4. Tap and drag the volume slider or pan knob up or down to adjust it. After you do this once, you can adjust the 
volume and panning of the MIDI program normally. 

Important: If you copy a sequence, the volume and pan values will be copied with that sequence. This is also true if 
you move to a new sequence and put the same MIDI program on a new track. 
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CV Programs 
 

A CV program lets you send your control voltage (CV) signals 
to an external MIDI device like a synth or drum machine that 
uses CV. 

Important: CV programs are available only while using MPC X. 
MPC Live does not have CV ports. 

 

To create a CV program: 

1. Press Main to enter Main Mode. 

2. Next to the Track field, tap the CV icon, which indicates 
a CV program. 

3. If the project does not contain a CV program yet, a new 
CV program will be added automatically to the project 
and appear in the Program field below. 

If the project already contains a CV program, it will be 
selected automatically and appear in the Program field 
below. 

To create another CV program, tap the + icon above 
the Program field. A new CV program will be created 
and appended with a number (e.g., CV 002). 

To rename the program, tap the cursor icon on the 
right edge of the Program section. Use the virtual 
keyboard that appears to enter a new name, and then 
tap Do It to confirm or the grey bar at the top of the 
touchscreen to cancel. 
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Menu 
 

The Menu lets you select any of the 20 modes, save your project, set your preferences, switch between Standalone 
Mode and Controller Mode, or view your system resources. 

 

To open the Menu, press Menu, or tap the icon in the upper-left corner of the touchscreen while on the normal 
page of your current mode. 

When viewing the Menu, do any of the following: 

To enter a mode, tap it. 

Important: If a sequence is currently playing, you will not be able to enter Song Mode. Stop playback before 
entering Song Mode. 

To return to the previous mode, tap the grey area in the upper-left corner, or press Menu again.  

 

 

 

Click a part of the screen above to skip directly to that part of this user guide. 
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Save 

 

To save the project, tap the disk icon at the top of the 
touchscreen. If you have already saved the project, your 
changes will be saved. If you have not saved the project 
yet, use the Save window to save the project: 

To select the storage device you want to view, tap it 
in the Storage column on the left. Internal is the MPC 
Live’s internal drive. MPC Documents is a shortcut to 
the MPC Documents folder on the internal drive. If you 
have USB drives connected to MPC Live’s USB ports, 
they will appear in this column, as well. 

To enter a folder, double-tap it. Alternatively, turn the 
data dial or use the –/+ buttons to move through the 
list, and press the data dial to enter a folder. You can 
also tap one of the five folder buttons in the upper-right 
to jump immediately to those pre-assigned file paths 
(see Modes > Browser to learn how to do this). 

To create a new folder, tap New Folder, use the virtual keyboard that appears to enter a name, and then tap Do 
It. You will immediately enter the new folder. 

To move up one folder level, tap the folder/ icon. 

To name the file, tap the File Name field at the bottom of the touchscreen, and use the virtual keyboard that appears. 

To save the file, tap Save. 

To cancel and return to the Menu, tap Cancel. Alternatively, tap the  icon in the upper-left corner. 

 

 

Preferences 

 

To return to the Menu, tap the  icon in the upper-left 
corner. Any changes you have made in the Preferences will 
be retained. 

To restore your MPC Live’s default settings, tap Reset. 
In the screen that appears, tap OK to continue or Cancel 
to return to the Preferences. In the next window, tap Save 
to save your current project before restoring the default 
settings; tap Cancel to return to the Preferences; or tap 
Don’t Save to restore the default settings without saving 
your current project. 

To enter Update Mode, press and hold Shift and tap 
Update. In the screen that appears, tap Save to save your 
current project before entering Update Mode; tap Cancel 
to return to the Preferences; or tap Don’t Save to enter 
Update Mode without saving your current project. 

 

Info 

This screen shows current information about your MPC Live: its current firmware version, which includes its standalone 
operating system (MPC Firmware); its hardware Serial Number; and its current firmware for the Control Surface. 

 

Auto Save 

The settings on this screen determine if (and how) projects are automatically saved. 

Enabled: When enabled, MPC Live will automatically save your current project after each Timeout interval. When 
disabled, MPC Live will not automatically save your project; you may save only manually. 

Timeout: Use this field to select how often your project will automatically save. 
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Sequencer 

The settings on this screen determine how sequencing works in Grid View and in the Step Sequencer. 

Display Resolution: This is the display resolution (in PPQN—pulses per quarter note) of pulse values in certain areas 
of the operating system. Please note that this setting affects the display resolution, not the timing. 

Instant Track Mute: When disabled, if you mute a track, its Note On messages will be ignored, and samples and 
notes that are playing will finish playing their entire length (this is how legacy MPCs’ track-muting worked). This is 
useful if you are using loops and want a loop to play to the end of a bar but not play the next time the sequence 
loops. When enabled, if you mute a track, the MIDI track volume (0) will be sent. The loop will continue to play but 
at zero volume, allowing the loop to continue playing when the track is unmuted. This is useful when you want to 
have the track muted immediately. 

Play Track Mute and Solo Events: When enabled, track mute and solo events are played back when you are in 
Track Mute Mode. When disabled, track mute and solo events will not be played back while in Track Mute Mode. 

Record Track Mute and Solo Events: When enabled, track mute and solo events are recorded when you are in 
Track Mute Mode (timing correct settings will affect the recorded position events). When disabled, track mute and 
solo events will not be recorded while in Track Mute Mode. This feature is useful if you want to use Track Mute 
Mode to record track mutes or solos into your sequences as opposed to using Track Mute Mode for performance 
or listening purposes only. 

Record Pad Aftertouch Event: When enabled, pad aftertouch data (from MPC Live’s pressure-sensitive pads) will 
be recorded. When disabled, pad aftertouch data will be ignored. 

Place Events Recorded During Count-In at Start Point: When enabled, pressing a pad during the recording’s 
pre-count will record that note event at the start of the recording (this is how the MPC3000 worked). When 
disabled, no notes will be recorded until the pre-count is finished and recording has begun. 

Truncate Duration: This determines if/how events are cropped if they exceed the length of the current Sequence: 
To Sequence Length: If the length of an event exceeds the length of the sequence, it will be truncated. This 
ensures that the event will not overlap itself when the sequence loops. 
To Sequence End: If an event exceeds the length of the sequence, it will be truncated to the end of the 
current sequence. In other words, the event will stop playing when the sequence ends or loops. 
As Played: Events will play back exactly as they were recorded, even if they overlap themselves when the 
sequence loops. 

 
Hardware 

The settings on this screen determine the behavior of MPC Live’s pads and touchscreen. 

Pad Threshold: This determines how much force is required to strike the pads for them to trigger. 

Pad Sensitivity: This determines how the pads respond to touch. At lower values, you need to use more force to 
generate a high-velocity note. At higher values, it is easier to generate high-velocity notes, even if you do not use 
much force while pressing a pad. 

Pad Curve: This determines how striking the pads translates into velocity values. The A 
curve is essentially linear, while the B, C, and D curves are exponential (see graphic here). 

Velocity & Aftertouch: View these meters when striking and pressing the pads to help 
gauge the force and pressure you are applying to them. These meters are useful when 
adjusting the Pad Threshold and Pad Sensitivity parameters (above). 

Footswitch 1 & Footswitch 2: These determine how connected footswitches will work. 
These options are not available for MPC Live, which does not have footswitch inputs. 

MIDI Control Mode Output: This determines which MIDI port MPC Live is using to send 
MIDI messages to external MIDI devices. 

Screen Dimming: This determines how much time must pass before MPC Live automatically dims its touchscreen 
to preserve its battery life. 

Screen Brightness: This determines the brightness of the screen during normal operation: normal brightness 
(Day) or dimmed (Night). 

Power On Screen: This determines whether or not the power-on screen appears when you power the unit on. The 
power-on screen shows a Start button that you must tap and hold in order to fully power MPC Live on. If you do 
not tap and hold the Start button, MPC Live will return to its powered-off state. This feature is to prevent MPC 
Live from powering on if the power button is accidentally pressed. When set to Never, this feature is disabled. 
When set to When On Battery, this feature is enabled only if MPC Live is not connected to a power outlet. When 
set to Always, this feature is enabled regardless of a power outlet connection. 
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WiFi/Bluetooth 

The settings on this screen will determine how MPC Live’s wireless and Bluetooth connections work. We will add this 
functionality in a near-future release. Check akaipro.com to ensure you are using the latest software version. Your MPC 
Live’s current firmware (which includes its standalone operating system) is in the Info screen of these Preferences. 

 

Project Defaults 

The settings on this screen determine various default values for any new project that you create. 

Default Tempo: This is the default tempo in BPM. 

Default Master Tempo: When enabled, the default tempo value will be used for the master tempo. When 
disabled, the default tempo will be used for sequences. 

Default Sequence Bars: This determines the default number of bars of a new sequence. 

Default Time Signature Numerator: This determines the number of beats per bar of a new sequence (the top 
number of a time signature). 

Default Time Signature Denominator: This determines the value of each beat of a new sequence (the bottom 
number of a time signature). 

Default Pad Slice: This determines how new samples will play when you load them or record them into a project. 
When set to Pad, the Slice menu in Program Edit Mode will be set to Pad, which lets you set the start point, end 
point, etc. for the layer. When set to All, the Slice menu in Program Edit Mode will be set to All, in which the entire 
sample plays. 

Default Drum/Keygroup Filter: This determines the default type of filter that drum and keygroup programs will use. 

New Project Dialog: This determines what options you see when you start a new project. When set to Off, a new 
project will be empty with no preconfigured settings except for the project defaults shown here. When set to 
Demo, you can choose to load a demo project (from several different genres) as a starting point or an empty 
project. When set to Demo/Template/Recent, you can choose to load a demo project, a project template file, or 
an empty project. 

 

Sync 

The settings on this screen determine how MPC Live synchronizes with connected USB and MIDI devices. 

Receive MIDI: This determines whether MPC Live receives MIDI Clock information (MIDI Clock), MIDI Time Code 
information (MIDI Time Code (MTC)), or neither (Off). 

MTC Frame Rate: This determines the frame rate used by MIDI Time Code (MTC), which is important for correct 
timing, especially when working on film scoring projects. In most cases, you should select 25. 

Send MIDI: This determines whether MPC Live sends MIDI Clock information (MIDI Clock), MIDI Time Code 
information (MIDI Time Code (MTC)), or neither (Off). 

Start Time: This is the starting time that will be sent when Send MIDI is set to anything other than Off. The time is 
formatted in hours:minutes:seconds:frames. 

Send Port 1 & Send Port 2: These are the MIDI ports over which MIDI Clock or MTC information will be sent. 

Receive MMC: When enabled, MPC Live will be able to receive MIDI Machine Control (MMC) information. When 
disabled, MPC Live will not receive this information. 

Send MMC: When enabled, MPC Live will be able to send MIDI Machine Control (MMC) information. When 
disabled, MPC Live will not send this information. 

http://www.akaipro.com
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Other 

The settings on this screen determine how other features work in the hardware and operating system. 

Tap Tempo: This determines how many times you have to press the Tap Tempo button before the new tempo is 
recognized. 

Flash Tap Tempo Light: When enabled, the Tap Tempo button’s light will flash in time with the tempo. When 
disabled, the Tap Tempo button’s light will be off. 

Bank Button Press: This determines how the Pad Bank buttons work.  

Select A-D: Pressing a Pad Bank button once will select the corresponding bank from Pad Banks A–D. 
Pressing and holding Shift while pressing a Pad Bank button will select the corresponding bank from Pad 
Banks E–H. 

Select/toggle bank: Pressing a Pad Bank button will alternate between the corresponding bank from Pad 
Bank A–D and Pad Bank E–H. In other words, you do not need to hold Shift to select one of Pad Banks E–H. 

Filter ‘All Notes Off’ CC: When enabled, “All Notes Off” (“MIDI panic”) messages will be ignored. This is useful if 
you are using an external MIDI device that can send these types of messages but you want to filter them out. 
When disabled, “All Notes Off” messages will be received normally.  

Program Change: This determines what an incoming MIDI program change message will change: a Program, 
Sequence, or Track. 

Vintage Mode: This determines the type of emulation applied to the audio output. You can apply the particular 
sonic qualities of, for example, the MPC3000 or MPC60, or of course no emulation (None). 

Sampling Bit Depth: This determines bit depth of the audio recorded from a sample. 

Audition Auto Play: This determines how long a sample will sound when auto-previewing it. 

Cue Preview: This determines if/how audio is played as you move the cue playhead. As you move the cue 
playhead through a sample waveform, you can set it to play the small part of the sample before the cue playhead 
(Before), play the small part of the sample after the cue playhead (After), or not play at all (Off). You can also set 
this in Sample Edit Mode (see Modes > Sample Edit Mode > Settings). 

Slice Preview: This determines if/how audio is played as you move a slice marker. As you move the slice marker 
through a sample waveform, you can set it to play the small part of the sample before the slice marker (Before), 
play the small part of the sample after the slice marker (After), or not play at all (Off). You can also set this in 
Sample Edit Mode (see Modes > Sample Edit Mode > Settings). 

Screensaver Disable: This determines if/when your computer’s screensaver is disabled while using the MPC 
software (using MPC Live in Controller Mode): 

Never: Your computer’s screensaver will function normally. 

When hardware attached: As long as your MPC Live is connected to your computer and powered on, your 
computer’s screensaver will be disabled. It will function normally again if you power off or disconnect your 
MPC Live from your computer. 

Always: Your computer’s screensaver will be disabled as long as the MPC software is open (whether or not 
your MPC Live is connected or powered on). 

Collect Usage Statistics: This determines whether or not your usage statistics will be sent occasionally to us, 
enabling us to improve the MPC experience. 

Threads: This determines how many cores of your computer’s processor will be used to render audio. The 
available range depends on your processor. 

Audio Warp Algorithm: This determines how a sample is “warped” when you adjust the length of a sample 
without changing its pitch (e.g., the Warp function in Audio Edit Mode for audio tracks or in Program Edit Mode for 
clip programs). 

Auto Warp: This determines how recorded audio track regions are warped. When set to On, any audio track 
region that you record will be warped automatically to match the current sequence tempo. You can then adjust the 
sequence tempo while the audio track region remains in time. 

Note: When you record an audio file, the current sequence tempo will be embedded with it. This information is 
stored within the sample file when you save the project. When you warp an audio track region, the warping 
algorithm uses this sequence tempo and the current value in the BPM field to generate the “stretch factor.” 
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Legal 

This screen shows legal information relevant to MPC. For complete legal information, visit akaipro.com/product-legal 

 

 

Mode 

Tap this icon to switch MPC Live between Standalone Mode and Controller Mode. In the screen that appears, select 
whether you want to save your current project before switching (Save), switch without saving your project (Don’t 
Save), or stay in the current mode and project (Cancel). You cannot freely switch between Standalone and Controller 
Modes without also closing your current project. 

 

 

System Resources 

Tap one of these icons to show the System Resources window. 

 

The indicators in this window show current usage statistics: 

Battery: The first indicator shows the current battery life as 
a percentage. If you see an exclamation point (!) in the 
indicator and a low-battery warning at the bottom of the 
window, connect MPC Live to a power outlet as soon as 
possible. 

CPU: The second indicator shows the current CPU as a 
percentage. 

RAM Usage (Mem): The third indicator shows MPC Live’s 
current RAM usage as a percentage. 

 

To delete samples from the project, tap Purge. In the screen that appears, tap Unused Samples to delete all 
unused samples from the project, tap All Samples to delete all samples from the project, or tap Cancel to return to 
the previous screen. 

To close the System Resources window, tap OK, the X in the upper-right corner, or anywhere outside the window. 

http://www.akaipro.com/product-legal


 

 
49 

 

 
Time Counter 
 

In most of the available modes, there is a time counter at the top of the touchscreen. This 
indicates the current playhead position. 

 

To adjust the position, tap it, and then use the use the data dial or the –/+ buttons. 

 

To open the Locate screen and adjust its settings, double-tap the time counter. 

To close the Locate screen, tap the X in the upper-right corner or anywhere outside the window. 

 

To move forward or backward a step, tap the Step < or Step > button, respectively. 

 

To move forward or backward a bar, tap the Bar << or Bar >> button, respectively. 

 

To switch the time increments, tap the Beat/Time selector. When set to Beats, the time is shown in Bars, Beats, 
and Ticks. When set to Time, the time is shown in hours (HH), minutes (MM), seconds (SS), and frames (FF). 

 

To configure your auto record settings, use the Auto 
Record selector and adjacent fields: 

Auto Record selector: Tap the desired option to 
select it: 

Off: Auto recording is disabled. 

Punch In: You can auto record using punch-in and 
punch-out markers, enabling you to record over a 
specified length of time in the track. While 
recording, the entire sequence will play, but you will 
record over only the area between the Punch In 
and Punch Out markers. Any part of the sequence 
before the Punch In marker or after the Punch Out 
marker will remain untouched, even if you perform 
over it during recording. 

Record Start: After you record-arm the track and 
start playback, you will start recording once the 
sequence loops back to its start. This is essentially 
a punch-in feature for the entire track, enabling 
you to start playing a record-armed track while 
allowing more time than the usual count-in to 
prepare for the actual recording to start. 

Punch In: Use these fields to set the location of the Punch In marker, which is where recording will start (when the 
Auto Record selector is set to Punch In). 

Punch Out: Use these fields to set the location of the Punch Out marker, which is where recording will stop (when 
the Auto Record selector is set to Punch In). 

 

You can use this screen to set time markers, allowing you to jump automatically to precise locations in a sequence. 
You can set up to six time markers. 

To set a time marker, tap the time counter at the top of the screen, find the desired time, and then tap Set next to 
the desired time marker. The time will appear next to that marker. 

To jump to a time marker, tap the number next to it (1–6). 
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Automation 
 

You can set the automation for programs and audio tracks to be “written,” “read,” or disabled entirely. You can do 
this globally or for individual programs and audio tracks. 

 

 

Global 

 

In several modes, there is a button in the upper-right corner that controls the global automation. When you tap this 
button to change its state, it will change the automation state for all programs in the project. 

This is available in Main Mode, XYFX Mode, Pad Mute Mode, the Pad Mixer, the Channel Mixer, and Q-Link Edit Mode.  

 

Tap the global automation button to cycle through its three states: 

When off, automation data will be ignored. If you have already recorded or entered automation, tapping 
this will switch between Read (R) and Write (W) only, but you can override this and turn it off by 
pressing and holding Shift while tapping the button. 

Important: If you have already recorded automation and turn it off, the track will still use the effect and 
its parameter values at the point where you turned it off. 

When set to Read (R), automation data will be read but recorded. You can still manually edit and enter 
automation. (Think of this as a protective feature to prevent accidental changes to your automation 
while recording.) 

When set to Write (W), automation can be recorded and will overwrite any existing automation. (Make 
sure not to touch the XY pad accidentally while you are recording.) 

 

 

Programs & Audio Tracks 

 

You can also set the automation for each program or audio track by using the program automation button in the 
channel strip on the left side of the screen in Main Mode and the Channel Mixer. Program automation is available for 
all program types except MIDI programs. 

Note: Remember that tapping the global automation button will change the automation state for all programs in the 
project; if they were originally different, all of them will then match the global automation state. 

In Main Mode, if the channel strip is not already shown, tap the small eye icon below the Project field to show it. 

In the Channel Mixer, if you do not see a program automation button in the channel strip, make sure the Mixer field 
is set to Audio Tracks or Programs. 

 

Tap the program automation button to cycle through its three states: 

When off, the program will ignore automation data. If you have already recorded or entered 
automation, tapping this will switch between Read (R) and Write (W) only, but you can override this 
and turn it off by pressing and holding Shift while tapping the button. 

Important: If you have already recorded automation and turn it off, the track will still use the effect 
and its parameter values at the point where you turned it off. 

When set to Read (R), the program will read automation data but will not record any additional 
automation over it. You can still manually edit and enter automation. (Think of this as a protective 
feature to prevent accidental changes to your automation while recording.) 

When set to Write (W), the program can record automation. (If you have any Q-Link knobs assigned 
to automatable parameters, make sure not to touch any accidentally while you are recording.) 
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16 Level 
 

Press the 16 Level button on your MPC Live to activate or deactivate 
16 Level. 

 

When first activated, the selected pad (Pad A01 by default) will be 
temporarily copied to all 16 pads. The pads will now output the 
same note number as the initial pad, but a selectable parameter 
will be fixed at values that increase as the pad numbers increase 
(e.g., Pad 1 is the minimum, Pad 16 is the maximum), regardless of 
how hard you press them. 

 

In the 16 Levels screen that appears, use the Type selector to choose 
the parameter: Velocity, Tune, Filter, Layer, Attack, or Decay.  

 

To select a pad, do any of the following (while the 16 Levels window 
is open): 

• Press and hold 16 Level, and then press the desired pad. 

• Tap the 16 Levels checkbox to uncheck it (temporarily 
disabling the feature), press the desired pad, and then tap 
the 16 Levels checkbox again to check it. 

• Tap the Pad field, and use the data dial or –/+ buttons. 

• Double-tap the Pad field, and tap the desired pad in the list 
that appears. 

 
 
Erase 
 

The Erase function erases all or part of a track in a specific sequence. 

To open the Erase window, press the Erase button. Alternatively, 
while in Main Mode, tap the pencil icon on the right edge of the 
section, and then tap Erase in the screen that appears. 

 

To select the sequence you want to erase, use the Sequence field. 

To select the track you want to erase within the sequence, use 
the Track field. 

To set the time range of the sequence you want to erase, use 
the Bar, Beat, and Tick fields. The left fields set the start of the 
time range, and the right fields set the end of the time range.  

To select what types of events you erase, select one of the 
Erase options: 

All erases all pad events from the designated time range and 
reset all of its settings. 

Automation erases only automation from the designated time 
range. 

Note erases only specific pad events from the designated time 
range. In the diagram of the eight pad banks that appears, press 
each pad in each bank to select or deselect its notes. 

Except Note erases everything except pad events from the 
designated time range.  

 

To confirm your choice, tap Do It.  

To cancel and return to the previous screen, tap the X, Cancel, 
or anywhere outside the window. 
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Effects 
 

You can apply various effects to the pads, keygroups, programs, submixes, and master outputs, using insert and 
send/return effects. This chapter can help you get a good overall understanding of how the effects work. 

 

See Appendix > Effects & Parameters for a list of all available effects (with a brief description of each) and their 
editable parameters. 

 

 

Overview 
 

In a program, each pad or keygroup can have up to four insert effects applied to it. See Insert Effects > Pads or 
Insert Effects > Keygroups to learn more about this. 

 

An entire program can also have up to four insert effects applied to it, as well. See Insert Effects > Programs to 
learn more about this. 

 

Additionally, pads, keygroups, programs, and submixes can each be sent to up to four send channels. Their audio 
will be routed through effects on the send channels, and the processed audio will be returned to their original 
channel. See Send/Return Effects to learn more about this. 

 

For even further flexibility, each of the eight submixes can have up to four insert effects applied to it. You can route 
pads/keygroups and programs to a submix, which is then routed to a master output. See Insert Effects > Submixes 
to learn more about this. 

 

Finally, you can apply up to four insert effects to each master output (a stereo pair of channels: Outputs 1/2, 
Outputs 3/4, etc.). See Insert Effects > Masters to learn more about this. 

 

There are three other modes that handle effects differently: 

• The Sampler can use up to four insert effects, which are applied to the audio as you record it. This means 
that the effects cannot be “removed” from the sound later. Learn more about the Sampler in the Modes > 
Sampler chapter. 

• Similarly, the Looper can use up to four insert effects, which are applied to the audio as you record it. This 
means that the effects cannot be “removed” from the sound later. Learn more about the Looper in the 
Modes > Looper chapter. 

• In XYFX Mode, the effects act like a single insert effect on that program. In fact, XYFX is the name of the 
insert effect you have to load to the program before you can use this mode. Learn more about XYFX Mode in 
the Modes > XYFX Mode chapter. 

 
 

To view, load, edit, or clear effects, tap the area under the Inserts field. This usually 
appears in a channel strip (next to a level slider and pan knob). 
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When viewing loaded effects, you will see this window: 

To select an effect, use the field for each insert slot. A 
window (described below) will appear. 

To edit the parameters of a loaded effect, tap the 
pencil icon next to the insert slot. 

To clear the insert slot, tap the trash can icon next to it. 

To enable or disable an effect slot, tap the On/Off 
button next to it. 

To enable or disable all four effect slots, tap the All 
On/All Off button in the upper-right corner. 

 

 

When selecting an effect, you will see this window: 

To move through the list, swipe up or down. Alternatively, 
use the data dial or –/+ buttons.  

To sort or unsort the effects by type or manufacturer, 
tap Type or Manufacturer in the lower-left corner. 

To load an effect, double-tap it. Alternatively, tap 
Select, or press the data dial. 

To cancel, tap Close or anywhere outside the list. 

 

 

 

 

When you edit an effect, you will see this window: 

To adjust a parameter, tap and drag its slider. 
Alternatively, use the data dial or –/+ buttons. To make 
finer adjustments, double-tap the pad and adjust the 
larger version of the slider that appears. 

Tip: Turn the Q-Link knobs to quickly adjust the 
corresponding four parameters. Use the Q-Link button 
to select another set of four parameters the Q-Link 
knobs control. 

To select another page of parameters, tap the 
Parameters –/+ buttons at the top of the touchscreen. 

To enable or disable the effect, tap the On/Off button 
in the upper-right corner. 

To edit parameters for another insert effect on the 
same pad, program, etc., tap a different Insert tab at 
the bottom of the touchscreen to select it. 

To close the window, tap Close or the upper part of the 
touchscreen. 
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Insert Effects 
 

Pads 

You can load up to four insert effects to each pad. You can do this in Main Mode, the Pad Mixer, or Program Edit Mode. 

Tip: When using pad insert effects, they will be applied to the selected pad only. This means that you could apply 
unique combinations of effects to each pad within a program. If you want to apply the same effect to all pads, do this 
with a program insert effect (see Insert Effects > Programs). 

 

To load a pad insert effect in Main Mode: 

1. Use the Track field to select the track that uses the 
program with the desired pad—the program it uses will 
be selected automatically. 

2. If the channel strip is not already shown, tap the small 
eye icon below the Project field to show it. 

3. Tap the single-pad icon at the top of the channel strip. 
The channel strip will now show settings for the current 
pad. 

4. Press the desired pad to select it. Alternatively, use the 
Pad field at the top of the channel strip. 

5. Tap the area under Inserts, and then use the screen that 
appears to load or edit effects. 

 

To load a pad insert effect in the Pad Mixer: 

1. Use the Program field at the top of the touchscreen to 
select the desired program. Alternatively, use the Track 
field at the top of the touchscreen to select the desired 
track—the program it uses will be selected automatically.  

2. Press the desired pad to select it, or tap it in the 
touchscreen. Alternatively, double-tap the Pad field 
below the Program field. 

3. Tap the area under Inserts, and then use the screen that 
appears to load or edit effects. Alternatively, tap the 
Insert tab at the bottom of the touchscreen (tap it 
multiple times to select a different insert slot), and then 
double-tap the desired pad in the touchscreen. You 
could also use the data dial or –/+ buttons to select an 
effect immediately. 

 

To load a pad insert effect in Program Edit Mode: 

1. While using the desired program, press the desired pad 
to select it. 

2. Tap the Effects tab in the lower-right corner, and use it 
to load or edit effects. 
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Keygroups 

You can load up to four insert effects to each keygroup. You can do this in Main Mode, the Pad Mixer, or Program 
Edit Mode. 

Important: When using keygroup insert effects, they will be applied to that keygroup only. Keep this in mind if you 
load insert effects to multiple keygroups with overlapping note ranges—the effects will overlap in that range as well.  

 

To load a keygroup insert effect in Main Mode: 

1. Use the Track field to select the track that uses the 
program with the desired pad—the program it uses will 
be selected automatically. 

2. If the channel strip is not already shown, tap the small 
eye icon below the Project field to show it. 

3. Tap the single-pad icon at the top of the channel strip. 
The channel strip will now show settings for the current 
keygroup. 

4. Press a pad to select its corresponding keygroup, or tap 
it in the touchscreen. Alternatively, use the Keygroup 
field at the top of the channel strip. 

Important: Remember that the effect will be applied to 
that keygroup only. 

5. Tap the area under Inserts, and then use the screen that 
appears to load or edit effects. 

 

To load a keygroup insert effect in the Pad Mixer: 

1. Use the Program field at the top of the touchscreen to 
select the desired program. Alternatively, use the Track 
field at the top of the touchscreen to select the desired 
track—the program it uses will be selected automatically. 

2. Press a pad to select its corresponding keygroup, or tap 
it in the touchscreen. Alternatively, use the Keygroup 
field below the Program field. 

Important: Remember that the effect will be applied to 
that keygroup only. 

3. Tap the area under Inserts, and then use the screen that 
appears to load or edit effects. Alternatively, double-tap 
the desired pad in the touchscreen. You could also 
select one of the four Insert tabs at the bottom of the 
touchscreen, and then use the data dial or –/+ buttons 
to select an effect immediately. 

 

To load a keygroup insert effect in Program Edit Mode: 

1. While using the desired program, press the desired pad 
to select its keygroup. Alternatively, use the Keygroup 
field at the top of the touchscreen. 

2. Tap the Effects tab in the lower-right corner, and use it 
to load or edit effects. 
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Programs 

You can load up to four insert effects to each program. You can do this in Main Mode, XYFX Mode, and the Channel 
Mixer. 

Note: In XYFX Mode, the effects act like a single insert effect on that program. In fact, XYFX is the name of the insert 
effect that is loaded when use this mode. 

 

To load a program insert effect in Main Mode: 

1. Use the Track field to select the track that uses the 
program with the desired pad—the program it uses will 
be selected automatically. 

2. If the channel strip is not already shown, tap the small 
eye icon below the Project field to show it. 

3. Tap the four-pads icon at the top of the channel strip. 
The channel strip will now show settings for the current 
program. 

4. Tap the area under Inserts, and then use the screen that 
appears to load or edit effects. 

 

To load XYFX for a program in XYFX Mode: 

1. Select the desired program in another mode, and then 
enter XYFX Mode. 

2. If you have not yet used XYFX Mode for this program, 
tap Insert XYFX on the touchscreen to load it and show 
the XY pad. 

Note: If you already have four insert effects loaded, you 
will need to clear one of the insert effect slots before 
doing this. 

If you have already used XYFX Mode for this program, 
the XY pad will appear. 

3. If the Setup panel is not shown, tap Setup in the lower-
right corner to show it.  

4. Use the Preset field to load an effect. Use the controls 
below the Preset field to edit the effect. 

 

To load a program insert effect in the Channel Mixer: 

1. Set the Mixer field in the upper-left corner to Programs. 

2. In the touchscreen, tap the pad that corresponds to the 
desired program. Alternatively, double-tap the Program 
field below the Mixer field and tap the desired program. 

3. Tap the area under Inserts, and then use the screen that 
appears to load or edit effects. Alternatively, tap the 
Insert tab at the bottom of the touchscreen (tap it 
multiple times to select a different insert slot), and then 
double-tap the desired pad in the touchscreen. You 
could also use the data dial or –/+ buttons to select an 
effect immediately. 
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Submixes 

You can load up to four insert effects to each submix. You can do this in the Channel Mixer only. 

Important: Submixes are available only while using MPC Live in Controller Mode with the desktop version of the 
MPC software. 

 

To load a submix insert effect: 

1. Set the Mixer field in the upper-left corner to Submixes. 

2. In the touchscreen, tap the pad that corresponds to the 
desired program. Alternatively, double-tap the Submix 
field below the Mixer field and tap the desired program. 

3. Tap the area under Inserts, and then use the screen that 
appears to load or edit effects. Alternatively, tap the 
Insert tab at the bottom of the touchscreen (tap it 
multiple times to select a different insert slot), and then 
double-tap the desired pad in the touchscreen. You 
could also use the data dial or –/+ buttons to select an 
effect immediately. 

 

 

Masters 

You can load up to four insert effects to each master output (a stereo pair of channels: Outputs 1/2, Outputs 3/4, 
etc.). You can do this in Main Mode or the Channel Mixer. 

 

To load a master insert effect in Main Mode: 

1. If the channel strip is not already shown, tap the small 
eye icon below the Project field to show it. 

2. Tap the crown icon at the top of the channel strip. The 
channel strip will now show settings for the current 
master output. 

3. Use the Outputs field at the top of the channel strip to 
select the desired master output (Outputs 1/2, Outputs 
3/4, etc.). 

4. Tap the area under Inserts, and then use the screen that 
appears to load or edit effects. 

 

To load a master insert effect in the Channel Mixer: 

1. Set the Mixer field in the upper-left corner to Masters. 

2. In the touchscreen, tap the pad that corresponds to the 
desired master output (Outputs 1/2, Outputs 3/4, etc.). 
Alternatively, double-tap the Outputs field below the 
Mixer field. 

3. Tap the area under Inserts, and then use the screen that 
appears to load or edit effects. Alternatively, tap the 
Insert tab at the bottom of the touchscreen (tap it 
multiple times to select a different insert slot), and then 
double-tap the desired pad in the touchscreen. You 
could also use the data dial or –/+ buttons to select an 
effect immediately. 
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Send/Return Effects 

 

Send/return effects work in the following way: 

1. A pad, keygroup, program, or submix sends its audio to up to four returns at its designated send level. 

2. That audio is processed by the effects on the return. Each return can have up to four effects loaded. 

3. The processed audio is sent back to its pad, keygroup, program, or submix at a designated return level. 

 

You can load send/return effects and set return levels only in the Channel Mixer, described below. The rest of this 
section describes the different ways to set the desired send levels for pads, keygroups, programs, or submixes. 

 

To load a send/return effect to a return: 

1. In the Channel Mixer, set the Mixer field in the upper-left 
corner to Returns. 

2. In the touchscreen, tap the pad that corresponds to the 
desired return. Alternatively, double-tap the Return field 
below the Mixer field. 

3. Tap the area under Inserts, and then use the screen that 
appears to load or edit effects. Alternatively, tap the 
Insert tab at the bottom of the touchscreen (tap it 
multiple times to select a different insert slot), and then 
double-tap the desired pad in the touchscreen. You 
could also use the data dial or –/+ buttons to select an 
effect immediately. 

 

To set the return level: 

1. In the Channel Mixer, set the Mixer field in the upper-left 
corner to Returns. 

2. Tap the Level tab in the lower-left corner. 

3. In the touchscreen, tap the pad that corresponds to the 
desired return. Alternatively, double-tap the Return field 
below the Mixer field. 

4. To adjust the level of the currently selected return, use 
the data dial or –/+ buttons. Alternatively, use the level 
slider in the channel strip, or turn the corresponding Q-
Link knob. To make finer adjustments, double-tap the 
pad and adjust the larger version of the slider that appears. 
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Pads 

You can set the send levels for pads in Program Edit Mode or the Pad Mixer. 

 

To set the send levels for a pad in Program Edit Mode: 

1. While editing the desired program in Program Edit 
Mode, press the desired pad to select it. 

2. Tap the Effects tab in the lower-right corner. 

3. Use the Send knobs to set the send level for each return. 

 

To set the send levels for a pad in the Pad Mixer: 

1. Use the Program field at the top of the touchscreen to 
select the desired program. Alternatively, use the Track 
field at the top of the touchscreen to select the desired 
track—the program it uses will be selected automatically. 

2. Tap the Send tab at the bottom of the touchscreen (tap 
it multiple times to select a different send level). 

3. Press the desired pad to select it, or tap it in the 
touchscreen. Alternatively, double-tap the Pad field 
below the Program field. 

4. To set the send level, use the data dial or –/+ buttons. 
To make finer adjustments, double-tap the pad and 
adjust the larger version of the slider that appears.  

 

 

 

Keygroups 

You can set the send levels for keygroups in Program Edit Mode or the Pad Mixer. 

 

To set the send levels for a keygroup in Program Edit Mode: 

1. While using the desired program, press the desired pad 
to select its keygroup. Alternatively, use the Keygroup 
field at the top of the touchscreen.  

2. Tap the Effects tab in the lower-right corner. 

3. Use the Send knobs to set the send level for each return. 

 

To set the send levels for a keygroup in the Pad Mixer: 

1. Use the Program field at the top of the touchscreen to 
select the desired program. Alternatively, use the Track 
field at the top of the touchscreen to select the desired 
track—the program it uses will be selected automatically. 

2. Tap the Send tab at the bottom of the touchscreen (tap 
it multiple times to select a different send level). 

3. Press the desired pad to select its corresponding 
keygroup, or tap it in the touchscreen. Alternatively, 
double-tap the Keygroup field below the Program field. 

4. To set the send level, use the data dial or –/+ buttons. 
To make finer adjustments, double-tap the pad and 
adjust the larger version of the slider that appears.  
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Programs 

You can set the send levels for programs in the Channel Mixer only. 

 

To set the send levels for a program: 

1. In the Channel Mixer, set the Mixer field in the upper-left 
corner to Programs. 

2. Tap the Send tab at the bottom of the touchscreen (tap 
it multiple times to select a different send level). 

3. In the touchscreen, tap the pad that corresponds to the 
desired program. Alternatively, double-tap the Program 
field below the Mixer field. 

4. To set the send level, use the data dial or –/+ buttons. 
To make finer adjustments, double-tap the pad and 
adjust the larger version of the slider that appears. 

 

 

Submixes 

You can set the send levels for submxies in the Channel Mixer only. 

 

To set the send levels for a submix: 

1. In the Channel Mixer, set the Mixer field in the upper-left 
corner to Submixes. 

2. Tap the Send tab at the bottom of the touchscreen (tap 
it multiple times to select a different send level). 

3. In the touchscreen, tap the pad that corresponds to the 
desired submix. Alternatively, double-tap the Submix 
field below the Mixer field. 

4. To set the send level, use the data dial or –/+ buttons. 
To make finer adjustments, double-tap the pad and 
adjust the larger version of the slider that appears. 
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Audio Mixdown 
 

The Audio Mixdown screen lets you render and export either the current sequence or song as an audio file. In Song 
Mode, this will export the entire song. In Main Mode, this will export the current sequence only. 

To open the Audio Mixdown screen in Song Mode, tap Export at the bottom edge of the touchscreen. 

To open the Audio Mixdown screen in Main Mode, tap the Project field in the upper-left corner of the touchscreen, 
and then tap Export. 

 

Audio Length 

Use the Start Bar and End Bar fields to define where the 
resulting audio file will start and end, respectively. 

Use the Audio Tail field to add extra seconds to the end of 
the resulting audio file. This is useful if you are using effects or 
samples whose sounds exceed the defined audio length (e.g., 
long reverb or delay, one-shot samples with long decays, 
etc.). We recommend using an audio tail of at least a couple 
of seconds. 

 

Render Source 

Check Stereo Output and use the adjacent field to select a pair of outputs (Out 1,2–7,8 in Standalone Mode, Out 
1,2–31,32 in Controller Mode; MPC Live does not use Out 7,8 but displays them to maintain compatibility with 
MPC X, which does use them). The mixdown will be taken from these outputs. 

Check Separate Programs to create a mixdown of each program used the sequence or song. 

Check Explode Tracks to create a mixdown of each track used in the sequence (you cannot use this option for an 
entire song). This option is available only if you open the Audio Mixdown in Main Mode. In Song Mode, the Audio 
Mixdown screen will show this option as disabled. 
Important: Each pad or keygroup must have their output routed to Program to be included in the mixdown. This 
is the typical (and default) setting. See Pad Mixer > Routing to learn about this.  

 

Render Options 

If your Render Source is set to Stereo Output, check Master Inserts to include master insert effects in the mixdown. 

If your Render Source is set to Separate Programs or Explode Tracks, check Export Returns to export the 
return channel signals as separate files. 

If your Render Source is set to Stereo Output, tap Save as Project Preview to save the sequence or song as a 
project preview file (which you can play for reference in the Browser). If you check this box, Stereo Output will 
automatically be checked, as well. 

 

File Formats 

Tap WAV, AIFF, or MP3 to select the file format of the 
mixdown. 

For WAV and AIFF files, use the Bit Depth field to select a 
bit depth of 8, 16, or 24 bits, or 32 bits, floating point (32 F). 
For MP3 files, you can select a Bitrate of 128, 160, 192, or 
320 kbps. 

Use the Sample Rate field to select a sample rate of 44.1 
kHz, 48 kHz, 88.2 kHz, or 96 kHz. In most cases, we 
recommend selecting 44.1 kHz. 

 

Tap Export to enter the Save screen where you can select a name and location to save your audio mixdown. 

Tap Cancel to return to the previous screen. 



 

 
62 

 

 
Standalone vs. Controller Mode 
 

MPC Live can function in two ways: Standalone Mode and Controller Mode. 

 

 

To enter Standalone Mode, do one of the following: 

• If MPC Live is not connected to a computer, 
simply press the power switch to power it on. 

• If MPC Live is connected to your computer and you 
want to keep your MPC software open, press Menu 
to enter the Menu, and then tap the monitor/cable 
icon in the upper-right corner. When the Switch to 
Standalone Mode window appears, tap Standalone 
to continue. Your project will remain open on your 
computer, and you can continue to work on it 
independently from the project shown in your MPC 
Live. (If you tap Cancel, you can continue using MPC 
Live in Controller Mode.) 

• If MPC Live is connected to your computer and you 
want to close the MPC software, simply close the 
MPC software on your computer. When Looking 
for computer appears on MPC Live’s touchscreen, 
tap Standalone. If the Restart as Standalone 
window appears, tap Yes to continue. (If you tap 
Cancel, you can reopen your MPC software and 
continue using MPC Live in Controller Mode.) 

 

In Standalone Mode: 

• An MPC chip icon will appear under the battery 
icon in the upper-right corner. 

• MPC Live is not communicating with a computer 
over a USB connection. 

• Any files (projects, samples, etc.) that you save or 
load are in MPC Live’s internal hard drive or a 
connected USB drive or SD card. 

• Plugin programs are disabled. 
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To enter Controller Mode: 

1. Make sure MPC Live’s USB-B Port is connected to 
your computer. 

2. On your computer, open the MPC software. 

3. If MPC Live is powered off, press the power switch to 
power it on. 

4. If MPC Live is currently in Standalone Mode, press Menu 
to enter the Menu, and then tap the MPC chip icon in 
the upper-right corner. When the Enter Controller Mode 
window appears, tap Controller Mode to continue. (If 
you tap Cancel, you can continue using MPC Live in 
Standalone Mode.) Looking for computer may appear 
briefly in the touchscreen before MPC Live recognizes 
the USB connection as a controller. 

 

 

 

 

 

In Controller Mode: 

• A monitor/cable icon will appear under the battery 
icon in the upper-right corner. 

• MPC Live is communicating with a computer over 
a USB connection. 

• You can save or load files (projects, samples, etc.) to 
or from your computer as well as MPC Live’s internal 
hard drive or a connected USB drive or SD card. 

• Plugin programs are enabled. Remember to 
specify the disk directory where your plugins are 
located. This can be done in the software’s 
Preferences (in the Edit Menu). See the user guide 
in the MPC software to learn more: click the Help 
menu and select MPC User Manual. 

• The touchscreen on your MPC Live reflects what it 
is controlling in the software, but due to space and 
character limitations, the layout in the touchscreen 
is different (e.g., parameter names may be 
abbreviated, the layout may be different or spread 
across multiple tabs, etc.). 
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Modes 
 

MPC Live has a Menu page that lets you select any one of 20 modes. This chapter describes the various features 
and functions of each one. 

Click a button below to skip directly to that chapter. 
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Main Mode 

 

Main Mode gives you an overview of the most-used functions.  

 

 

To enter Main Mode, do one of the following:  

• Press Main. 

• Press Menu, and then tap Main. 

 

 

 

 

 

 

 

 

The top of the touchscreen shows the project name and timing information. 

 
 

The Project field shows the name of the current project. 

 

To view the Project window, tap the Project field. The Project window will appear, showing a list of available 
programs, sequences, and samples in the project. 

In the Project window, in additional to typical functions you can perform in lists, you can do any of the following: 

To move through a list, swipe up or down. 

To expand or collapse the list of programs or sequences, tap the arrow (∨ or >) to its left. 

To select a program, sequence, or sample, tap it. 

To immediately select a sample and enter Sample Edit Mode, double-tap it. 

To save the project, tap Save. 

To save the project with another name, tap Save As. Use the Save window that appears to save the project. 

To return to the previous screen, tap the X in the upper-right corner or anywhere outside the window. 

To delete samples from the project, tap Purge. In the screen that appears, tap Unused Samples to delete all 
unused samples from the project, tap All Samples to delete all samples from the project, or tap Cancel to return 
to the previous screen. 

To export the current sequence, tap Export. Use the Audio Mixdown screen that appears to export a song (see 
General Features > Audio Mixdown to learn about the settings in this window). To export the song instead, see 
the Song Mode chapter. 

 

The In and Out boxes indicate MPC Live is receiving or sending (respectively) MIDI messages from or to your computer. 

 

The time counter at the top of the touchscreen the current playhead position. This is shown in most of the modes. 
See General Features > Time Counter to learn about this.  
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The Timing Correct window contains various settings to help quantize the note events in your sequence. 

To open the Timing Correct settings, tap the TC/clock icon at the top of the touchscreen. 

To apply the settings you selected, tap Do It. 

To cancel and return to the previous screen, tap Close. 

  

 

Use the Type selector to set how timing corrections are applied. 

Start: The start points of note events will be extended or shortened to align with the closest time division marker in 
the grid. The start points will remain untouched. 

End: The end points of note events will be extended or shortened to align with the closest time division marker in 
the grid. The start points will remain untouched. 

Length: The end points of note events will be extended or shortened so that each event’s length is a multiple of 
the time division, regardless of where it is in the grid. The start points will remain untouched. 

Legato: The end points of note events will be extended or shortened to create a long, unbroken phrase from the 
first note event’s start point to the last note event’s end point. Each note event will sustain until another note event 
starts. If multiple note events start at the same time (and are not the last note events), their lengths will become 
identical. Selecting Legato disables all other options in this window. 

  
Without legato applied. With legato applied. 

 

Use the Time Division selector to set the quantization value. Note events will “snap” to these time divisions on the 
grid. The T indicates a triplet-based value. 
 
Alternatively, press and hold Note Repeat and use the six buttons at the bottom of the touchscreen. 
 
Use the Swing field to set the amount of swing from 50% to 75%. Swing lets you “shuffle” your beats—from subtle 
to extreme. 
 
Use the Shift Timing field to shift all note events by clock ticks.  
 
Use the Window field to set how many notes around a quantize value will be quantized. Any notes outside this range 
will not be quantized; notes inside will. 
 
Use the Strength field to set how strictly notes will be quantized (i.e., shifted toward the quantize value). Lower 
values move notes a little bit towards the closest quantize value, resulting in a less mechanical feel than a strict 
quantization (a higher value). 
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Use the Events selector to set the target range for the time 
correction. You can apply the time correction to All note 
events or to just the Selected ones. When Range is 
selected, you can define the bars as well as the pads or 
keys that will be quantized. 

 

 

 

 

 

 

The Click/Metro menu contains all settings regarding the 
metronome (click track). 

 

To open the metronome settings, tap the Metro/ 
metronome icon at the top of the touchscreen. 

 

Use the Count-In field to set if/when the metronome 
counts before recording. 

Off disables the metronome pre-count. 

Record enables the pre-count during recording only. 

Record + Play enables pre-count in both Record and 
Playback Modes. 

 

Use the Enable field to set if/when the metronome is enabled. 

Off disables the metronome. 

Play enables the metronome sound during playback only. 

Record enables the metronome sound during recording only. 

Record + Play enables the metronome to happen in both Record and Playback Modes. 

 

Use the Rate field to select the metronome click’s time division: 1/4, 1/4T, 1/8, 1/8T, 1/16, 1/16T, 1/32 or 1/32T.  
T indicates a triplet-based time division. 

 

Use the Sound field to select the sound that you want to hear for the metronome: Sidestick 1, Sidestick 2, Clap, 
Metroclick, Shake, Tambourine, or MPC Click. 

 

Use the Volume knob to set the volume of your metronome click. 

 

Tap the On/Off button to enable or disable the metronome. 

 

 

The automation button indicates the global automation state. This is shown in several modes. See General Features > 
Automation to learn about this. 
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In Main Mode, these are the buttons at the bottom of the touchscreen: 

MIDI: Tap this button to view only MIDI tracks in the Track section. 

Audio: Tap this button to view only audio tracks in the Track section. 

Track –/+: Tap one of these buttons to switch to the previous or next track, respectively. 

Mute: Tap this button to mute the current track. 

Solo: Tap this button to solo the current track. 

 

The left edge contains icons to quickly enter one of five modes. Using this strip of icons, 
you can easily jump between them: 

To enter Main Mode, tap the house icon. 

To enter Grid View, tap the grid icon. 

To enter Audio Edit Mode, tap the waveform-and-box icon. 

To enter the Track View, tap the bars-and-magnifying-glass icon. 

To enter the Step Sequencer, tap the vertical-bars icon. 

To enter XYFX Mode, tap the XY icon. 

 

There are also two small icons to the right of these that control the channel strip. 

To show or hide the channel strip, tap the eye icon. 

The icon below the eye icon indicates the type of channel strip (see next description). 
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The channel strip contains some important settings for the current pad, program, track, or 
master output, depending on the currently selected icon: 

To view the pad channel strip, tap the single-pad icon. 

To view the program channel strip, tap the four-squares icon. 

To view the track channel strip, tap the bars icon. 

To view the master channel strip, tap the crown icon. 

 

When viewing the pad channel strip while using a drum program, keygroup program, or 
clip program: 

• The first field shows the current pad number. Press a pad or tap the field to select 
a different pad. 

Tip: This is useful for mixing your pads without having to enter the Pad Mixer. 

• The second field shows where the pad is routed (which you can change). Usually, 
this is set to Program. 

• The Inserts field shows any enabled or disabled effects for that pad. Tap the area 
under Inserts to open a window where you can load, change, and enable or 
disable the effects. 

• To solo or mute the pad, tap Solo or Mute (respectively). 

• To change the panning or level of the pad, adjust the pan knob or level slider. 
The green level meter next to the slider shows the pad’s current volume level in dB. 

 

When viewing the program channel strip while using a drum program, keygroup program, 
clip program, or plugin program: 

• The first field shows the current program number and name (which you can change). 

• The second field shows where the program is routed (which you can change). 

• The Inserts field shows any enabled or disabled effects for that program. Tap the 
area under Inserts to open a window where you can load, change, and enable or 
disable the effects. 

• To solo or mute the program, tap Solo or Mute (respectively). 

• To change the program’s automation, tap the program automation button to 
cycle through its three states: 

When off, the program will ignore automation data. If you have already recorded or 
entered automation, tapping this will switch between Read (R) and Write (W) only, 
but you can override this and turn it off by pressing and holding Shift while tapping 
the button. 

Important: If you have already recorded automation and turn it off, the track will 
still use the effect and its parameter values at the point where you turned it off. 

When set to Read (R), the program will read automation data but will not record 
any additional automation over it. You can still manually edit and enter automation. 
(Think of this as a protective feature to prevent accidental changes to your 
automation while recording.) 

When set to Write (W), the program can record automation. (If you have any Q-Link 
knobs assigned to automatable parameters, make sure not to touch any accidentally 
while you are recording.) 

Tip: You can quickly set all programs and audio tracks to the same automation by 
tapping the global automation button in the upper-right corner of the touchscreen. 
See General Features > Automation to learn about this. 

• To change the panning or level of the program, adjust the pan knob or level slider. 
The green level meter next to the slider shows the program’s current volume level in dB. 
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When viewing the track channel strip while using a MIDI track (any program type): 

• The first field shows the current track (which you can change) and its name. 

• The second field shows the name of the program the track is using. 

• To solo or mute the track, tap Solo or Mute (respectively). 

• To change the panning or level of the track, adjust the pan knob or level slider. The 
blue level meter next to the slider shows the track’s current velocity level. 

Note: If the track is using a plugin program, then the slider will send CC #7 (Volume) 
and the knob will send CC #10 (Pan) to your instrument plugin. The plugin will then 
handle these messages as it normally would. 

 

 

When viewing the track channel strip while using an audio track: 

• The first field defines the input source of the external audio signal (Input 1,2, Input 
3,4, or one of Input 1–4). 

• The second field shows where the track is routed (which you can change; Out 1,2–7,8 
in Standalone Mode, Out 1,2–31,32 in Controller Mode; MPC Live does not use Out 
7,8 but displays them to maintain compatibility with MPC X, which does use them). 

• The Inserts field shows any enabled or disabled effects for that track. Tap the area under 
Inserts to open a window where you can load, change, and enable or disable the effects. 

• To solo or mute the track, tap Solo or Mute (respectively). 

• To change the audio track’s automation, tap the track automation button to cycle 
through its three states: 

When off, the audio track will ignore automation data. If you have already recorded or 
entered automation, tapping this will switch between Read (R) and Write (W) only, but you 
can override this and turn it off by pressing and holding Shift while tapping the button. 

Important: If you have already recorded automation and turn it off, the track will still 
use the effect and its parameter values at the point where you turned it off. 

When set to Read (R), the audio track will read automation data but will not record any 
additional automation over it. You can still manually edit and enter automation. (Think of 
this as a protective feature to prevent accidental changes to your automation while 
recording.) 

When set to Write (W), the audio track can record automation. (If you have any Q-Link 
knobs assigned to automatable parameters, make sure not to touch any accidentally 
while you are recording.) 

Tip: You can quickly set all programs and audio tracks to the same automation by 
tapping the global automation button in the upper-right corner of the touchscreen. See 
General Features > Automation to learn about this. 

• To change the panning or level of the track, adjust the pan knob or level slider. 

• To record-enable the track, tap the Record Arm button. When you begin audio 
recording, the audio signal will be recorded to this track. 

Tip: You can select multiple tracks in the Track View by pressing and holding Shift 
while tapping the Arm button to each track. 

 

When viewing the master channel strip: 

• The first field shows the current master output as a stereo pair (which you can change). 

• The Inserts field shows any enabled or disabled effects for that pair of outputs. Tap 
the area under Inserts to open a window where you can load, change, and enable or 
disable the effects. 

• To mute the master output, tap Mute. 

• To change the panning or level of the master output, adjust the pan knob or level 
slider. The green level meter next to the slider shows the outputs’ current volume 
level in dB. 



 

 
71 

 

 

The Sequence section shows the current sequence and its information. 

 

 

 

Use Sequence field to select a sequence. 

To edit the name of the sequence, tap the cursor icon on the right edge of the section, and use the virtual 
keyboard that appears. 

 

Use the BPM field to adjust the tempo of the sequence.  

To set whether the sequence follows its own tempo (Sequence) or a 
master tempo (Master), tap the Sequence/Master button under the BPM 
field. Alternatively, press and hold Shift+Tap Tempo. 

 

Use the Bars field to adjust the length of the sequence in bars. 

 

The Loop button shows whether the sequence (or a part of it) will loop or not. 

To enable or disable looping, tap the button. 

To set the start point and end point of loop, tap the Start or End field (respectively) and then use the data dial 
or the –/+ buttons, or double-tap the field and use the numeric keyboard that appears. 

Note: The Last Bar value of the Delete Bars and Copy Bars processes depends on the total length of the sequence. 

 

Use the Transpose field to set the transposition (in semitones) of the entire sequence.  
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To edit the sequence, tap the pencil icon on the right 
edge of the section. The Sequence Edit/Copy window will 
open. 

 

You can use any of these functions as described below. 

 

To return to Main Mode, tap Cancel or the left arrow () 
in the upper-left corner of the touchscreen. Alternatively, 
press Main. 

 

To edit the name of the sequence, tap the top of the 
touchscreen and use the virtual keyboard that appears. 

 

 

The Erase function erases all or part of a track in a specific sequence. 

To select the sequence you want to erase, use the Sequence 
field. 

To select the track you want to erase within the sequence, 
use the Track field. 

To set the time range of the sequence you want to erase, use 
the Bar, Beat, and Tick fields. The left fields set the start of the 
time range, and the right fields set the end of the time range.  

To select what types of events you erase, select one of the 
Erase options: 

All erases all pad events from the designated time range and 
reset all of its settings. 

Automation erases only automation from the designated 
time range. 

Note erases only specific pad events from the designated time 
range. In the diagram of the eight pad banks that appears, 
press each pad in each bank to select or deselect its notes. 

Except Note erases everything except pad events from the 
designated time range.  

To confirm your choice, tap Do It.  

To return to the previous screen, tap Function or anywhere 
outside the window. 

To cancel and return to Main Mode, tap Cancel. 

 

 

The Clear function erases all events from the sequence and resets 
all of its settings. 

To confirm your choice, tap Clear. 

To return to the previous screen, tap Cancel. 
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The Transpose function transposes a range of events on a track in 
a sequence. The events within that range will shift accordingly in the 
Grid View. 

To select the sequence you want to transpose, use the 
Sequence field. 

To select the track you want to transpose within the 
sequence, use the Track field. 

To set the time range of the sequence you want to transpose, 
use the two sets of Bar, Beat, and Tick fields. The left fields set 
the start of the time range, and the right fields set the end of the 
time range. 

For drum programs, use the two Pad fields to select the 
“source” pad (whose events you want to move) and “destination” 
pad (where the events will be placed). Tap each field and then 
press the desired pad. 

For keygroup programs, plugin programs, and MIDI 
programs, set the range and amount of transposition: 

Range: Use the two Note fields to set the range of notes of 
the events you want to transpose. Note events within this 
range will be transposed, while note events outside of this 
range will remain unchanged. 

Transpose: Use this field to set how many semitones up or 
down you want to transpose the note events. 

To confirm your choice, tap Do It. 

To return to the previous screen, tap Function or anywhere 
outside the window. 

To cancel and return to Main Mode, tap Cancel. 

 

 

The Bounce to Sample function immediately renders the sequence (all of its tracks) as an audio sample and places it 
in the project’s sample pool. By default, it will be named Bounce - and appended with the sequence name. 

If you have already used this function on this sequence, then you will be asked if you want to overwrite the existing 
sample with this new one or cancel. 

To continue and save the sequence over the existing one, tap Replace. 

To cancel, tap Cancel. 
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The Delete Bars function removes a range of bars from a sequence. 

To select the sequence whose bars you want to delete, use 
the Sequence field. 

To set the range of bars you want to delete, use the First Bar 
and Last Bar fields. The bar in each field and all bars in between 
them will be deleted. 

To confirm your choice, tap Do It. 

To return to the previous screen, tap Function or anywhere 
outside the window. 

To cancel and return to Main Mode, tap Cancel. 

 

 

 

The Insert Bars function adds empty bars to a sequence at a 
specified point. 

To select the desired sequence, use the Sequence field. 

To set how many bars you will insert, use the # of Bars field. 

To set the time signature of the inserted bars, use the two 
Time Sig fields. 

To set where you will insert the bars, use the Before Bar field. 
The bars will be inserted before this one. 

To confirm your choice, tap Do It. 

To return to the previous screen, tap Function or anywhere 
outside the window. 

To cancel and return to Main Mode, tap Cancel. 

 

 

The Half Length function will immediately halve the length of the sequence (without deleting any note events). 

 

 

The Double Length function will immediately double the sequence and copy all events from the first half to the second half. 
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The Copy Sequence function copies the contents of one sequence 
to another. 

To select the “source” sequence, use the Copy Contents of 
Sequence field. This is the sequence whose events you want to 
copy. 

To select the “destination” sequence, use the Over Contents 
of Sequence field. This is the sequence where the source 
sequence will be copied. 

To confirm your choice, tap Do It. 

To return to the previous screen, tap Function or anywhere 
outside the window. 

To cancel and return to Main Mode, tap Cancel. 

 

 

The Copy Bars function copies a range of bars from a sequence 
and adds them to another at a specified point. 

To select the “source” sequence, use the From Sequence 
field. This is the sequence whose bars you want to copy. 

To set the range of bars to copy in the source sequence, use 
the First Bar and Last Bar fields. 

To select the “destination” sequence, use the To Sequence 
field. This is the sequence where the source sequence bars will 
be copied. 

To set where you want to add the copied bars, use the After 
Bar field. The copied bars will be inserted after this one. 

To set how many instances of the copied bars you want to 
add, use the Copies field. 

To overwrite the destination sequence, tap Replace. 

To add the events to the destination sequence without 
erasing anything, tap Merge. 

To return to the previous screen, tap Function or anywhere 
outside the window. 

To cancel and return to Main Mode, tap Cancel. 
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The Copy Events function copies a range of events from a 
sequence and add them to another at a specified point. 

To select the “source” sequence, use the From 
Sequence field. This is the sequence whose events you 
want to copy. 

To select the “source” track, use the From Track 
field. This is the track whose events you want to copy. 

To set the time range of the events you want to copy, 
use the Bar, Beat, and Tick fields. The left fields set the 
start of the time range, and the right fields set the end of 
the time range.  

To select the “destination” sequence, use the To 
Sequence field. This is the sequence where the source 
sequence events will be copied. 

To select the “destination” track, use the To Track 
field. This is the track where the source track events will 
be copied. 

To set where you want to add the copied events, use the Bar, Beat, and Tick fields. The events will be added 
after this point. 

To set how many instances of the copied events you want to add, use the Copies field. 

To overwrite the destination sequence, tap Replace. 

To add the events to the destination sequence without erasing anything, tap Merge. 

To return to the previous screen, tap Function or anywhere outside the window. 

To cancel and return to Main Mode, tap Cancel. 

 

 

The Save Current Sequence function saves the current 
sequence to an external storage device or MPC Live’s 
internal drive. 

To select the storage device you want to view, tap it 
in the Storage column on the left. Internal is the MPC 
Live’s internal drive. MPC Documents is a shortcut to 
the MPC Documents folder on the internal drive. If you 
have USB drives connected to MPC Live’s USB ports, 
they will appear in this column, as well. 

To enter a folder, double-tap it. Alternatively, turn the 
data dial or use the –/+ buttons to move through the 
list, and press the data dial to enter a folder. You can 
also tap one of the five folder buttons in the upper-right 
to jump immediately to those pre-assigned file paths 
(see Browser to learn how to do this). 

To create a new folder, tap New Folder, use the virtual keyboard that appears to enter a name, and then tap Do 
It. You will immediately enter the new folder. 

To move up one folder level, tap the folder/ icon. 

To name the file, tap the File Name field at the bottom of the screen, and use the virtual keyboard that appears. 

To save the file, tap Save. 

To cancel and return to the Menu, tap Cancel. Alternatively, tap the  icon in the upper-left corner. 
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The Track section shows the current track, program type, and its information. 

 

 

 
 

The Track field shows the track number and its name. 

To edit the name of the track, tap the cursor icon on the right edge of the section and use the virtual keyboard that 
appears. 

 

While using a MIDI track, the program selector indicates the type of program through which the track is being 
routed. The specific program name is displayed below in the Program section. You can use the program selector to 
change program type (and then select a specific program of that type in the Program section below it). 

To select a drum program, tap the four-squares icon. 

To select a keygroup program, tap the piano-keys icon. 

To select a clip program, tap the play-button icon. 

To select a MIDI program, tap the bars icon. 

To select a CV program, tap the CV icon. Although this option is selectable, it is not available for MPC Live, 
which does not have CV outputs. 

To select a plugin program, tap the plug icon. Plugin programs are available only while using MPC Live in 
Controller Mode with the desktop version of the MPC software. 

 

While using a MIDI track, use the Length field to set how long the track is in beats. If you select the minimum value, 
Seq or 0 (if you use the numeric keypad), the track will be the exact same length as its sequence. 

Tip: This feature lets you maintain tracks of different lengths. For instance, you could play a 1-bar drum sequence 
repeatedly under a 4-bar bass line. 

 

While using a MIDI track, use the Velocity field to set how loudly or quietly a track plays relative to its recorded 
levels. When set to 50%, the track will be played with half the velocity it was originally played. When set to 200%, the 
track will play twice as loud. The maximum velocity level is still 127, though. 

 

While using a MIDI track, use the Transpose field to set the transposition (in semitones) of the entire track.  

 

While using an audio track, tap the Record Arm button to record-enable the track. When you begin audio recording, 
the audio signal will be recorded to this track. 

Tip: You can select multiple tracks in the Track View by pressing and holding Shift while tapping the Arm button to 
each track. 

 

While using an audio track, use the Monitor button to set how your audio track will be monitored. Tapping it will 
cycle through its three states: 

When set to Auto, you will hear incoming audio while the track is record-enabled only. 

When on, you will hear incoming audio whether or not the track is record-enabled. 

When off, you will never hear any incoming audio. 
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To edit the track, tap the pencil icon on the right edge of the 
section. The Track Edit window will open. 

 

 

While using MIDI tracks, you can use any of these functions as 
described below. 

 

To return to Main Mode, tap Cancel or the left arrow () in the 
upper-left corner of the touchscreen. Alternatively, press Main. 

To edit the name of the track, tap the top of the touchscreen 
and use the virtual keyboard that appears. 

 

The Clear function erases all events from the track and resets all of its settings. 

To confirm your choice, tap Clear. 

To return to the previous screen, tap Cancel. 

 

 

The Explode function immediately splits the current track into multiple tracks—one for each distinct pad or note 
(pitch, not event). The current track also remains present and intact, while each track created from it is labeled with 
the track name and pad name or number. 

 

The Double-Speed Events function immediately halves the lengths of all note events on the track as well as the 
distance between them. In other words, the track’s notes are pressed closer together so the track sounds like it is 
playing at twice the previous speed. This does not actually affect the pitches of notes or the tempo. 

 

The Half-Speed Events function immediately doubles the lengths of all note events on the track as well as the 
distance between them. In other words, the track’s notes are spread further apart so the track sounds like it is 
playing at half of the previous speed. This does not actually affect the pitches of notes or the tempo. 

 

The Copy Track function copies the contents of one track to 
another. 

To select the “source” track, tap the Copy Contents of 
Track field. This is the track whose events you want to copy. 

To select the “destination” track, tap the Over Contents of 
Track field. This is the track where the source track will be 
copied. 

To confirm your choice, tap Do It. 

To cancel and return to Main Mode, tap Cancel. 

 
 
 
The Bounce to Sample function immediately renders the track (for the current sequence only) as an audio sample 
and places it in the project’s sample pool. By default, it will be named Bounce - and appended with the track name. 
This function does not work for tracks that use MIDI programs or CV programs. 

If you have already used this function on this track, then you will be asked if you want to overwrite the existing 
sample with this new one or cancel. 

To continue and save the track over the existing one, tap Replace. 

To cancel, tap Cancel. 
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The Bounce to Audio Track function immediately renders the track (for the current sequence only) as an audio track in 
the project. The Main Mode will automatically switch to the Audio tab. By default, it will be named Audio and appended 
with a number (e.g., Audio 002). This function does not work for tracks that use MIDI programs or CV programs. 

If you have already used this function on this track, then you will be asked if you want to overwrite the existing 
sample with this new one or cancel. 

To continue and save the track over the existing one, tap Replace. 

To cancel, tap Cancel. 

 

The Export as Pattern function saves the track (for the 
current sequence only) as a pattern (.mpcpattern) to an 
external storage device or MPC Live’s internal drive. 

To select the storage device you want to view, tap it 
in the Storage column on the left. Internal is the MPC 
Live’s internal drive. MPC Documents is a shortcut to 
the MPC Documents folder on the internal drive. If you 
have USB drives connected to MPC Live’s USB ports, 
they will appear in this column, as well. 

To enter a folder, double-tap it. Alternatively, turn the 
data dial or use the –/+ buttons to move through the 
list, and press the data dial to enter a folder. You can 
also tap one of the five folder buttons in the upper-right 
to jump immediately to those pre-assigned file paths 
(see Browser to learn how to do this). 

To create a new folder, tap New Folder, use the virtual keyboard that appears to enter a name, and then tap Do 
It. You will immediately enter the new folder. 

To move up one folder level, tap the folder/ icon. 

To name the file, tap the File Name field at the bottom of the screen, and use the virtual keyboard that appears. 

To save the file, tap Save. 

To cancel and return to the Menu, tap Cancel. Alternatively, tap the  icon in the upper-left corner. 

 

 

While using audio tracks, you can use any of these 
functions as described below. 

 

To return to Main Mode, tap Cancel or the left arrow () 
in the upper-left corner of the touchscreen. Alternatively, 
press Main. 

To edit the name of the track, tap the top of the 
touchscreen and use the virtual keyboard that appears. 
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The Delete function erases the entire audio track. 

To confirm your choice, tap Clear. 

To return to the previous screen, tap Cancel. 

 

The Clear Regions function erases all regions from the audio 
track without erasing the track itself. 

 

The Reset Channel Strip function:  

• clears all Insert effect slots; 

• turns Mute, Solo, automation, and Monitor off; 

• resets the pan knob to the center; 

• resets the level slider to 0.00 dB; and  

• turns the Record Arm button off.  

It does not change the track’s inputs or outputs. 

 

The Copy Track function copies the contents of one track to 
another. 

To select the “source” track, tap the Copy Contents of 
Track field. This is the track whose events you want to copy. 

To select the “destination” track, tap the Over Contents of 
Track field. This is the track where the source track will be 
copied. 

To confirm your choice, tap Do It. 

To cancel and return to Main Mode, tap Cancel or anywhere 
outside the window. 

 

 

The Save Current Channel Strip function saves the current 
settings of the track channel strip (for the current audio track) to 
an external storage device or MPC Live’s internal drive. 

To select the storage device you want to view, tap it in 
the Storage column on the left. Internal is the MPC Live’s 
sainternal drive. MPC Documents is a shortcut to the MPC 
Documents folder on the internal drive. If you have USB 
drives connected to MPC Live’s USB ports, they will appear 
in this column, as well. 

To enter a folder, double-tap it. Alternatively, turn the data 
dial or use the –/+ buttons to move through the list, and 
press the data dial to enter a folder. You can also tap one 
of the five folder buttons in the upper-right to jump 
immediately to those pre-assigned file paths (see Browser 
to learn how to do this). 

To create a new folder, tap New Folder, use the virtual keyboard that appears to enter a name, and then tap 
Do It. You will immediately enter the new folder. 

To move up one folder level, tap the folder/ icon. 

To name the file, tap the File Name field at the bottom of the touchscreen, and use the virtual keyboard that appears. 

To save the file, tap Save. 

To cancel and return to the Menu, tap Cancel. Alternatively, tap the  icon in the upper-left corner. 
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The Program section shows the current program. This section will appear differently depending on the type of 
program selected in the Track section above it. 

 

For all program types while using MIDI tracks, you can do the following: 

To edit the name of the program, tap the cursor icon on the right edge of the section. Use the virtual keyboard 
that appears to enter a new name, and then tap Do It. 

To create a new program of the currently selected type, tap the + icon. A new program of the same type will be 
created and appended with a number (e.g., Program 002). 

 

While viewing drum programs, the Drum Program field 
shows the name of the program. 

Tap Assign Samples to enter the Sample Assign tab in 
the Browser immediately (see Browser to learn about this). 

Tap Edit Samples to enter Program Mode in Sample Edit 
Mode immediately (see Sample Edit Mode > Program 
Mode to learn about this). The sample shown will be the 
one in the top layer of the last pad you pressed. 

 

While viewing keygroup programs, the Keygroup Program 
field shows the name of the program. 

 

 

While viewing clip programs, the Clip Program field shows 
the name of the program. 

Tap Edit Clips to enter Program Edit Mode, where you 
can assign samples (clips) to pads, edit each clip, and 
configure how each clip plays when launched (see 
Program Edit Mode > Clip Programs to learn about this). 

 

While viewing plugin programs, the Plugin Program field 
shows the name of the program. 

Important: Plugin programs are available only while using 
MPC Live in Controller Mode with the desktop version of 
the MPC software. 

Use the Plugin field to select the plugin the program is 
using. In the screen that appears, you can tap the Type or 
Manufacturer button at the bottom of the touchscreen to 
enable or disable sorting of your plugins by type or maker. 

Note: You have to specify the disk directory where your 
plugins are located. This can be done in the software’s 
Preferences. To see user guide in the MPC software 
and learn how to do this, click the Help menu and select 
MPC User Manual. 

Use the MIDI Ch field to select the MIDI channel the 
program uses. Use this setting when you are working with 
a virtual instrument plugin that supports multi-mode. 

Use the Preset field to select a preset (if any) within the 
plugin the program is using. 
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While viewing MIDI programs, the MIDI Program field 
shows the name of the program. 

Use the MIDI Port field to select the port over which the 
program sends its MIDI data. 

Note: You also have to configure the MIDI ports in the 
Preferences. To see user guide in the MPC software 
and learn how to do this, click the Help menu and select 
MPC User Manual. 

Use the Program Ch field to select the program change 
message the program sends out. 

Use the MIDI Ch field to select the MIDI channel over 
which the program sends its MIDI data. 

Use the Bank MSB and Bank LSB fields to select the 
messages for Most Significant Byte and Least Significant 
Byte (respectively) that the program sends out. 

 

While viewing CV programs, the CV Program field shows the 
name of the program. Although this option is selectable, it is 
not available for MPC Live, which does not have CV outputs. 

Use the CV/Gate field to select the CV outputs over 
which the program sends its CV/Gate data. 

 

 

To edit the program, tap the pencil icon on the right edge 
of the section. The Program Edit/Copy window will open. 

 

You can use any of these functions as described below. 

To return to Main Mode, tap Cancel or the left arrow () 
in the upper-left corner of the touchscreen. Alternatively, 
press Main. 

To edit the name of the program, tap the top of the 
touchscreen and use the virtual keyboard that appears. 

 

 

 

The Delete function erases all events from the track and 
resets all of its settings. 

To confirm your choice, tap Clear. 

To return to the previous screen, tap Cancel. 

 

 

The Duplicate function immediately creates an identical 
program. The duplicate program will use the same name 
but appended with a number (e.g., Program 002).  
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The Duplicate to Track function immediately creates an identical program on a new track. The duplicate program 
will use the same name but appended with a number (e.g., Program 002). The new track will be named Track and 
appended with a number (e.g., Track 06). 

 

The Bounce to Sample function immediately renders all tracks that use that program (for the current sequence only) 
as an audio sample and places it in the project’s sample pool. By default, it will be named Bounce - and appended with 
the program name. This function does not work for MIDI programs or CV programs. 

If you have already used this function on this program, then you will be asked if you want to overwrite the existing 
sample with this new one or cancel. 

To continue and save the program over the existing one, tap Replace. 

To cancel, tap Cancel. 

 

The Bounce to Audio Track function immediately renders that program (for the current sequence only) as an audio 
track in the project. The Main Mode will automatically switch to the Audio tab. By default, it will be named Audio and 
appended with a number (e.g., Audio 002). This function does not work for MIDI programs or CV programs. 

If you have already used this function on this track, then you will be asked if you want to overwrite the existing 
sample with this new one or cancel. 

To continue and save the track over the existing one, tap Replace. 

To cancel, tap Cancel. 

 

The Save Current Program or Save Current Sample 
function saves the current program or sample (the top 
layer of the last pad you pressed) (respectively) to an 
external storage device or MPC Live’s internal drive. 

To select the storage device you want to view, tap it 
in the Storage column on the left. Internal is the MPC 
Live’s internal drive. MPC Documents is a shortcut to 
the MPC Documents folder on the internal drive. If you 
have USB drives connected to MPC Live’s USB ports, 
they will appear in this column, as well. 

To enter a folder, double-tap it. Alternatively, turn the 
data dial or use the –/+ buttons to move through the 
list, and press the data dial to enter a folder. You can 
also tap one of the five folder buttons in the upper-right 
to jump immediately to those pre-assigned file paths 
(see Browser to learn how to do this). 

To create a new folder, tap New Folder, use the virtual keyboard that appears to enter a name, and then tap Do 
It. You will immediately enter the new folder. 

To move up one folder level, tap the folder/ icon. 

To name the file, tap the File Name field at the bottom of the touchscreen, and use the virtual keyboard that 
appears. 

To save the file, tap Save. 

To cancel and return to the Menu, tap Cancel. Alternatively, tap the  icon in the upper-left corner. 

 

For all program types while using audio tracks, you can do the following: 

To change the input source, tap Input Config. This will show or hide the track channel strip. If you are viewing 
the audio track channel strip (not the master channel strip), the first field will be automatically selected. 

To enter Audio Edit Mode, tap Edit Audio. This is the same as tapping the waveform-and-box icon on the left 
edge of the touchscreen. 
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Grid View 
 

Grid View lets you view and edit the note events of each track of a sequence in a project and 
their velocities. This mode has two different appearances: one for drum programs and one for 
keygroup programs, MIDI programs, and plugin programs. 

For drum programs, the left column shows you all available pads in a vertical view with their corresponding data.  

For keygroup programs, plugin programs, and MIDI programs, the left column shows a vertical “piano roll” keyboard.  

 

To enter Grid View, press Menu, and then tap Grid View. 

 

  
Grid View of a drum program.   Grid View of a keygroup program or MIDI program. 

 

 

The top of the touchscreen shows the track name, sequence and timing information, and editing tools. 

 

 

 

Use the Track field to select which track of the current sequence you want to show in the grid. 

 

Use the Bars field to set the length of the sequence. 

 

The time counter at the top of the touchscreen the current playhead position. This is shown in most of the modes. 
See General Features > Time Counter to learn about this.  
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In Grid View, these four icons enable you to use different functions in the grid. Tap one to 
select its mode: 

 

 

Pencil: Draw Mode: 

To enter a note in an empty grid square, tap the square. 

To select a note, tap it. 

To move a note, tap and drag it to another grid square. 

To erase a note, double-tap it. 

 

Eraser: Erase Mode: 

To erase a note, tap it. 

 

Select Box: Select Mode: 

To select a note, tap it.  

To select multiple notes, tap and drag across the grid to create a box around them. 

To move a note, tap and drag it to another grid square. 

To move multiple notes, select them as described above, and tap and drag them. 

To erase multiple notes, select them as described above, and then select the Eraser tool and tap any of 
the selected notes. 

 

Magnifying Glass: Navigation Mode: 

To move to another part of the grid, tap and drag it. 

To zoom in or out, spread or pinch your fingers (respectively) on the grid. You can do this vertically, 
horizontally, or both at the same time. 

 

 

The Settings window lets you configure certain Grid View settings. 

To view the Settings, tap the gear icon. 

 

Use the Hitting Pad Selects All Events selector to turn the feature 
on or off. When on, pressing a pad will automatically select all note 
events for that pad in the sequence on that track. When off, pressing 
a pad will simply play its sound without selecting any note events. 

 

Use the Auto-Scroll selector to set how the screen behaves 
relative to the audio playhead. 

Follow: Depending on the zoom setting, the grid will scroll along 
in the background while keeping the audio playhead centered. 

Page: The grid will move to the “next page” to follow the audio 
playhead. 

Off: The grid will not move at all. 

These functions also apply to the sample waveform in Sample Edit 
Mode. 
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The left edge contains icons to quickly enter one of five modes. Using this strip of icons, you can easily 
jump between them: 

To enter Main Mode, tap the house icon. 

To enter Grid View, tap the grid icon. 

To enter the Track View, tap the bars-and-magnifying-glass icon. 

To enter the Step Sequencer, tap the vertical-bars icon. 

To enter XYFX Mode, tap the XY icon. 

 

 

 

 

 

 
 

Regardless of which tool is selected, you can do any of the following to move, lengthen, shorten, or transpose any 
selected note/notes. 

To automatically set the grid to view one pad bank and two bars, tap the grid-and-magnifying-glass icon in 
the lower-left corner. 

To undo your last action, press Undo. 

To redo the last action you undid, press Shift+Undo/Redo. 

To select all notes for a pad, press the desired pad. 

To move the selected notes, tap Nudge at the bottom of the touchscreen, and then use the data dial or –/+ 
buttons to shift the notes left or right. By default, you can position notes only by quantization values defined by the 
Time Correct value (learn about this feature here in the Main Mode chapter). 

To move the selected notes without restricting (“snapping”) them to the quantization grid, tap and hold Don’t 
Snap in the lower-left corner of the touchscreen, and then use the data dial or –/+ buttons to shift the notes. In 
this case, each nudge is equivalent to four ticks. 

To adjust the start point or end point of the selected notes (without changing their position), tap Edit Start at 
the bottom of the touchscreen, and then use the data dial or –/+ buttons. 

To transpose the selected notes up or down, tap Transpose at the bottom of the touchscreen, and then use 
the data dial or –/+ buttons. 

To switch to the previous or next track, press and hold Shift, and then tap Track – or Track + (respectively) at 
the bottom of the touchscreen. 

To mute or solo the track, press and hold Shift, and then tap Mute or Solo (respectively) at the bottom of the 
touchscreen. 
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To open the Timing Correct window, press and hold Shift, and then tap TC at the bottom of the touchscreen. This 
feature is described here in the Main Mode chapter. 

To select a time division directly, double-tap the down arrow () in the upper-left corner of the grid and select a 
time division. 

 

To adjust the metronome settings, press and hold Shift, and then tap Click at the bottom of the touchscreen. This 
feature is described here in the Main Mode chapter. 

 

Grid View also contains a velocity lane where you can easily adjust note velocities. 

 

  
The velocity lane in the Grid View.  The taller velocity lane in the Grid View. 

 

 

To show or hide the velocity lane: 

1. Tap the up arrow (∧) button in the lower-right corner to show the velocity lane. 

2. Tap the up arrow (∧) button once more to show a taller version of the velocity lane. The button will now show a 
down arrow (∨). 

3. Tap the down arrow (∨) to hide the velocity lane. 

 

Each note’s velocity is represented by a vertical bar. The higher and more red the bar is, the higher the velocity is. 
Yellow bars indicate a lower velocity. Bars with a grey line at the top indicate a currently selected note. 

To adjust the velocity of the selected notes, tap Velocity at the bottom of the touchscreen, and then use the data 
dial or –/+ buttons. The numeric value will appear on the touchscreen. 
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Audio Edit Mode 
 
Audio Edit Mode lets you view and edit the audio tracks of a sequence in a project. 

 

 

To enter Audio Edit Mode, press Menu, and then tap Audio Edit Mode. 

 
Audio Edit Mode. 

 

 

Below is a brief step-by-step process so you can get 
started recording audio tracks quickly. Continue 
reading the rest of this chapter to learn how to use 
Audio Edit Mode in different cases. 

 

To record in Audio Edit Mode (or Main Mode): 

1. If the channel strip is not already shown on the left 
side of the screen, tap the small eye icon to show it. 

2. Connect a synthesizer or other line-level audio source 
to the appropriate input/inputs of your MPC Live. Set 
the Line/Phono selector appropriately, too. 

3. Double-tap the first field to select the input source 
of the external audio signal (Input 1,2, Input 3,4, or 
one of Input 1–4). 

4. Double-tap the second field to select where the track is routed (Out 1,2–7,8 in Standalone Mode, Out 1,2–31,32 
in Controller Mode; MPC Live does not use Out 7,8 but displays them to maintain compatibility with MPC X, 
which does use them). 

5. Tap the Monitor button to set how your audio track will be monitored. Tapping it will cycle through its three states: 

When set to Auto, you will hear incoming audio while the track is record-enabled only. 

When on, you will hear incoming audio whether or not the track is record-enabled. 

When off, you will never hear any incoming audio. 

6. Turn the Rec Vol knob to set the input level while sending an audio signal into MPC Live. You should now see the 
level in the meter. Make sure it does not exceed the maximum level (the meter should not be “peaking” constantly). 

7. If the Solo and Mute buttons are on, tap them so they are off. We also recommend tapping the track automation 
button below them so it is off (not R/Read or W/Write). 
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8. Tap the Rec Arm button next to the pan knob to record-enable the track. 

9. Press Rec or Overdub to record-arm MPC Live. 

10. To start recording, press Play or Play Start—then play your audio source. You should hear your existing 
sequence playing in the background. You’ll see the waveform appear as a single “track region” as you record. 

11. To stop recording, press Stop.  

 

The top of the touchscreen shows the track name, sequence and timing information, and editing tools. 

 
 

Use the Track field to select which track of the current sequence you want to show in the grid. 

 

Use the Bars field to set the length of the sequence. 

 

The time counter at the top of the touchscreen the current playhead position. This is shown in most of the modes. 
See General Features > Time Counter to learn about this.  

 

In Audio Edit Mode, these five icons enable you to use different functions in the 
track. Tap one to select its mode: 

 

 

Arrow: Selection Mode: 

To select a track region, tap it. 

To move a track region, tap and drag it. 

To shorten or lengthen a track region, tap its edge and drag it. 

 

Eraser: Erase Mode: 

To erase a track region, tap it. 

 

Scissors: Cut Mode: 

To split the track at a specific point (creating a track region on either side), tap that point in the track. 

To select a track region, tap its left-most edge. 

 

Mute: Mute Mode: 

To mute or unmute a track region, tap it. 

 

Magnifying Glass: Navigation Mode: 

To move to another part of the track, tap and drag it. 

To zoom in or out, spread or pinch your fingers (respectively) on the grid. You can do this vertically, 
horizontally, or both at the same time. 
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The Settings window lets you configure certain Audio Edit Mode 
settings. 

To view the Settings, tap the gear icon. 

 

Use the Auto-Scroll selector to set how the screen behaves 
relative to the audio playhead. 

Follow: Depending on the zoom setting, the waveform display 
will scroll along in the background while keeping the audio 
playhead centered. 

Page: The waveform display will move to the “next page” to 
follow the audio playhead. 

Off: The waveform display will not move at all. 

These functions also apply to the sample waveform in Sample Edit Mode. 

 
 
The left edge contains icons to quickly enter one of five modes. Using this strip of icons, you can easily jump 
between them: 

To enter Main Mode, tap the house icon. 

To enter Audio Edit Mode, tap the waveform-and-box icon. 

To enter the Track View, tap the bars-and-magnifying-glass icon. 

To enter the Step Sequencer, tap the vertical-bars icon. 

To enter XYFX Mode, tap the XY icon.  

 

 

There are also two small icons to the right of these that control the channel strip. 

To show or hide the channel strip, tap the eye icon. 

The icon below the eye icon indicates the type of channel strip (see next description). 

 

The channel strip contains some important settings for the audio track or master output, 
depending on the currently selected icon: 

To view the track channel strip, tap the waveform icon. 

To view the master channel strip, tap the crown icon. 

 

When viewing the track channel strip while using an audio track: 

• The first field defines the input source of the external audio signal (Input 1,2, Input 
3,4, or one of Input 1–4). 

• The second field shows where the track is routed (which you can change; Out 1,2–7,8 
in Standalone Mode, Out 1,2–31,32 in Controller Mode; MPC Live does not use Out 
7,8 but displays them to maintain compatibility with MPC X, which does use them). 

• The Inserts field shows any enabled or disabled effects for that track. Tap the area under 
Inserts to open a window where you can load, change, and enable or disable the effects. 

• To solo or mute the track, tap Solo or Mute (respectively). 

• To set how your audio track will be monitored, tap the Monitor button to cycle 
through its three states: 

When set to Auto, you will hear incoming audio while the track is record-enabled only. 

When on, you will hear incoming audio whether or not the track is record-enabled. 

When off, you will never hear any incoming audio. 
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• To change the audio track’s automation, tap the track automation button to cycle 
through its three states: 

When off, the program will ignore automation data. If you have already recorded or 
entered automation, tapping this will switch between Read (R) and Write (W) only, but you 
can override this and turn it off by pressing and holding Shift while tapping the button. 

Important: If you have already recorded automation and turn it off, the track will still 
use the effect and its parameter values at the point where you turned it off. 

When set to Read (R), the program will read automation data but will not record any 
additional automation over it. You can still manually edit and enter automation. (Think 
of this as a protective feature to prevent accidental changes to your automation while 
recording.) 

When set to Write (W), the program can record automation. (If you have any Q-Link 
knobs assigned to automatable parameters, make sure not to touch any accidentally 
while you are recording.) 

Tip: You can quickly set all programs and audio tracks to the same automation by 
tapping the global automation button in the upper-right corner of the touchscreen. See 
General Features > Automation to learn about this. 

• To change the panning or level of the track, adjust the pan knob or level slider. 

• To record-enable the track, tap the Record Arm button. When you begin audio 
recording, the audio signal will be recorded to this track. 

Tip: You can select multiple tracks in the Track View by pressing and holding Shift 
while tapping the Arm button to each track. 

 

When viewing the master channel strip: 

• The first field shows the current master output as a stereo pair (which you can change). 

• The Inserts field shows any enabled or disabled effects for that pair of outputs. Tap 
the area under Inserts to open a window where you can load, change, and enable or 
disable the effects. 

• To mute the master output, tap Mute. 

• To change the panning or level of the master output, adjust the pan knob or level 
slider. 
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Regardless of which tool is selected, you can do any of the following to edit the selected audio track regions. 

Tip: If you want to hear only the audio track while editing, use the Solo button in the track channel strip to solo it. 

To select a track region, tap the arrow icon to enter Selection Mode and tap a track region. When a track region 
is selected, all region parameters will be available to edit. 

To undo your last action, press Undo. 

To redo the last action you undid, press Shift+Undo/Redo. 

To move the selected track region, tap Nudge at the bottom of the touchscreen, and then use the data dial or –
/+ buttons to shift the track region left or right. By default, you can move a track region only by quantization values 
defined by the Time Correct value (learn about this feature here in the Main Mode chapter). 

To move the selected track region without restricting (“snapping”) it to the quantization grid, tap and hold 
Don’t Snap in the lower-left corner of the touchscreen, and then use the data dial or –/+ buttons to shift the track 
region. In this case, each nudge is equivalent to four ticks. 

To adjust the start point or end point of the selected track region (without changing its position), tap Edit Start 
at the bottom of the touchscreen, and then use the data dial or –/+ buttons. 

To split the track at the current playhead position (creating a track region on either side), tap Split at the 
bottom of the touchscreen. 

To copy and paste the selected track region, press 
Copy, turn the data dial to move the highlighted track 
region, and then press the data dial to paste it at its 
current location. 

To duplicate the selected track region, tap Duplicate 
at the bottom of the touchscreen. The duplicate track 
region will appear immediately after the original one. 

To create a fade-in or fade out for the selected 
track region, use the Fade In or Fade Out fields, 
respectively. The fades will be shown as a sloped line 
at the start or end of the track region. 

To set the level of the selected track region, use the 
Level field. The waveform amplitude will change 
accordingly. 
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To reverse the selected track region, tap Reverse. 

 

 

 

 

 

 

To mute the selected track region, tap Mute. 

 

 

 

 

 

 

To lengthen or shorten the selected track region without changing its pitch, tap Warp, which will enable the 
Semi, Fine, and BPM fields next to it. Use the BPM field to change the tempo, which will change the length of the 
track region accordingly. Use the Semi and Fine fields if you want to change the pitch (this is useful for matching 
the durations of two samples with different pitches). 

Tip: You can configure audio track recording to ensure the resulting track region is warped automatically. You can 
then adjust the sequence tempo while track region remains in time. See Menu > Preferences > Other to learn 
about this. 

Note: When you record an audio file, the current sequence tempo will be embedded with it. This information is 
stored within the sample file when you save the project. When you warp an audio track region, the warping 
algorithm uses this sequence tempo and the current value in the BPM field to generate the “stretch factor.” 

Note: The Warp algorithms are very CPU-intensive and can result in audio drop-outs during playback if used too 
freely. Be mindful of how (and how often) you use the warp function. You can reduce the CPU resources required 
by doing any/all of the following: 

• Minimize the amount of pitch adjustment (e.g., the Semi and Fine fields). 

• Avoid warping very small track regions. 

• Warp as few tracks or track regions as possible (i.e., reduce the number of total number of voices [of the 
polyphonic limit] that use the warp algorithm at a given time). 

 

To open the Timing Correct window, press and hold Shift, and then tap TC at the bottom of the touchscreen. 
This feature is described here in the Main Mode chapter. 

 

To adjust the metronome settings, press and hold Shift, and then tap Click at the bottom of the touchscreen. 
This feature is described here in the Main Mode chapter. 

 

To switch to the previous or next track, press and hold Shift, and then tap Track – or Track + (respectively) at 
the bottom of the touchscreen. 

 

To mute or solo the track, press and hold Shift, and then tap Mute or Solo (respectively) at the bottom of the 
touchscreen. 



 

 
94 

 

 
Track View 
 

Track View gives you an overview of the tracks of each sequence. Use this mode to edit 
tracks and sequences simultaneously. 

 

To enter the Track View, do either of the following: 

• Press Menu, and then tap Track View. 

• Press Shift+Main/Track. 

 

 
 

Each horizontal strip represents a track in the current sequence. MIDI tracks and audio tracks are grouped together. 
MIDI tracks are listed first, audio tracks are listed second. 

To move through the list of tracks, swipe up or down. 

To collapse or expand each group of tracks, tap the up arrow () or down arrow () icon above the first 
track’s Mute button. 

 

The top of the touchscreen shows the sequence name and timing information. 

 
 

Use the Sequence field to select which sequence contains the tracks you want to show below. 

 

The time counter at the top of the touchscreen the current playhead position. This is shown in most of the modes. 
See General Features > Time Counter to learn about this.  

 

The Settings window lets you configure certain Track View settings. 

To view the Settings, tap the gear icon. 

Use the Show Unused Tracks selector to turn this feature on or 
off. When on, tracks with a sequence, program, etc. will still appear 
in the Track View. When off, only tracks with a sequence, program, 
etc. will appear. 
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The left edge contains icons to quickly enter one of five modes. Using this strip of icons, you can easily jump 
between them: 

To enter Main Mode, tap the house icon. 

To enter Grid View, tap the grid icon. 

To enter Audio Edit Mode, tap the waveform-in-box icon. 

To enter the Track View, tap the bars-and-magnifying-glass icon. 

To enter the Step Sequencer, tap the vertical-bars icon. 

To enter XYFX Mode, tap the XY icon. 

 

 

To open the Timing Correct settings, tap TC at the bottom of the touchscreen. This window is described in the 
here in the Main Mode chapter. 

 

To open the metronome settings, tap Click at the bottom of the touchscreen. This window is described in the here 
in the Main Mode chapter. 

 

To select the previous or next track of the same type (MIDI or audio), tap Track – or Track + (respectively) at the 
bottom of the touchscreen. Alternatively, tap the track in the main part of the touchscreen. 

 

 

MIDI Tracks 

 

 
 

All MIDI tracks in the project are grouped together in the upper half of the Track View. 

To show or hide them, tap the  or  arrow icon. 

 

Use the Program field to select the program that the track will use. 

 

Use the Length field to set how long the track is. If you select the minimum value, Seq or 0 (if you use the numeric 
keypad), the track will be the exact same length as its sequence. 

Tip: This feature lets you maintain tracks of different lengths. For instance, you could play a 1-bar drum sequence 
repeatedly under a 4-bar bass line. 

 

Use the Velocity field to set how loudly or quietly a track plays relative to its recorded levels. When set to 50%, the 
track will be played with half the velocity it was originally played. When set to 200%, the track will play twice as loud. 
The maximum velocity level is still 127, though. 

 

Use the Transpose field to set the transposition (in semitones) of the entire track.  

 

Use the level slider to change the level of the track. The level meter above the slider shows the track’s current level. 

 

Use the pan knob to change the panning of the track. 

 

Use the Solo and Mute buttons to solo or mute the track (respectively). 

Alternatively, tap Mute or Solo (respectively) at the bottom of the touchscreen to mute the currently selected track. 
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Audio Tracks 
 

 

 

All audio tracks in the project are grouped together in the lower half of the Track View. 

To show or hide them, tap the  or  arrow icon. 

 

Use the Input field to set the track’s input/inputs. 

 

Use the Arm button to record-enable the track. When you begin audio recording, the audio signal will be recorded to 
this track. You can select multiple tracks by pressing and holding Shift while tapping the Arm button to each track. 

 

Use the Monitor button to set how your audio track will be monitored. Tapping it will cycle through its three states: 

When set to Auto, you will hear incoming audio while the track is record-enabled only. 

When on, you will hear incoming audio whether or not the track is record-enabled. 

When off, you will never hear any incoming audio. 

 

Use the level slider to change the level of the track. The level meter above the slider shows the track’s current level. 

Use the pan knob to change the panning of the track. 

 

Use the Solo and Mute buttons to solo or mute the track (respectively). 

Alternatively, tap Mute or Solo (respectively) at the bottom of the touchscreen to mute the currently selected track. 

 

Use the Add new audio track button to create a new audio track. 
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Step Sequencer 
 

The Step Sequencer lets you create or edit sequences by using the pads as “step buttons,” 
simulating the experience of a traditional step-sequencer-style drum machine.  

This is available for MIDI tracks only, not audio tracks. 

 

To enter the Step Sequencer, press Menu, and then tap Step Sequencer. 

 

 

 

 
The top of the touchscreen shows the track name and information as well as sequence and timing information. 

 
 
 

The Track field shows the name of the current track. 

 

Use the Track Length field to set how long the track is. If you select the minimum value, Sequence or 0 (if you use 
the numeric keypad), the track will be the exact same length as its sequence. 

Tip: This feature lets you maintain tracks of different lengths. For instance, you could play a 1-bar drum sequence 
repeatedly under a 4-bar bass line. 

 

Use the Bars field to adjust the length of the sequence in bars. 

 

Use the BPM field to adjust the tempo of the sequence.  

To set whether the sequence follows its own tempo (Seq) or a master tempo (Mst), tap the 
Seq/Mst button next to the BPM field. Alternatively, press and hold Shift+Tap Tempo. 

 

The time counter at the top of the touchscreen the current playhead position. This is shown in most 
of the modes. See General Features > Time Counter to learn about this.  
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The left edge contains icons to quickly enter one of five modes. Using this strip of icons, you can easily 
jump between them: 

• To enter Main Mode, tap the house icon. 

• To enter Grid View, tap the grid icon. 

To enter Audio Edit Mode, tap the waveform-and-box icon. 

• To enter the Track View, tap the bars-and-magnifying-glass icon. 

• To enter the Step Sequencer, tap the vertical-bars icon. 

• To enter XYFX Mode, tap the XY icon. 

 

 

Use the Time Division selector to set the value that determines how many steps each bar of the sequence 
will have. The T indicates a triplet-based value. 

Alternatively, tap TC at the bottom of the touchscreen to open the Timing Correct window. This is 
described here in the Main Mode chapter. 

 

To enter or delete steps in a sequence: 

1. Use the Pad –/+ buttons at the bottom of the touchscreen to select the pad whose steps you want to enter or 
delete. The current pad number is shown in the upper-left corner. 

Alternatively, use the Pad Select feature: Tap and hold Pad Sel, press the desired pad, and then release Pad 
Sel. You can also use Pad Select as a “latching” feature: tap Pad Sel so it is activated, press the desired pad, 
and then tap Pad Sel once more so it is deactivated. 

2. Use the Bar –/+ buttons at the bottom of the touchscreen to select the bar of the sequence whose steps you 
want to enter or delete. The current bar number is shown in the upper-left corner. 

3. Press the pads of your MPC Live, or tap a button at the bottom of the sequencer. Each pad corresponds to a 
step in the bar and will light with a color corresponding to its velocity. 

Keep in mind that for time divisions larger than 16, the bar’s steps will be represented by multiple pad banks. In 
this case, use Pad Bank Buttons A and B to view all the steps within a bar. 

 

For time divisions larger than 16, the bar’s steps will be represented by multiple pad banks. In 
this case, use the left and right arrows (< and >) by the step numbers (1–16, 17–32, etc.) to 
change which steps are shown in the sequencer. 

Alternatively, use Pad Bank Buttons A and B. 

 

To adjust the velocities of the steps, do either of the following: 

• Tap anywhere on the velocity bar of a step. The top of the velocity bar will jump to that point. 

• Use the slider on the right edge of the touchscreen to increase or decrease the velocities of all steps. 

 

Use the Nudge < and Nudge > arrows to shift each step left or right (respectively) one step. This is useful for 
experimenting with different rhythmic permutations. 

 

Use the slider on the right edge of the touchscreen to increase or decrease the velocities of all steps.  

 

Use the Flip Steps button to switch which steps have notes entered and which do not have notes. 
Steps that previously had no notes will now have notes at full velocity (127). Steps that previously had 
notes will now be empty. 
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Tap Presets to show or hide the preset sequence controls. These controls let you manipulate and 
transform the velocities of the current bar in the sequence. 

 

The first button will apply ascending or descending velocities to the steps. Each time you tap it, it will 
cycle through these options: 

• The velocities will ascend to a single peak at the end of the bar. 

• The velocities will ascend to two peaks—one after each half of the bar. 

• The velocities will ascend to four peaks—one after each quarter of the bar. 

• The velocities will descend from a single peak at the start of the bar.  

• The velocities will descend from two peaks—one after each half of the bar. 

• The velocities will descend from four peaks—one at the start each quarter of the bar. 

 

The second button will set the velocities of the steps to be at the maximum value (127) or minimum values (1), 
depending on their position in the bar. Each time you tap it, it will cycle through these options: 

• The velocities of the first half of the bar will be set to 1. The velocities of the second half will be set to 127. 

• The velocities of the first and third quarters of the bar will be set to 1. The velocities of the second and fourth 
quarters will be set to 127. 

• The velocities of the first, third, fifth, and seventh eighths of the bar will be set to 1. The velocities of the 
second, fourth, sixth, and eighth eighths will be set to 127. 

• The velocities of the first half of the bar will be set to 127. The velocities of the second half will be set to 1. 

• The velocities of the first and third quarters of the bar will be set to 127. The velocities of the second and 
fourth quarters will be set to 1. 

• The velocities of the first, third, fifth, and seventh eighths of the bar will be set to 127. The velocities of the 
second, fourth, sixth, and eighth eighths will be set to 1. 

 

The third button will apply ascending or descending velocities to the steps. Each time you tap it, it will cycle through 
these options: 

• Across the entire bar, the velocities will ascend to a peak and then descend from it.  

• In each half of the bar, the velocities will ascend to a peak and then descend from it. 

• In each quarter of the bar, the velocities will ascend to a peak and then descend from it. 

• Across the entire bar, the velocities will descend from a peak into a valley and then ascend back up to the peak. 

• In each half of the bar, the velocities will descend from a peak into a valley and then ascend back up to the peak. 

• In each quarter of the bar, the velocities will descend from a peak into a valley and then ascend back up to 
the peak. 

 

The fourth button will swap the first half and second half of the bar. In other words, the first half of the bar will 
become a mirrored image of the second half, and vice versa. 

 

The fifth button will invert the velocities of all steps with entered notes. The sum of the old and new velocities will 
equal 127. The exception is a velocity of 127 or 1 as a step with a note cannot have a velocity of 0. 

Examples: 

Steps with velocities of 40 will now have velocities of 87, and vice versa. 

Steps with velocities of 75 will now have velocities of 52, and vice versa. 

Steps with velocities of 127 will now have velocities of 1, and vice versa. 
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XYFX Mode 
 

XYFX Mode turns the touchscreen into an XY pad where each axis represents the range of an effect 
parameter. As you move your finger on the XY pad, the current position will determine the current value 
of the two parameters. You can use this mode to create interesting effect automation on your tracks. 

The effect you control in XYFX Mode acts like an insert effect on that program. In fact, XYFX is the name of the insert 
effect you have to load to the program before you can use this mode. Learn more about this in General Features > 
Effects. 

 

To enter XYFX Mode, press Menu, and then tap XYFX. 

When you first enter this mode in a project, you may be prompted to load XYFX to the program. Tap Insert XYFX to 
do this. 

Note: If you already have four insert effects loaded, you will need to clear one of the insert effect slots before doing this. 

 

 

 

The left edge contains icons to quickly enter one of five modes. Using this strip of icons, you can easily 
jump between them: 

• To enter Main Mode, tap the house icon. 

• To enter Grid View, tap the grid icon. 

To enter Audio Edit Mode, tap the waveform-and-box icon. 

• To enter the Track View, tap the bars-and-magnifying-glass icon. 

• To enter the Step Sequencer, tap the vertical-bars icon. 

• To enter XYFX Mode, tap the XY icon. 

 

Use the XYFX Location field to select the signal to which the effects will be applied: the current program 
(Program) or a master output (a stereo pair of channels: Output 1/2, Output 3/4, etc.). 

 

The time counter in the upper-right corner the current playhead position. This is shown in most of the 
modes. See General Features > Time Counter to learn about this.  

 

The automation button indicates the global automation state. This is shown in several modes. See General 
Features > Automation to learn about this. 
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Touch or move your finger on the gridded part of 
the touchscreen. A marker will follow your finger to 
indicate the current position. The X axis is the 
horizontal axis, increasing in value as you move 
right. The Y axis is the vertical axis, increasing in 
value as you move up. Each axis is labeled with its 
assigned parameter. 

When an effect has a beat division parameter, the 
current division will be highlighted as an entire 
column. 

Effects are differently colored for easy visual 
distinction: beat-synchronized effects are blue, 
while manually controlled effects are green. 

 

While touching the XY pad, tap Latch in the lower-
left corner to keep the marker on the XY pad even 
after you release it. The marker will remain there 
until you touch another part of the XY pad or until 
you tap Latch again. 

 

Use the Setup button to show or hide the Setup 
panel, which controls how the XY pad behaves. 

 

Use the Preset field to select the effect you want 
to use in XYFX Mode. 

 

Use the Attack knob to set the length of the attack 
phase of the envelope, which is triggered when you 
touch the XY pad. In other words, this determines 
how long it takes the effect to fully respond to your 
touch. 

 

Use the Release knob to set the length of the 
release phase of the envelope, which is triggered 
when you release the XY pad. In other words, this 
determines how long it takes the effect to fully 
deactivate after you stopping touching the XY pad. 

 

Use the Wet/Dry knob to set the blend the original 
signal (dry) and the effect signal (wet). 

 

The X Axis and Y Axis fields show which parameters 
are controlled by each axis. This varies depending 
on the effect you are using. 
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Sample Edit Mode 
 

Sample Edit Mode lets you edit samples using various functions. 

 

 

To enter Sample Edit Mode, press Menu, and then tap 
Sample Edit. 

 

To select a sample to edit, do any of the following: 

• Use the Sample field at the top of the touchscreen. 

• In Main Mode, tap the Project field at the top of the 
touchscreen, and then double-tap a sample in the list 
on the right side. 

• In the Browser, tap the Project button with the P/page 
icon at the bottom of the touchscreen, and then 
double-tap a sample in the list on the right side. 

 

To edit the name of the sample, tap the keyboard icon next 
to the name at the top of the touchscreen, and use the virtual 
keyboard that appears. 

 

To delete the sample, tap the trash-can icon next to the 
name at the top of the touchscreen. In the screen that 
appears, you will see the programs that use this sample within 
your project. Tap Delete Sample to continue, or tap Cancel 
to return to the previous screen.  

 

The upper half of the touchscreen shows the waveform. The 
lower half shows the editing controls. 

The waveform display shows the “active” section of the 
sample waveform. Swipe left or right on the waveform to 
move through it. 

Above the waveform is the timeline, shown in Samples, Time (in 
seconds and milliseconds), or Beats. You can select the 
measurement units you want to show in the Settings. 

 

To zoom in or out, do any of the following: 

• When the magnifying-glass icon (in the upper-right 
corner) is selected, spread or pinch your fingers 
(respectively) on the waveform. 

• Tap the Zoom + or Zoom – buttons (respectively) at 
the bottom of the touchscreen. 

• Turn the bottom-most Q-Link knob in the fourth bank. 

 

To scroll through the waveform, do either of the following: 

• When the magnifying-glass icon (in the upper-right 
corner) is selected, swipe the waveform left or right. 

• Turn the third Q-Link knob in the fourth bank. 
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The green marker and red marker are the start point and end point (respectively). These two points define the region 
of the sample that will be played. 

To move the start point or end point of the selected region, do either of the following: 

• Tap and drag its marker left or right. 

• Use the Start or End fields shown below the waveform. 

• Use the first bank Q-Link knobs to adjust the start point or the second bank of Q-Link knobs to adjust the 
end point. The top-most Q-Link knob provides coarse adjustment. The bottom-most Q-Link knob provides 
fine adjustment. 

Tip: A recorded sample may have some silence at the beginning or end, which makes it difficult to time it correctly in 
a musical context. Fix this by adjusting the start point. You can also adjust end point to remove any extra silence or 
unwanted audio at the end. In addition to making your workflow easier, having a “tight,” well-edited sample can 
enhance your production or performance. 

 

You can use Sample Edit Mode in three different ways: Trim Mode, Chop Mode, or Program Mode. The options for 
each mode are slightly different. Please refer to the following Trim Mode, Chop Mode, and Program Mode parts of 
this chapter to learn how each works. Before using these modes, though, you may want to configure your settings—
see the following Settings chapter to do this. 

 

Tip: You can use Trim Mode for a specific slice of the sample, previously created and selected in Chop Mode. This 
allows for a more detailed view of a single slice than in Chop Mode and gives you more options for auditioning the 
slice. You can easily switch between Trim Mode and Chop Mode while doing this. 

 

To use both Trim Mode and Chop Mode to edit a sample slice: 

1. Tap Trim/Chop at the bottom of the touchscreen so it says Chop. 

2. Set all fields as desired to create your sample slices. 

3. Select the desired slice. 

4. Tap Trim/Chop at the bottom of the touchscreen so it says Trim. The region you are now editing is indicated by 
the normal start point and end point markers rather than slice markers. 

5. Tap Trim/Chop at any time to return to Chop Mode. 
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Settings 
 

The Settings window lets you configure certain Sample Edit Mode 
settings. 

To view the Settings, tap the gear icon. 

 

Use the Cue Play Mode selector to set how the cue playhead will 
play audio. 

One Shot: Tapping Play Cue will play the entire sample from the 
cue playhead. 

Toggle: Tapping Play Cue once will start playback from cue 
playhead. Tapping it once more will stop playback. 

 

Use the Cue Preview selector to set if any audio plays as you move the cue playhead. As you move the cue 
playhead through the sample waveform, you can set it to play the small part of the sample before the cue playhead 
(Before), play the small part of the sample after the cue playhead (After), or not play at all (Off). You can also set this 
in your overall Preferences (see General Features > Menu > Preferences > Other). 

 

Use the Slice Preview selector to set if any audio plays as you move a slice marker. As you move the slice marker 
through the sample waveform, you can set it to play the small part of the sample before the slice marker (Before), 
play the small part of the sample after the slice marker (After), or not play at all (Off). You can also set this in your 
overall Preferences (see General Features > Menu > Preferences > Other). 

 

Use the Auto-Scroll selector to set how the screen behaves relative to the audio playhead. 

Follow: Depending on the zoom setting, the waveform will scroll along in the background, keeping the audio 
playhead centered. 

Page: The waveform display will move to the “next page” to follow the audio playhead. 

Off: The waveform display will not move at all. 

These functions also apply to the sample waveform in Grid View. 

 

Use the Timeline Units selector to set the measurement units shown above the sample waveform. You can select 
one of the following options: 

Time: hours:minutes:seconds:frames 

Samples: number of samples 

Beats: bars:beats:ticks 
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Trim Mode 

 

We recommend using Trim Mode to simply crop the end/ends from a sample. 

 

To enter Trim Mode, tap the Trim/Chop button in 
the lower-left corner so it says Trim. 

 

Use the Start and End fields to set the position of 
the start point and end point of the sample 
(respectively). Alternatively, tap and drag the start (S) 
or end (E) marker left or right, or use the first bank 
Q-Link knobs to adjust the start point or the second 
bank of Q-Link knobs to adjust the end point. 

 

Trim Mode includes a loop function. When on, the 
region of the sample between the loop point and 
end point will repeat. This is useful when trying to 
find an ideal spot to begin the sample. The loop 
cannot be earlier than the start point. 

 

To adjust the loop point, do any of the following: 

• Use the Loop field. 

• Tap and drag the start (S) marker (if Loop Lock is on) or the loop marker (if Loop Lock is off). 

• Use the first bank of Q-Link knobs (if Loop Lock is on) or the third bank Q-Link knobs (if Loop Lock is off). 
The top-most Q-Link knob provides coarse adjustment. The bottom-most Q-Link knob provides fine adjustment. 

 

To turn Loop Lock on or off, tap the Loop Lock button. When on, the loop point is the same as the start point. 
When off, the loop point is independent from the start point and indicated by a separate loop marker. 

 

To turn the loop function on or off, tap the Loop button to cycle between the three modes: 

Forward: When the loop reaches its end point, it will start playing again from the loop point. 

Reverse: When the loop reaches its end point, it will play in reverse. When it reaches the loop point again, it will 
return to the end point and continue playing in reverse. 

Alternating: When the loop reaches its end point, it will play in reverse. When it reaches the loop point again, it will 
start playing forward again from the loop point. 

To switch between Forward and off, press and hold Shift, and then tap Loop at the bottom of the touchscreen. 
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Use the MPC Live pads to play certain parts of the selected sample: 

 

Play Loop  Play to Loop 
Start  Play from 

Loop Start  Play Loop 
Continuous 

13  14 15 16

Play All  
Play Sample

 
(One Shot) 

 
Play Sample

 
(Note On) 

 No function 

09  10 11 12

Play from 
Start 

 
(Note On) 

 

Play to  
Start 

 
(Note On) 

 

Play to 
End 

 
(Note On) 

 

Play from 
End 

 
(Note On) 

05  06 07 08

Play from 
Start 

 
(One Shot) 

 

Play to  
Start 

 
(One Shot) 

 

Play to 
End 

 
(One Shot) 

 

Play from 
End 

 
(One Shot) 

01  02 03 04
 

Play Sample (One Shot) (Pad 10) plays the sample once from the start point to the end point. Press the pad once 
to play it. 

Play Sample (Note On) (Pad 11) plays the sample once from the start point to the end point. Press and hold the 
pad to play it, and release the pad to stop playing it. Alternatively, select the headphones icon in the upper-right 
corner, and then tap and hold your finger on the waveform. 

Play Loop Continuous (Pad 16) plays the sample repeatedly using the mode set by the Loop button (Forward, 
Reverse, or Alternating; if the Loop button is off, the sample will loop forward repeatedly). 

Play Loop (Pad 13) plays the sample repeatedly using the mode set by the Loop button (Forward, Reverse, or 
Alternating; if the Loop button is off, the sample will loop forward repeatedly). Press and hold the pad to play it, 
and release the pad to stop playing it. 

Play to Loop Start (Pad 14) plays the part of the sample just before the loop point. Press and hold the pad to play 
it, and release the pad to stop playing it. 

Play from Loop Start (Pad 15) plays the sample from the loop point to the end of the sample regardless of the 
end point. Press and hold the pad to play it, and release the pad to stop playing it. 

Play All (Pad 9) plays the entire sample. 

 

Pads 1–4 have the same respective functions as Pads 5–8, but Pads 1–4 play the sample part as “One Shots” 
(pressing the pad once will play the entire part) while Pads 5–8 play the sample part as “Note Ons” (pressing the pad 
and holding it will play the part; releasing it will stop playback): 

Play from Start (Pad 1, Pad 5) plays the sample from the start point to the end point. 

Play to Start (Pad 2, Pad 6) plays the part of the sample just before the start point to the start point. 

Play to End (Pad 3, Pad 7) plays the part of the sample just before the end point to the end point. 

Play from End (Pad 4, Pad 8) plays the part of the sample from the end point to the end of the sample. 
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Use the Tune field to transpose the sample up or down from its original pitch. 

 

Tap From BPM to open the Edit Tuning window, which lets 
you tune a sample to the current sequence. 

Use the Beats field to match the number of beats in the 
sequence. 

To tune the sample to the sequence, tap Match. The 
Tune field will adjust automatically and close the window. 
The sample is now tuned to the sequence. 

To tune the sample to the sequence and adjust the 
sequence tempo, tap To Sequence. This is the same as 
tapping Match but it also changes the sequence’s tempo 
to the BPM shown in the Tempo field on the right. 

To close the window, tap Close. 

 

To enter a tempo manually, use the BPM field. 

To detect the tempo automatically, tap Detect. In the Edit 
BPM window that appears, you can do any of the following: 

• Use the BPM field to enter a tempo manually. 

• Tap Detect to detect the tempo automatically. 

• Tap Tap Tempo at the bottom of the touchscreen at 
the desired rate to use it as the tempo. You can play a 
sequence in the background to help with your timing. 

• Tap Close, the X, or anywhere outside the window to 
close it. 

 

Use the Root Note field to set the root note of the sample. This defines which note will play the sample at its original 
pitch when in a keygroup program. 

 

To select a slice to edit, do either of the following (after you have created slices in Chop Mode): 

• Use the Slice field. 

• Turn the top-most Q-Link knob in the fourth bank. 

 

When Link Slices is enabled (after you have created slices in Chop Mode), changing the start point of a slice will also 
change the end point of the previous slice. Similarly, changing the end point of a slice will also change the start point 
of the next slice. Disable Link Slices if you are trying to create slices that use non-contiguous parts of the sample. 

To enable or disable this feature, tap the Link Slices button. 

Important: Link Slices must be disabled to make slices nonsequential, noncontiguous, or overlapping. 

 

0 Snap forces start points, end points, and loop points to occur only at the waveform’s “zero-crossings.” This can 
help to avoid clicks and glitches when playing a sample. 

To enable or disable 0 Snap, press and hold Shift, and then tap 0 Snap at the bottom of the touchscreen. 

 

To enable or disable the loop function, press and hold Shift, and then tap Loop at the bottom of the touchscreen. 
This switches the loop function between Forward and off. The loop function is described earlier. 
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Assigning Samples 
 

You can assign your new sample directly to a pad from Trim Mode. 

To assign a sample, tap Assign at the bottom of the touchscreen to open the Assign Sample window. 

Important: Assigning a sample to a pad in this way will replace the sample on the first layer of the pad. 

 

If you set the Assign To field to Assign slice to a pad, the pad will 
simply refer to the slice in this sample instead of creating a new 
sample. This is useful for reducing clutter in your project. 

 

Use the Pad field to select the desired pad. Alternatively, press 
the desired pad. 

 

Use the Slice Type field to select how the pad’s layer settings 
will be set when the slice is assigned to it (see Program Edit 
Mode to learn more about the parameters mentioned below): 

Non-Destructive Slice: The pad’s Slice setting will be set to 
the slice number. 

Pad Parameters: The pad’s Slice setting will be set to Pad. 
The Pad Start and Pad End will be set to the slice’s start 
point and end point values, and the Loop Position will be 
set to the slice’s start point but with Pad Loop deactivated. 

 

Use the Program field to specify the program to which you 
want to add the slice. 

 

To assign the sample, tap Do It. 

To cancel the operation, tap Close, the X, or anywhere 
outside the window. 

 

If you set the Assign To field to Make new sample, this will create a 
new sample in your project. (The original sample will remain as it is.) 

 

Use the Pad field to select the desired pad. Alternatively, press 
the desired pad. 

 

Check the Crop Sample box to delete the unused parts from the 
sample when it’s created and assigned. This feature is destructive, 
though the project will still contain your original sample. 

Leave this box unchecked to keep the unused parts of the 
sample when it is created and assigned. This way, you will still 
be able to edit the entire sample further even though you are 
using only part of it at the moment. 

 

Use the Program field to specify the program to which you 
want to add the slice. 

 

To assign the sample, tap Do It. 

To cancel the operation, tap Close, the X, or anywhere outside 
the window. 
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Processing Slices & Samples 
 

Tap the Process button to open the Process window, where you can select an editing option for the sample. 

 

Use the Function field to select an editing process. Double-tap it or tap Function at the bottom of the touchscreen 
to open the Function window, which gives an overview of all available editing processes. 

 

 
 

You can use any of these functions as described below. 

To return to Sample Edit Mode, tap Cancel. 

To return to the Process window, tap the top of the touchscreen. 

Note: All Slice processes will affect only the part of the sample between the start point and the end point. The Sample 
processes (Bit Reduce and Stereo -> Mono) will affect the entire sample regardless of its start point or end point. 
 

The Discard process deletes the regions before the start point and 
after the end point. 

 

 

 

 

 

 

 

The Delete process deletes the region between the start point and 
end point and closes the gap between them. 
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The Silence process replaces the region between the start point 
and end point with silence. 

 

 

 

 

 

 

 

 

The Extract process deletes the regions before the start point and 
after the end point and saves it as a new sample in your current 
project. 

Use the Edit Name field (and the virtual keyboard that appears) 
to name the new sample. 

Tip: This is useful if you recorded a drum loop and wanted to 
remove just a snare drum hit, a kick drum hit, etc. to use 
separately in the project. 

 

 

 

The Normalize process increases a sample’s level to the highest 
level possible without distortion. This is essentially a kind of digital 
gain optimization, so you do not have to worry about excessive 
level settings when working with samples with a wide range of 
amplitudes. 

 

 

 

 

 

 

The Reverse process reverses the region between the start point 
and end point. 
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The Fade In process sets a fade-in between the start point and 
end point. The following types are available:  

Linear fades the audio in with a linear curve—a straight line 
between the start and end. 

Log fades the audio in with a logarithmic curve—quickly rising at 
the start and flattening out towards the end. 

Exp fades the audio in with an exponential curve—slowly rising 
in the beginning and growing steeper towards the end. 

 

 

The Fade Out process sets a fade-out between the start point and 
end point. The following types are available:  

Linear fades the audio out with a linear curve—a straight line 
between the start and end. 

Log fades the audio out with a logarithmic curve—quickly rising 
at the start and flattening out towards the end. 

Exp fades the audio out with an exponential curve—slowly rising in 
the beginning and growing steeper towards the end. 

 

 

The Pitch Shift process changes the pitch of the sample without 
changing its length. This lets you set the sample’s pitch to your 
sequence without affecting the sample’s tempo or duration. You 
can adjust it up to 12 semitones, up or down. Keep in mind that 
the audio quality may decrease at more extreme settings. 

 

 

 

 

 

The Time Stretch process lengthens or shortens the sample 
without changing its pitch. This is useful for matching the durations 
of two samples with different pitches. You can enter the original 
tempo of the sample and the desired tempo after processing.  

Use the Beat field to set the desired value number of beats. 

Use the New Tempo field to set the new tempo. The Ratio field 
will then automatically show the time stretch factor. 

Alternatively, to adjust the ratio instead, use the Ratio field to 
set the desired ratio. The New Tempo field will then change 
automatically based on the new time stretch factor. 
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The Gain Change process raises or lowers the volume of the 
sample. You can adjust it up to 18 dB, higher or lower. This 
function is different than Normalize because it will allow volumes 
beyond clipping level. This may be a desired effect, but remember 
to watch your output level! 

 

 

 

 

 

 

The Copy process saves a copy of the sample.  

Use the Edit Name field (and the virtual keyboard that appears) 
to name the new sample. Otherwise, the process will add a 
consecutive number after the sample name. 

 

 

 

 

 

 

The Bit Reduce process lowers the bit resolution of a sample, 
effectively reducing its degree of faithful reproduction. You can 
reduce it down to 1 bit. (The sound is similar to the Resampler 
effect, but Bit Reduce will permanently alter the sample.) 

Tip: Use this on drum loops to get a dirty, “old-school” sizzle but with 
a digital “edge.” 

Note: This process affects the entire sample regardless of its start 
point or end point. 

 

 

 

The Stereo -> Mono process converts a stereo sample to a new 
mono sample and saves it as a new sample.  

Use the Edit Name field (and the virtual keyboard that appears) 
to name the new sample. Otherwise, the process will add a 
consecutive number after the sample name. 

The following options are available: 

• Left will convert the left channel only. 

• Right will convert the right channel only. 

• Sum will combine the left and right audio channels to a 
single mono channel. 

Note: This process affects the entire sample regardless of its start 
point or end point. 
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Chop Mode 

 

Whereas Trim Mode crops only the end/ends off of 
a sample, Chop Mode divides the sample into 
multiple regions called slices. We recommend 
using Chop Mode when working with a long 
sample with different sounds throughout (e.g., a 
drum loop or a long melodic or harmonic passage). 

 

To enter Chop Mode, tap the Trim/Chop button 
in the lower-left corner so it says Chop. 

 

Use the Start and End fields to set the position of 
the start point and end point (respectively) of the 
currently selected slice. Alternatively, tap and 
drag the start (S) or end (E) marker left or right, or 
use the first bank Q-Link knobs to adjust the 
start point or the second bank of Q-Link knobs 
to adjust the end point. 

 

Use the selector in the lower-left corner of the touchscreen to choose how you want to use Chop Mode: 

 

Manual  

This method lets you insert slices at locations you select. 

 

Threshold  

This method uses an adjustable detection algorithm that derives the number of slices created from the volume 
levels present in the sample. 

Use the Threshold field to set the threshold level. Alternatively, turn the second Q-Link knob in the third bank. 
The higher the selected value, the more slices will be created. 

Use the Min Time field to set the minimum length of a slice in milliseconds.  

 

Regions 

This method divides a sample into several slices of equal length. 

Use the Regions field to set how many regions the sample will be divided into. Alternatively, turn the second Q-
Link knob in the third bank. The higher the selected value, the more slices will be created. 

 

BPM 

This method divides a sample into several slices based on the tempo (beats per minute). 

Use the Bars field to set how many bars are in the sample. Alternatively, turn the second Q-Link knob in the third bank. 

Use the Beats field to set how many beats are in each bar. Alternatively, turn the third Q-Link knob in the third bank. 

Use the Time Div field to set a note division. Alternatively, turn the bottom-most Q-Link knob in the third bank. 
The slice markers will be placed according to this setting. You can select 1/4, 1/8, 1/16, or 1/32. (In most cases, 
you should set this parameter to 1/16.) 
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To play a slice, do either of the following: 
• Press the pad that corresponds to the slice. If your sample has more than 16 slices, use the additional pad banks. 
• When the headphones icon (in the upper-right corner) is selected, tap a slice in the waveform. 

 

When the One Shot feature is enabled, you can press a pad once to play the entire slice. When this is disabled, 
pressing the pad and holding it will play the slice; releasing it will stop playback. 

To enable or disable One Shot, press and hold Shift, and then tap One Shot. 

 

To select a slice to edit, do either of the following: 
• Use the Slice field. 
• Turn the top-most Q-Link knob in the fourth bank. 
• When the headphones icon (in the upper-right corner) is selected, tap a slice in the waveform. 

 

To add a slice at the current playhead position, tap Slice+ at the bottom of the touchscreen. You can do this at 
any point during sample playback.  

To insert a slice marker during sample playback, press an unlit pad (usually Pad 1) to start playback of the 
sample, and then press an unlit pad during playback to place a slice marker at each location of the playhead. (If you 
press a lit pad, playback will restart from that pad’s corresponding slice marker.) The number of the pad that is lit 
green is the number of the most-recently inserted slice marker. The numbers of the pads that are lit yellow are the 
numbers of the slice markers that are already inserted. 

 

To split or combine slices, tap the glue-and-scissors icon. In the 
Split/Combine Region screen that appears, tap one of the following buttons: 

Split: This splits the currently selected region into two equal slices. 
Combine: This combines the currently selected region with the one 
before it. 
Back: This closes the window. 

 

When Link Slices is enabled, changing the start point of a slice will also 
change the end point of the previous slice. Similarly, changing the end 
point of a slice will also change the start point of the next slice. Disable 
Link Slices if you are trying to create slices that use non-contiguous 
parts of the sample. 

To enable or disable this feature, tap the Link Slices button. 
Important: Link Slices must be disabled to make slices nonsequential, 
noncontiguous, or overlapping. 

 

To remove all slices from a sample, press and hold Shift and tap Clear All. 

 

The cue playhead is useful when manually inserting slice markers. You can set its position and behavior to suit your 
workflow.  

Use the Cue field to adjust the position of the cue playhead. Alternatively, tap and drag the translucent marker with 
the triangle (). 

To play the sample from the cue playhead, tap Play Cue at the bottom of the touchscreen. 

To create a slice marker at the cue playhead position, tap Slice+ at the bottom of the touchscreen. 

To set how the cue playhead behaves, use the Settings window (described earlier). 

 

0 Snap forces start points and end points to occur only at the waveform’s “zero-crossings.” This can help to avoid 
clicks and glitches when playing a sample. 

To enable or disable 0 Snap, press and hold Shift, and then tap 0 Snap at the bottom of the touchscreen. 
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Converting or Assigning Slices 

 

You can assign your new sample directly to a pad from Chop Mode. 
You can also convert it into a new program or patched phrase. 

To convert or assign a sample, press and hold Shift, and then 
tap Convert at the bottom of the touchscreen to open the Convert 
or Assign Slices window. 

 

If you set the Convert To field to New [program type] program 
using slices, this will create a new program and assign the sample’s 
slices to its pads. The pads will simply refer to the slices in this 
sample instead of creating new samples. This is useful for reducing 
clutter in your project. The new program will be named after the 
sample and appended with ch. 

 

Use the Slice Type field to select how each pad’s layer settings 
will be set when the slices are assigned to them (see Program 
Edit Mode to learn more about the parameters mentioned below): 

• Non-Destructive Slice: Each pad’s Slice setting will be 
set to the slice number. 

• Pad Parameters: Each pad’s Slice setting will be set to 
Pad. The Pad Start and Pad End parameters will be set to 
the slice’s start point and end point values, and the Loop 
Pos parameter will be set to the slice’s start point but with 
Pad Loop deactivated. 

 

Check the Create Events box to automatically create a new 
track for the new program in which each pad plays its 
corresponding slice in ascending sequence by pad number.  

 
If Create Events is checked, use the Bars field to set how many 
bars the slices’ events will occupy. 

 

To convert the sample, tap Do It. 
To cancel the operation, tap Close. 

 

If you set the Convert To field to New clip program, this will 
create a new clip program and assign the sample’s slices to its 
pads as clips. The pads will simply refer to the slices in this sample 
instead of creating new samples. This is useful for reducing clutter 
in your project. The new program will be named after the sample 
and appended with ch. 

 

Use the Tempo field to enter the tempo of the clips in the new 
program. 

 

Check the Create Events box to automatically create a new 
track for the new program in which each pad plays its 
corresponding slice in ascending sequence by pad number.  

 
If Create Events is checked, use the Bars field to set how many 
bars the slices’ events will occupy. 

 

To convert the sample, tap Do It. 
To cancel the operation, tap Close. 



 

 
116 

 

 

If you set the Convert To field to New program with new 
samples, this will create a new sample from each slice and assign 
them to pads in a new program. 

The new program will be named after the sample and appended 
with ch. The new samples will be appended with SI-# (where # is a 
consecutive number). 

 

Check the Crop Samples box to delete the unused parts from the 
sample when they are created and assigned. This feature is 
destructive, though the project will still contain your original sample. 

Leave this box unchecked to keep the unused parts of the 
samples when they’re created and assigned. This way, you will 
still be able to edit the entire samples further even though you 
are using only part of them at the moment. 

 

By default, this option already will create a new program. You 
can uncheck the Create New Program box to convert each 
slice into a sample that is placed in the project’s sample pool 
but not assigned to a program or pad. 

 

If Create New Program is checked, check the Create Events 
box to automatically create a new track in which each pad plays 
its corresponding slice in ascending sequence by pad number.  

 

If Create Events is checked, use the Bars field to set how many 
bars the slices’ events will occupy. 

 

To convert the sample, tap Do It. 

To cancel the operation, tap Close. 

 

If you set the Convert To field to Assign slice to a pad, the pad 
will simply refer to the slice in this sample instead of creating a new 
sample. This is useful for reducing clutter in your project. 

Important: Assigning a sample to a pad in this way will replace the 
sample on the first layer of the pad. 

 

Use the Pad field to select the desired pad. Alternatively, press 
the desired pad. 

 

Use the Slice Type field to select how the pad’s layer settings 
will be set when the slice is assigned to it (see Program Edit 
Mode to learn more about the parameters mentioned below): 

• Non-Destructive Slice: The pad’s Slice setting will be set 
to the slice number. 

• Pad Parameters: The pad’s Slice setting will be set to Pad. 
The Pad Start and Pad End will be set to the slice’s start 
point and end point values, and the Loop Position will be 
set to the slice’s start point but with Pad Loop deactivated. 

 

Use the Program field to specify the program to which you want 
to add the slice. 

 

To convert the sample, tap Do It. 

To cancel the operation, tap Close. 
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If you set the Convert To field to Make new sample, this will 
create a new sample in your project. (The original sample will 
remain as it is.) 

Important: Assigning a sample to a pad in this way will replace the 
sample on the first layer of the pad. 

 

Use the Pad field to select the desired pad. Alternatively, press 
the desired pad. 

 

Check the Crop Sample box to delete the unused parts from the 
sample when it’s created and assigned. This feature is destructive, 
though the project will still contain your original sample. 

Leave this box unchecked to keep the unused parts of the sample 
when it is created and assigned. This way, you will still be able to 
edit the entire sample further even though you are using only part 
of it at the moment. 

 

Use the Program field to specify the program to which you want 
to add the slice. 

 

To convert the sample, tap Do It. 

To cancel the operation, tap Close. 

 

 

If you set the Convert To field to Patched phrase, this will create 
a new sample that will play based on the tempo of your Sequence, 
and places it in the current project. The patched phrase will have 
the same name as the original sample but appended with pp and 
will use a different icon when viewing your project information.  

 

Use the Bars field to set how many bars long the patched 
phrase is meant to be. 
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Processing Slices 

 

Press and hold Shift, and then tap the Process button to open the Process window, where you can select an editing 
option for the currently selected slice. (This has fewer options than Trim Mode. Unavailable ones are darkened.) 

Use the Function field to select an editing process. Double-tap it or tap Function at the bottom of the touchscreen 
to open the Function window, which gives an overview of all available editing processes. 

Important: Chop Mode is non-destructive: You can choose the slice/edit behavior without destroying your original 
sample, giving you more control over sample playback; you can save your sliced sample and but also reuse all of the 
slice data in another project. See the Program Edit Mode chapter to learn more about setting a pad to play the entire 
sample, a specific slice of a sample, or a specific region of the sample (independent of its slice markers). 

 

 

 

You can use any of these functions as described below. 

To return to Sample Edit Mode, tap Cancel. 

To return to the Process window, tap the top of the touchscreen. 

Note: All processes here will affect only the currently selected slice. 
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The Silence process replaces the region between the start point 
and end point with silence. 

 

 

 

 

 

 

 

 

The Extract process deletes the regions before the start point and 
after the end point and saves it as a new sample (with a name you 
enter) in your current project. 

Tip: This is useful if you recorded a drum loop and wanted to 
remove just a snare drum hit, a kick drum hit, etc. to use separately 
in the project. 

 

 

 

 

 

The Normalize process increases a sample’s level to the highest 
level possible without distortion. This is essentially a kind of digital 
gain optimization, so you do not have to worry about excessive 
level settings when working with samples with a wide range of 
amplitudes.  

 

 

 

 

 

 

The Reverse process reverses the region between the start point 
and end point. 
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The Fade In process sets a fade-in between the start point and 
end point. The following types are available: 

Linear fades the audio in with a linear curve—a straight line 
between the start and end. 

Log fades the audio in with a logarithmic curve—quickly rising at 
the start and flattening out towards the end. 

Exp fades the audio in with an exponential curve—slowly rising 
in the beginning and growing steeper towards the end. 

 

 

 

The Fade Out process sets a fade-out between the start point and 
end point. The following types are available: 

Linear fades the audio out with a linear curve—a straight line 
between the start and end. 

Log fades the audio out with a logarithmic curve—quickly rising 
at the start and flattening out towards the end. 

Exp fades the audio out with an exponential curve—slowly rising 
in the beginning and growing steeper towards the end. 

 

 

 

The Pitch Shift process changes the pitch of the sample without 
changing its length. This lets you set the sample’s pitch to your 
sequence without affecting the sample’s tempo or duration. You 
can adjust it up to 12 semitones, up or down. Keep in mind that 
the audio quality may decrease at more extreme settings. 

 

 

 

 

 

 

The Gain Change process raises or lowers the volume of the 
sample. You can adjust it up to 18 dB, higher or lower. This 
function is different than Normalize because it will allow volumes 
beyond clipping level. This may be a desired effect, but remember 
to watch your output level! 
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Program Mode 

 

Program Mode lets you edit a sample in the context 
of the program in which you’ll use it. You can adjust 
the pad parameters as though you were in Program 
Edit Mode, auditioning and hearing how it will sound 
in the program’s audio path. 

 

To enter Program Mode, tap the Program button at 
the bottom of the touchscreen. The pads will show 
their assigned samples in the current Program. 

  

Use the Start and End fields to set the position of 
the start point and end point of the sample 
(respectively). Alternatively, tap and drag the start (S) 
or end (E) marker left or right, or use the first bank 
Q-Link knobs to adjust the start point or the second 
bank of Q-Link knobs to adjust the end point. 

 

Program Mode includes a loop function. When on, the region of the sample between the loop point and end point will 
repeat. This is useful when trying to find an ideal spot to begin the sample. The loop cannot be earlier than the start point. 

 

To adjust the loop point, do any of the following: 

• Use the Loop field. 

• Tap and drag the start (S) marker (if Loop Lock is on) or the loop marker (if Loop Lock is off). 

• Use the first bank of Q-Link knobs (if Loop Lock is on) or the third bank Q-Link knobs (if Loop Lock is off). 
The top-most Q-Link knob provides coarse adjustment. The bottom-most Q-Link knob provides fine adjustment. 

 

To turn Loop Lock on or off, tap the Loop Lock button. When on, the loop point is the same as the start point. 
When off, the loop point is independent from the start point. 

 

To turn the loop function on or off, tap the Loop button to cycle between the three modes: 

Forward: When the loop reaches its end point, it will start playing again from the loop point.  

Reverse: When the loop reaches its end point, it will play in reverse. When it reaches the loop point again, it will 
return to the end point and continue playing in reverse. 

Alternating: When the loop reaches its end point, it will play in reverse. When it reaches the loop point again, it will 
start playing forward again from the loop point. 

To switch between Forward and off, press and hold Shift, and then tap Loop at the bottom of the touchscreen. 

 

Tap each pad to hear its sample/samples. The sample on its first layer will automatically appear in the waveform 
display for editing. 

 

Use the Tune field to transpose the sample up or down from its original pitch. 
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Tap From BPM to open the Edit Tuning window, which lets 
you tune a sample to the current sequence. 

Use the Number of Beats field to match the number of beats 
in the sequence. 

To tune the sample to the sequence, tap Match. The 
Tune field will adjust automatically and close the window. 
The sample is now tuned to the sequence. 

To tune the sample to the sequence and adjust the 
sequence tempo, tap To Seq. This is the same as tapping 
Match but it also changes the sequence’s tempo to the 
BPM shown in the Tempo field on the right. 

To close the window, tap Close. 

 

Use the Root Note field to set the root note of the sample. This defines which note will play the sample at its original 
pitch when in a keygroup program. 

 

Use the Slice field to display either the sample as it has been edited (Pad) or the entire sample (All). 

If the Slice field is set to All, you can display the sample as it has been edited but keep the start point and end point. 
To do this, press and hold Shift, and then tap To Pad at the bottom of the touchscreen. The Slice field will change 
to Pad, but the start point and end point will remain in their current locations. 

 

The Link Slices button does not have a function in Program Mode. 

 

0 Snap forces start points, end points, and loop points to occur only at the waveform’s “zero-crossings.” This can 
help to avoid clicks and glitches when playing a sample. 

To enable or disable 0 Snap, press and hold Shift, and then tap 0 Snap at the bottom of the touchscreen. 

 

To enable or disable the loop function, press and hold Shift, and then tap Loop at the bottom of the touchscreen. 
This switches the loop function between Forward and off. The loop function is described earlier. 

 



 

 
123 

 

 

Assigning Samples 

 

You can assign your new sample directly to a pad from Program Mode. 

To assign a sample, tap Assign at the bottom of the touchscreen to open the Assign Sample window. 

Important: Assigning a sample to a pad in this way will replace the sample on the first layer of the pad. 

 

If you set the Assign To field to Assign slice to a pad, the pad will 
simply refer to the slice in this sample instead of creating a new 
sample. This is useful for reducing clutter in your project. 

 

Use the Pad field to select the desired pad. Alternatively, press 
the desired pad. 

 

Use the Slice Type field to select how the pad’s layer settings 
will be set when the slice is assigned to it (see Program Edit 
Mode to learn more about the parameters mentioned below): 

• Non-Destructive Slice: The pad’s Slice setting will be set to 
the slice number. 

• Pad Parameters: The pad’s Slice setting will be set to Pad. 
The Pad Start and Pad End will be set to the slice’s start 
point and end point values, and the Loop Position will be 
set to the slice’s start point but with Pad Loop deactivated. 

 

Use the Program field to specify the program to which you want 
to add the slice. 

 

To assign the sample, tap Do It. 

To cancel the operation, tap Close. 

 

If you set the Assign To field to Make new sample, this will create a 
new sample in your project. (The original sample will remain as it is.) 

 

Use the Pad field to select the desired pad. Alternatively, press 
the desired pad. 

 

Check the Crop Sample box to delete the unused parts from the 
sample when it’s created and assigned. This feature is destructive, 
though the project will still contain your original sample. 

Leave this box unchecked to keep the unused parts of the 
sample when it is created and assigned. This way, you will still 
be able to edit the entire sample further even though you are 
using only part of it at the moment. 

 

Use the Program field to specify the program to which you want 
to add the slice. 

 

To assign the sample, tap Do It. 

To cancel the operation, tap Close. 
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Processing Slices 

 

Press and hold Shift, and then tap the Process button to open the Process window, where you can select an editing 
option for the currently selected slice. (This has fewer options than Trim Mode. Unavailable ones are darkened.) 

Use the Function field to select an editing process. Double-tap it or tap Function at the bottom of the touchscreen 
to open the Function window, which gives an overview of all available editing processes. 

Important: Program Mode is non-destructive: You can choose the slice/edit behavior without destroying your original 
sample, giving you more control over sample playback; you can save your sliced sample and but also reuse all of the 
slice data in another project. See the Program Edit Mode chapter to learn more about setting a pad to play the entire 
sample, a specific slice of a sample, or a specific region of the sample (independent of its slice markers). 

 

 

 

You can use any of these functions as described below. 

To return to Sample Edit Mode, tap Cancel. 

To return to the Process window, tap the top of the touchscreen. 

Note: All processes here will affect only the currently selected slice. 
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The Silence process replaces the region between the start point 
and end point with silence. 

 

 

 

 

 

 

 

 

The Extract process deletes the regions before the start point and 
after the end point and saves it as a new sample (with a name you 
enter) in your current project. 

Tip: This is useful if you recorded a drum loop and wanted to 
remove just a snare drum hit, a kick drum hit, etc. to use separately 
in the project. 

 

 

 

 

 

The Normalize process increases a sample’s level to the highest 
level possible without distortion. This is essentially a kind of digital 
gain optimization, so you do not have to worry about excessive 
level settings when working with samples with a wide range of 
amplitudes.  

 

 

 

 

 

 

The Reverse process reverses the region between the start point 
and end point. 
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The Fade In process sets a fade-in between the start point and 
end point. The following types are available:  

Linear fades the audio in with a linear curve—a straight line 
between the start and end. 

Log fades the audio in with a logarithmic curve—quickly rising at 
the start and flattening out towards the end. 

Exp fades the audio in with an exponential curve—slowly rising 
in the beginning and growing steeper towards the end. 

 

 

 

The Fade Out process sets a fade-out between the start point and 
end point. The following types are available:  

Linear fades the audio out with a linear curve—a straight line 
between the start and end. 

Log fades the audio out with a logarithmic curve—quickly rising 
at the start and flattening out towards the end. 

Exp fades the audio out with an exponential curve—slowly rising 
in the beginning and growing steeper towards the end. 

 

 

 

The Pitch Shift process changes the pitch of the sample without 
changing its length. This lets you set the sample’s pitch to your 
sequence without affecting the sample’s tempo or duration. You 
can adjust it up to 12 semitones, up or down. Keep in mind that 
the audio quality may decrease at more extreme settings. 

 

 

 

 

 

The Gain Change process raises or lowers the volume of the 
sample. You can adjust it up to 18 dB, higher or lower. This 
function is different than Normalize because it will allow volumes 
beyond clipping level. This may be a desired effect, but remember 
to watch your output level! 
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Sampler 
 

The Sampler lets you record audio samples to use in your projects. 

Important: To record any audio, you need to connect an audio source to your MPC Live or to 
your computer’s audio interface. 

 

To open the Sampler, press Menu and then tap Sampler. 

 

To set up the Sampler before recording: 

1. Make sure to reduce the volume levels of your audio 
source and speakers, headphones, and/or monitors 
before you make any connections to avoid “pops” or 
feedback. 

2. Connect a synthesizer or other line-level audio source 
to the input/inputs of your MPC Live. 

3. Turn the Rec Vol knob to set the input level while 
playing your audio source. You should now see the 
level in the meter. Make sure it does not exceed the 
maximum level (the meter should not be “peaking” 
constantly). 

4. Set the recording controls as desired (described in this 
chapter). 

5. Tap the Arm button to record-arm the Sampler. 

 

You can use the Sampler to record using four different methods: Sample, Slice, Pad Tap, or Pad Hold, all described 
later in this chapter. The following controls are present regardless of which method you use. 

 

The time counter in the upper-right corner the current playhead position. This is shown in most of the modes. See 
General Features > Time Counter to learn about this. 

 

The upper-left Input Source field defines whether you are going to record an external 
audio signal (Input 1,2, Input 3,4, or one of Input 1–4) or an internal signal from within 
MPC Live (Resample L, Resample R, or Resample L+R). 

Resampling does not require an audio connection because the source is within MPC 
Live and is therefore recorded without any loss in audio quality. You can, for example, 
use Resample to record two or more samples by pressing the corresponding pads 
simultaneously. 

 

Use the second upper-left Mono/Stereo field to choose whether your recorded 
samples will be monaural (Mono) or binaural (Stereo). 

 

The Inserts field shows any enabled or disabled effects for the Sampler. Tap the area under 
Inserts to open a window where you can load, change, and enable or disable the effects. 

Important: These effects are applied to the audio as you record it. This means that the 
effects cannot be “removed” from the sound later. Learn more about how effects work 
in General Features > Effects. 
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Tap the Monitor button to enable or disable input monitoring. When on, the audio you 
hear in your headphones will be taken before it reaches the Sampler, ensuring zero 
latency. When off, the audio you hear in your headphones will be taken after it is 
processed in the Sampler, so there may be some latency, but you will hear the audio 
source as it sounds in the recording. 

Tip: To avoid possible clicks or feedback while input monitoring, reduce the level of 
the audio sources. 

 

Use the threshold slider to adjust the threshold. Alternatively, turn the bottom-most Q-
Link knob. 

When the Sampler is record-armed, it automatically starts recording when the level of 
the incoming source exceeds this setting. If you set it too high, the recording may not 
start when you play the input source, or the start of the material you wanted to record 
may be missing. If you set it too low, the recording may start too early, before you play 
the external source. Set this parameter to an appropriate level using the level meter. 

To reset the “peak hold,” which shows the highest level of your input signal in the level 
meter, tap it. 

 

For reference, the Sample Length counter shows you the length of your sample during 
the recording procedure. 

 

Tap Arm to record-arm the Sampler. The button will then change to Record and show 
Waiting for signal. 

At that point, start recording by doing either of the following: 

• Start performing so that the incoming audio level exceeds the level of the 
threshold slider. 

• Tap Record under the Sample Length counter. 

To disarm the track instead, tap Cancel. 

 

Use the Max Length field to define the maximum sampling time. Alternatively, turn the 
top-most and second Q-Link knobs. 

You can record up to 20 minutes and 59 seconds (20:59) per sample. We recommend 
setting these to values that roughly match your estimated recording duration. 
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Sample 

 

Using this method, you can insert slice markers directly in your 
sample as you record it.  

Slice markers divide the sample into multiple regions called slices, 
which you can adjust in the Chop Mode of Sample Edit Mode (see 
Sample Edit Mode > Chop Mode for more information). This is useful 
when working with a long sample with different sounds throughout 
(e.g., a drum loop or a long melodic or harmonic passage). 

 

To start recording, do one of the following: 

• Start performing so that the incoming audio level exceeds 
the level of the threshold slider. 

• Tap Record under the Sample Length counter. 

 

To insert a slice marker in a sample while recording, press 
Slice+ (in the lower-right corner) as the sample records. Each time 
you press it, a slice marker will be placed at that location. 

 

To stop recording, tap Stop under the Sample Length counter. 

 

After you stop your recording, the Keep or Discard Sample window 
will appear. 

 

Use the Edit Name field to name the new sample. Tap it and use 
the virtual keyboard that appears. 

 

Use the Program field to assign the new sample to a program. 
Select <none> if you want to save it to the project without assigning 
it to a program. 

 

Use the Assign to Pad field to assign the sample to a pad in the 
program.  

 

Use the Root Note field to set where the sample’s original pitch will be on the keyboard. 

 

If you recorded a sample while a sequence was playing, the Keep or Discard Sample window will show a few more 
options after you select a pad. 

Check the Add Event box to automatically add the sample to the currently playing sequence. 

Use the @ field to select where you want the event to start: 

• Start: The sample will be a note event at the start of the currently playing sequence. 

• Trigger: The sample will be a note event where you began recording it in the currently playing sequence.  

Use the Track field to set which track will contain the new event. 

 

To confirm your selections, tap Keep at the bottom of the touchscreen.  

To discard the recording and return to the Sampler, tap Discard at the bottom of the touchscreen. 

To play the recording, tap Play at the bottom of the touchscreen. 

Tip: We recommend editing your recorded sample in Sample Edit Mode (see Sample Edit Mode for more information). 
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Slice 
 

Using this method, the pads correspond to slices of the currently recorded sample. Slice markers divide the sample 
into multiple regions called slices, which you can adjust in the Chop Mode of Sample Edit Mode (see Sample Edit 
Mode > Chop Mode for more information). This is useful when working with a long sample with different sounds 
throughout (e.g., a drum loop or a long melodic or harmonic passage). 

 

To start recording, do one of the following: 

• Start performing so that the incoming audio level exceeds the level of the threshold slider. 

• Tap Record under the Sample Length counter. 

 

To insert a slice marker in a sample while recording, press any pad as the sample records. Each time you press 
it, a slice marker will be placed at that location. 

The number of the pad that flashes red is the number of the slice marker that will be inserted next. The numbers of 
the pads that are lit yellow are the numbers of the slice markers that are already inserted. 

When you are done recording, you can name the sample and create a new program using the slices.  

 

To stop recording, tap the round Stop button.  

 

After you stop your recording, the Keep or Discard Sample window 
will appear. 

 

Use the Edit Name field to name the new sample. Tap it and use 
the virtual keyboard that appears. Otherwise, the process will add a 
consecutive number after the sample name. 

 

Use the Create New Program field to assign the new sample to a 
new program: 

Off: No program will be created. The slices will still be added to 
your project’s sample pool. 

With Non-Destructive Slices: In the new program, each pad’s 
Slice setting will be set to the corresponding slice number. This is 
identical to how you can assign samples in Sample Edit Mode (as 
described in Sample Edit Mode > Chop Mode > Converting or 
Assigning Slices). 

With Pad Parameters: In the new program, each pad’s Slice 
setting will be set to Pad. The Pad Start and Pad End will be set 
to the slice’s start point and end point values, and the Loop 
Position will be set to the slice’s start point but with Pad Loop 
deactivated. This is identical to how you can assign samples in 
Sample Edit Mode (as described in Sample Edit Mode > Chop 
Mode > Converting or Assigning Slices). 

 

To confirm your selections, tap Create or Keep at the bottom of the touchscreen.  

To discard the recording and return to the Sampler, tap Discard at the bottom of the touchscreen. 

To play the recording, tap Play at the bottom of the touchscreen. 

Tip: We recommend editing your recorded sample in Sample Edit Mode (see Sample Edit Mode for more information). 
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Pad Tap 
 

Important: This mode works for drum programs only; you must select a drum program before using this mode. 
Otherwise, this feature will not do anything, even though it may appear to work. 

With this method, pressing a pad immediately starts or continues recording directly to that pad (make sure you are 
using the desired program before you start recording). Pads with assigned samples are lit bright yellow. Pads without 
samples are lit dim yellow. 

 

To start recording to a pad, press it. Recording will start immediately, and the pad will flash red. If you press a new 
pad, the recording will stop on the previous pad, which will turn green, and start on the new pad, which will flash red. 

Note: If you start recording by tapping Record under the Sample Length counter—or if the volume exceeds the 
level of the threshold slider—the sample will record to your project’s sample pool, not to a pad. 

 

To stop recording to a pad, press the currently recording pad, which is flashing red. The sample will continue 
recording. You can start recording on another pad at any time. 

To stop all recording, tap Stop under the Sample Length counter. 

 

When you are done recording, each pad that you have pressed during recording: 

• will have its Slice setting set to Pad; 

• will have its Pad Start and Pad End set to the slice’s start point and end point values; and 

• will have its Loop Position set to the slice’s start point but with Pad Loop deactivated. 

This is identical to how you can assign samples in Sample Edit Mode (as described in Sample Edit Mode > Chop 
Mode > Converting or Assigning Slices). 

Tip: We recommend editing your recorded sample in Sample Edit Mode (see Sample Edit Mode for more information). 

 

 

Pad Hold 
 

Important: This mode works for drum programs only; you must select a drum program before using this mode. 
Otherwise, this feature will not do anything, even though it may appear to work. 

With this method, pressing and holding a pad immediately starts or continues recording directly to that pad (make sure 
you are using the desired program before you start recording). Pads with assigned samples are lit bright yellow. Pads 
without samples are lit dim yellow. 

 

To start recording to a pad, press and hold it. Recording will start immediately, and the pad will light red. 

Note: If you start recording by tapping Record under the Sample Length counter—or if the volume exceeds the 
level of the threshold slider—the sample will record to your project’s sample pool, not to a pad. 

 

To stop recording, release the pad. The pad will light green, and the sample will continue recording. You can start 
recording on another pad at any time. 

To stop all recording, tap Stop under the Sample Length counter. 

 

When you are done recording, each pad that you have pressed during recording: 

• will have its Slice setting set to Pad; 

• will have its Pad Start and Pad End set to the slice’s start point and end point values; and 

• will have its Loop Position set to the slice’s start point but with Pad Loop deactivated. 

This is identical to how you can assign samples in Sample Edit Mode (as described in Sample Edit Mode > Chop 
Mode > Converting or Assigning Slices). 

Tip: We recommend editing your recorded sample in Sample Edit Mode (see Sample Edit Mode for more information). 
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Pad Mute Mode 
 

Pad Mute Mode lets you easily mute pads within a program or set mute groups for each pad 
within a program. 

 

To enter Pad Mute Mode, press Menu, and then tap Pad Mute. 

 

 

 

There are two tabs you can view in this mode: Pad Mute or Pad Group. Tap each button in the lower-left corner to 
select it. See the following Pad Mute and Pad Group sections to learn about each. 

 

Use the Program field at the top of the touchscreen to select a program. 

 

The time counter in the upper-right corner the current playhead position. This is shown in most of the modes. See 
General Features > Time Counter to learn about this. 

 

The automation button indicates the global automation state. This is shown in several modes. See General Features 
> Automation to learn about this. 

 

Time Correct lets you quantize pad mutes. This is useful when you want your mutes to line up with a specific time 
division. For example, with Time Division set to 1 Bar, your mutes will always align with the beginning of the measure 
immediately after you press the pad. 

Tap Time Division at the bottom of the touchscreen, and select a value from 1/16 to 2 Bars (T indicates a triplet-
based time division).  

Tap TC at the bottom of the touchscreen to enable or disable the Time Correct feature. 
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Pad Mute 
 

You can mute or unmute individual sounds (on a single track) 
in real time by pressing the pads. This is useful if you want to 
hear a track without a particular sound or if you want to 
isolate specific sounds or combinations of sounds.  

Tip: This function is similar to muting pads one at a time in the 
grid—but more convenient. 

 

To mute pads in this mode: 

1. If the Pad Mute tab in the lower-left corner is not already 
selected, tap it. 

2. Select the desired pad bank. Use the Pad Bank Buttons or 
tap a pad bank shown on the left side of the touchscreen. 

3. To mute or unmute a pad’s sound, press it or tap it in the 
touchscreen. Muted pads are lit red. Unmuted pads are lit 
yellow. Unused pads do not show any sample names. 

 

To assign pads to pad groups within this tab: 

1. Use the Q-Link button to select a row of four pads, 
outlined in the touchscreen. 

2. Turn each of the Q-Link knobs to assign each of the four 
outlined pads to a pad group. The number of each pad’s 
group is shown in its upper-right corner. 

 

 

Pad Group 
 

The pad group feature extends the concept of pad mutes: you 
can mute or unmute multiple pads (on a single track) by 
pressing one pad that you have assigned to a mute group. This 
is useful if you want to hear a track without a particular group of 
sounds or if you want to isolate specific sounds in various 
combinations. You can create up to 16 different pad groups. 

 

To use pad groups: 

1. If the Pad Group tab in the lower-left corner is not already 
selected, tap it. 

2. Use the Pad Bank buttons to select the desired pad bank. 

3. To select a pad to add to a mute group, press it or tap it 
on the touchscreen. The selected pad is lit green. If there are 
other pads in the same mute group, they will flash yellow. 

4. To add the pad to the mute group, tap the number of the 
desired mute group on the left side of the touchscreen. To 
remove it from the mute group, tap Off. 

 

Alternatively, do the following: 

1. Use the Q-Link button to select a row of four pads, 
outlined in the touchscreen. 

2. Turn each of the Q-Link knobs to assign each of the four 
outlined pads to a pad group. The number of each pad’s 
group is shown in its upper-right corner. 



 

 
134 

 

 
Pad Mixer 
 

In the Pad Mixer, you can set a program’s levels, stereo panning, routing, and effects. 

 

This mode appears differently for each type of program: 

For drum programs, this mode shows a pad with controls for each individual pad (of 128). 

For keygroup programs, this mode shows a pad with controls for each individual keygroup (up to 128). 

For clip programs, this mode shows a pad with controls for each individual clip (up to 16). Even though you can 
view other pad banks, only Pad Bank A is relevant for clip programs. 

For MIDI programs, plugin programs, and CV programs, this mode is unavailable. 

For more information on how these programs differ, please see General Features > Programs. 

 

To enter the Pad Mixer, press Menu, and then tap Pad Mixer. 

 

 
 

The Pad Mixer works like an audio mixer with various settings for each pad, shown in a 4x4 array. All of their 
functionality is identical. If a sample has been assigned to a pad, its name is displayed at the top of it. 

 

To select a pad, press its corresponding pad or tap it on the touchscreen. Alternatively, use the Pad field in the 
upper-left corner. 

 

To view more channels, use the Pad Bank buttons. 

 

Use the Program field in the upper-left corner to select the program whose pads you want to view. Remember that 
only drum programs or keygroup programs will display properly in the Pad Mixer. 

 

Use the Track field at the top of the touchscreen to select the desired track. 

 

The time counter in the upper-right corner the current playhead position. This is shown in most of the modes. See 
General Features > Time Counter to learn about this. 

 

The automation button indicates the global automation state. This is shown in several modes. See General 
Features > Automation to learn about this.  

 

To view a specific setting on all channels, tap the Level, Pan, Mute, Send, Insert, or Route button at the bottom of 
the touchscreen. You can tap the Send or Insert buttons multiple times to cycle through the four available slots for each. 
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When a pad is selected, you can view and adjust all of its settings in the left side of the 
touchscreen rather than using the tab buttons at the bottom. 

When viewing the channel strip: 

• The first field shows the current pad number. Press a pad or double-tap the field to 
select a different pad. 

• The second field shows where the pad is routed (which you can change). Usually, this 
is set to Program. Double-tap the field to select a different destination (Out 1,2–7,8 
in Standalone Mode, Out 1,2–31,32 in Controller Mode; MPC Live does not use Out 
7,8 but displays them to maintain compatibility with MPC X, which does use them). 

• The Inserts field shows any enabled or disabled effects for that pad. Tap the area 
under Inserts to open a window where you can load, change, and enable or 
disable the effects. 

• To solo or mute the pad, tap Solo or Mute (respectively). 

• To change the panning or level of the pad, adjust the pan knob or level slider. 

 

 

Levels 
 

When the Level tab is selected, use the data dial or –/+ 
buttons to adjust the level of the currently selected pad. 

The level sliders and meters in each pad show a visual 
representation of the level. Double-tap a pad in the touchscreen 
to open a large version of the level slider and meter. 

 

 

 

 

 

Panning 
 

When the Pan tab is selected, use the data dial or –/+ 
buttons to adjust the panning of the currently selected pad. 

The pan sliders in each pad show a visual representation of 
the level. Double-tap a pad in the touchscreen to open a large 
version of the pan knob. 

 

 

 

 

 

Mute 
 

When the Mute tab is selected, mute the currently selected 
pad by doing any of the following: 

• Turn the data dial. 

• Use the –/+ buttons. 

• Tap the pad in the touchscreen. 

When a pad is muted, its M button will light red. 
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Send Effects 

 
When the Send tab is selected, use the data dial or –/+ 
buttons to adjust the send level of the currently selected pad. 

The level sliders in each pad show a visual representation of 
the level. Double-tap a pad in the touchscreen to open a large 
version of the level slider. 

You can select up to four send effects for each pad. You can 
use various effects included in your MPC Live as well as other 
VST and AU plugins installed on your computer. Tap the Send 
button to cycle through the four available slots for each. 

To learn how to use send effects, please see General Features 
> Effects > Send/Return Effects. 

Important: To use a send effect, you have to load an effect 
into the corresponding send effect slot in the Channel Mixer. 

 

 

Insert Effects 
 

When the Insert tab is selected, use the data dial or –/+ buttons 
to adjust the insert effect level of the currently selected pad. 

The level sliders in each pad show a visual representation of the 
level. Double-tap a pad in the touchscreen to open a window 
where you can load, change, and enable or disable the effects. 

You can select up to four insert effects for each pad. You can 
use various effects included in your MPC Live as well as other 
VST and AU plugins installed on your computer. Tap the Insert 
button to cycle through the four available slots for each. 

To learn how to use insert effects, please see General Features 
> Effects > Insert Effects. 

Important: 

When using keygroup insert effects, they will be applied to 
that keygroup only. Keep this in mind if you load insert effects 
to multiple keygroups with overlapping note ranges—the 
effects will overlap in that range as well. 

If a routing is set to anything other than Program, then a 
program insert effect will not be applied to that pad or keygroup. 

 

 

Routing 
 

When the Route tab is selected, use the data dial or –/+ 
buttons to select the output of the currently selected pad. 
Usually, this is set to Program. Double-tap a pad in the 
touchscreen to select a different destination (Out 1,2–7,8 in 
Standalone Mode, Out 1,2–31,32 in Controller Mode; MPC 
Live does not use Out 7,8 but displays them to maintain 
compatibility with MPC X, which does use them). 
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Next Sequence Mode 
 

Next Sequence Mode lets you trigger different sequences simply by playing the pads. This is 
useful for live performances, letting you change a song’s structure in real time. 

 

To enter Next Sequence Mode, press Menu, and then tap Next Sequence. 

 

 
 
 
The time counter in the upper-right corner the current playhead position. This is shown in most of the modes. See 
General Features > Time Counter to learn about this. 

 

The sequence playlist on the left side shows a list-style overview of all used 
sequences in your project: 

The Sequence column shows the name of the song’s sequences. 

The Length column shows the bar length of a sequence.  

The BPM column shows the tempo of a sequence in beats per minute. 

The currently selected sequence is highlighted in the list. Tap a sequence in the list 
to select it. 
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In Next Sequence Mode, every pad is assigned to a sequence, 
starting from Pad A01 with Sequence 1 and ascending from there. 
The pads will show the names of their corresponding sequences. 
Empty pads correspond to unused sequences. The currently 
selected pad will flash green. 

 

During playback, change the next sequence that will play by 
pressing the corresponding pad or tapping it in the touchscreen. If 
you do not select another sequence, the current sequence will 
repeat indefinitely. 

 

 

 

As a sequence plays, you can use the buttons at the bottom of the touchscreen to change how playback works: 

To switch to the currently selected sequence at the beginning of the next bar, tap Next Bar. This is useful if 
you want to switch to another sequence before the current one ends without having to worry about timing issues. 

To switch to the currently selected sequence immediately, tap Sudden. The new sequence will start playing 
whether or not the current sequence is done. This is useful in live performances if you need to switch to the next 
sequence instantly at a certain cue. 

To delete the currently selected sequence from the sequence playlist, tap Clear. This option is available only 
if that sequence is not playing at that moment. 

To repeat the current sequence indefinitely and temporarily ignore pad presses, tap Hold. To return to 
normal operation, tap it again. This is useful if you want to select other pads without selecting them to play next. 

 

To copy the sequence playlist to a song, tap   Song while playback is stopped. 

In the Copy to Song screen that appears, select a song, and then tap Do It to continue or Close to cancel. 

To read more about Song Mode, please see the Song Mode chapter. 
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Program Edit Mode 
 

Program Edit Mode contains all parameters for editing your Programs. 

 

For drum programs, this mode includes the parameters of four layers as well as all synthesis parameters and insert 
effect settings. See the Drum Programs section to learn more. 

For keygroup programs, this mode contains slightly more parameters than drum programs. See the Keygroup 
Programs section to learn more. 

For clip programs, this mode looks very different from that of other programs due to how clip launching works. See 
the Clip Programs section to learn more. 

For plugin programs, skip to Plugin Programs to learn more. These are available only when using MPC Live in 
Controller Mode. 

For MIDI programs and CV programs, skip to MIDI Programs and CV Programs to learn more. 

For more general information on the differences between the types of programs, please see General Features > 
Programs. 

 

To enter Program Edit Mode, press Menu, and then tap Program Edit. 

 

 

Drum Programs 
 

When using drum programs, Program Edit Mode lets you edit 
the parameters for each pad. 

To select a pad, press it. Its parameters will appear on the 
screen immediately. 

To view a specific tab of parameters, tap the Master, 
Samples, Pan Velocity, Filter Env, LFO Modulation, or 
Effects button at the bottom of the touchscreen. You can tap 
the Samples button multiple times to cycle through its four 
available sections. 

 

 

Tap the location icon at the top of the touchscreen (between 
the Program and Pad fields) to open the Edit Zones window, 
which is a feature for drum programs and clip programs. This 
window displays an overview of any selected pads. Use the 
Mode selector to set how the selected pads will be edited: 

Current: Only the currently selected pad can be edited. 

Multiple: All selected pads can be edited simultaneously. 

All: All pads can be edited simultaneously. 

To close the window, tap Close, the X, or anywhere outside 
the window. 

Tip: You can immediately select multiple pads while on any tab 
in Program Edit Mode (regardless of the current Edit Zones 
setting) by pressing and holding the Shift button and pressing 
each desired pad. The Edit Zones setting will automatically 
change to Multiple. 

 

The automation button indicates the global automation state. This is shown in several modes. See General Features > 
Automation to learn about this.  
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Master 
In the Master tab, you can set the playback mode and 
tuning for the overall Program. 

 

Polyphony sets the playback mode for the program’s 
pads. In Mono Mode, only one pad will sound at a time. If 
a pad is played while another (or the same one) is still 
playing its sample/samples, the new pad will immediately 
mute all other currently playing pads in that program. In 
Poly Mode, several pads can be triggered at the same time 
(limited only by the total number of voices available). 

 
Semi lets you transpose the program up to 36 semitones 
up or down. 

 
Fine provides fine-tuning of the program up to 99 cents up 
or down. 

 

Volume controls the overall volume level of the loaded sample/samples. 

 
Pan controls the overall panning of the loaded sample/samples in the stereo field. 

 

The Simultaneous Play section lets you set up to four pads that can be triggered by pressing one pad only. This function 
is useful for triggering a stack of sounds (e.g., layered bass drums). Use each Pad field to select the desired pad. 

 

The Mute Targets tab lets you select up to four pads (in the same program) for the currently selected pad. When the 
currently selected pad is played, it will immediately silence its mute targets. Use each Pad field to select the desired 
mute target. 
Tips: 
This feature is useful for programming realistic hi-hats, especially if only the open or closed hat should be heard. 
This feature is similar to the mute group feature, available for both drum programs and keygroup programs. 

 

 

Samples 
Each pad can trigger up to four samples, which are 
assigned in four individual layers. Each layer has identical, 
independently assignable parameters. 

Tap Samples to cycle through its four available sections.  

 

To turn Loop Lock on or off, tap the Loop Lock button. 
When on, the loop position is the same as the pad start (as 
determined in the third and fourth Samples tabs). When 
off, the loop position is independent from the pad start. 

 

Use the Sample field to select the sample file for that layer. 
Remember that the sample has to be loaded into the 
project’s sample pool beforehand. For information on how to 
load samples into a project, please see the Browser chapter. 

 

Semi lets you transpose the selected layer 36 up to semitones up or down. 

 

Fine provides fine-tuning of each layer by cents. 

 
Level lets you adjust the each layer’s volume, letting you control the “balance” of the samples assigned to the pad. 
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Important: The parameters on the second, third, and fourth Samples tabs work in conjunction with Chop Mode (in 
Sample Edit Mode). Here’s how it works: 

When working in Sample Edit Mode and using Chop Mode to divide a sample into slices for your pads, you can 
convert a slice using Non-Destructive Slice or Pad Parameters. 

A Non-Destructive Slice will let its pad to refer to that slice when you press it; the original sample remains intact and 
each slice marker is like a “bookmark” for a pad. In Program Edit Mode, you’ll see that the pad/layer to which it’s 
assigned has its Slice drop-down menu set to the corresponding slice number in the original sample. Playing that 
pad will cause it to refer to that slice marker like a “bookmark” instead of creating an entirely new sample of that 
slice. This means that you no longer have to clutter your Project with a new sample for every slice (though you can 
still use this earlier method, if you prefer). 

A slice converted using Pad Parameters is very similar to a non-destructive slice described above. The difference is 
that in Program Edit Mode, the pads/layers they’re assigned to have their Slice drop-down menus set to Pad (instead 
of the slice number), and the Pad Start and Pad End points will correspond to the slice markers in the original sample. 

 
Use the Slice field to select what part/parts of the sample 
will play: 

All: The entire sample will play. 

Pad: The sample will play from the Pad Start position to 
the Pad End position, described below. This also lets 
you activate Pad Loop. 

Slice 1, 2, 3, etc.: If you have sliced the sample in Chop 
Mode, you can select which slice will play when you 
trigger the pad. 

 

Use the Direction selector to select in which direction the 
sample will play: 

Fwd: The sample will play in the normal forward direction. 

Rev: The sample will play in reverse. 

 

Use the Offset slider to determine a time offset for the 
sample’s playback.  

Positive values (right of center): When the pad is 
played, playback will start immediately but at a later 
point in the sample specified by the offset value.  

Negative values (left of center): When the pad is played, 
playback will be delayed by the amount specified by the 
offset value. 

 

Use the Pad Start slider to determine the position (in 
samples) where the pad’s playback will start. The minimum 
value is 0, and the maximum value is the Pad End value. 

Note: When Loop Lock is on, the loop position (as 
determined in the fourth Samples tab) is the same as the 
pad start. When off, the loop position is independent from 
the pad start. 
 

Use the Pad End slider to determine the position (in 
samples) where the pad’s playback will stop. The minimum 
value is the Pad Start value, and the maximum value is the 
sample’s total length (in samples). 
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Use the Pad Loop button to cycle through the available 
Pad Loop modes.  

Important: For Pad Loop to work, you must (1) set the 
Sample Play field to Note On instead of One Shot and (2) 
set the Slice field to Pad instead of All or a slice number. 

Off: The sample will not loop. 

Forward: You can hold down the pad to cause 
that sample to repeat from the Loop Position 
to the end of the sample. Release the pad to 
stop the repeating playback. 

Reverse: You can hold down the pad to cause 
that sample to play in reverse, repeating from 
the end of the sample to the Loop Position. 
Release the pad to stop the repeating playback. 

Alternating: You can hold down the pad to 
cause that sample to play from the Loop 
Position to the end of the sample and then 
play in reverse until it reaches the Loop 
Position again. This will repeat as long as you 
are holding the pad down. Release the pad to 
stop the repeating playback. 

 

Use the Loop Position slider to determine the position (in samples) where the pad’s playback will repeat when Pad 
Loop is activated. 

Note: When Loop Lock is on, the loop position is the same as the pad start (as determined in the third Samples 
tab). When off, the loop position is independent from the pad start. 

 

 

Pan Velocity 

 

Use the pan knob to adjust the stereo placement of the 
respective layer. 

 

Use the Vel Start and Vel End knobs to define the velocity 
range of each layer. Set the values by doing one of the 
following: 

A range from 0 to 127 lets the layer respond to the entire 
velocity range which is input from the respectve pad while, 
for example, a range from 100 to 127 lets the layer respond 
only to higher velocity levels. By assigning several samples 
of one instrument, you can create a realistic-sounding 
“multi-sample” by adjusting the velocity ranges of each 
layer accordingly. 

For example, you may have three samples of a drum hit 
with low force, medium force, and high force. You can set 
each sample to a layer and set the Velocity ranges so only 
low velocities trigger the low-force sample, only mid-range 
velocities trigger the medium-force sample, and only high 
velocities trigger the high-force sample. 
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Filter Envelope 

 

Use the Type field to select a filter for the selected pad. 
See Appendix > Glossary > Filter for an explanation of the 
available filter types. 

 

Use the Cutoff knob to set the cutoff frequency for low-
pass and high-pass filter types or the center frequency for 
band-pass and band-stop filter types. 

 

Use the Reso knob to set the resonance/emphasis of the 
frequencies around the cutoff point. 

Tip: Use values lower than 80 to give more brilliance to the 
sound. At values higher than 80, the sound will result in a 
strong audible boost around the cutoff frequency.  

 

Use the Env to determine the amount of influence the filter envelope has on the cutoff frequency. Higher settings will 
increase the modulation of the filter by the envelope; lower settings will result in only subtle changes of the filter 
Cutoff over time. 

Tip: To give a sound a more distinctive attack, increase the Env setting and set low Atk and Decay values as well 
as a medium-low Sust value of the Filter Envelope. This will start a sound with the filter opened and close it shortly 
afterward, giving it a bright start followed by a darker sustain. String sounds, on the other hand, can sound much 
more “alive” with low Env settings and a high Atk value, resulting in a slight fade-in of the higher frequencies.  

 

Use the Modulation Sources knobs to set how much velocity is required to modulate certain other parameters:  

Vel>Sta (VelocityStart) sets how much velocity is needed (for a triggered pad) to modulate the sample startpoint. 

Vel>Atk (VelocityAttack) sets how much velocity is needed (for a triggered pad) to modulate the Attack phase for 
the Amp envelope.  

Vel>Env (VelocityEnvelope) enables velocity information to control the amount of the filter envelope’s effect on 
the cutoff frequency. 

Vel>Flt (VelocityFilter) uses the velocity of a pad to modulate the cutoff frequency directly. 

 

The Filter Envelope controls affect the filter frequency. Use the fields or tap and drag the “handles” of the envelope 
to shape the envelope or time-variant modulation output. Adjust the envelope’s influence on the filter frequency with 
the Env knob. See the later Anatomy of an Envelope section to learn about the envelope parameters. 

 

The Amp Envelope controls affect level changes over time. Use the fields or tap and drag the “handles” of the 
envelope to shape the envelope or time-variant modulation output. Adjust the envelope’s influence on the filter 
frequency with the Env knob. See the later Anatomy of an Envelope section to learn about the envelope parameters. 

 



 

 
144 

 

 

LFO Modulation 

 

The Modes controls let you set the behavior for each pad’s 
samples in a drum program. 

 

Use the Mute Group field to assign the selected pad to 
one of the 32 available groups. When pads assigned to the 
same mute group receive MIDI notes, the last pad played 
will silence all other pads in that mute group. A mute group 
affects pads within that program only; mute groups do not 
affect pads in other programs. 

Tip: This feature is useful for programming realistic hi-hats, 
especially if only the open or closed hat should be heard. 

 

Use the Layer Play selector to determine how multiple samples assigned to the same pad are played: 

Cycle (Cyc): Each time the pad is played, it will play the next layer’s sample. In other words, the samples will cycle 
through the layers as follows: 1, 2, 3, 4, 1, 2, 3, 4… etc. 

Velocity (Vel): The pad will switch between layers depending on how hard you press a pad.  

Random (Ran): Each time the pad is played, it will play one of its layer’s samples at random.  

 

Use the Sample Play selector to determine how much of the sample is played.  

One Shot: The entire sample will play from start to end. Use this when you want to play short sounds. 

Note On: The sample will play only as long as the pad is held. This is better for longer samples so you can control 
a sound’s duration by pressing and holding its corresponding pad. 

 

Use the Pad Polyphony field to determine how the pad’s sound behaves when multiple hits are registered. When set 
to Mono, only one pad will sound at a time. If a pad is played while another (or the same one) is still playing its 
sample/samples, the new pad will immediately mute all other currently playing pads in that program. When set to 
Poly, several pads can be triggered at the same time (limited only by the total number of voices available). You can 
also select a specific number of pads (2–32) so that you can trigger up to this many pads at the same time (unless 
they exceed the total number of voices available). 

 

The Velocity Sensitivity controls determine how much the velocity affects the pitch of the sound (Pitch), the attack of 
the filter envelope (Attack), the volume level of the filter envelope (Amp) and or the panning of the sound (Pan). 

When you press a pad softly, only minimal modulation is applied. When you press it harder, the modulation amount 
also gets stronger depending on the setting of the corresponding knob. 

 

A low-frequency oscillator (LFO) generates a periodic waveform with an adjustable frequency and shape which can 
be used for modulation purposes. 

 

Use the Wave field to select the LFO waveform type: 

Sine (best suited for smooth modulations) 

Triangle (best suited for smooth modulations) 

S&H (samples a random value and holds it until the next value is generated) 

Saw (can generate interesting filter or volume changes) 

Saw Down (can generate interesting filter or volume changes) 

Square (interesting results with hard-panning modulations) 

Noise (generates random values and glides) 
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Use the Rate field to determine the LFO frequency when Sync is on. At lower values, it might take some time for the 
LFO to complete a cycle, while higher values will come closer to audible range. 

 

Use the Sync field to set if the LFO’s rate is synchronized with the tempo. You can select one of several time 
divisions (a . indicates a dotted note; a T indicates a triplet-based time division). When None is selected, Sync is off. 

 

Use the Destinations sliders to determine how much the LFO affects the pitch of the sound (Pitch), the cutoff 
frequency of the filter (Filter), the volume level of the sound (Amp) and panning of the sound (Pan). 

 

 

Effects 

 

You can select up to four insert effects for each pad. To 
learn how to use insert effects in MPC Live, please see 
General Features > Effects > Insert Effects. 

 

To add an effect: 

1. Double-tap the desired Inserts slot. A list of effects will 
appear. 

2. Swipe up or down to move through the list. 

You can tap the Type and Manufacturer buttons to 
sort your effects by those categories. 

3. To load an effect, double-tap it, or tap Select. 

To close the list, tap Close. 

 

To remove an effect from its slot, tap the trash can icon.  

 

To enable or disable the effect, tap the On/Off button for 
the slot. 

 

To enable or disable all four insert effects, tap the All 
On/Off button in the upper-right corner. 

 

To adjust the effect’s parameters, tap the pencil icon. 
Use the sliders to set the value of each parameter. These 
values affect only this instance of the effect; insert effects 
are not global.  

The audio of the pad will be routed to send effects (if you 
have any loaded) at their designated send levels. The send 
effects will then return the audio at the designated return 
levels. 

Use the Send knobs to set the volume level of the signal 
the pad will route to each send effect. 

Important: To set the send level, use, you have to load an 
effect into the corresponding send effect slot in the Channel 
Mixer. See Channel Mixer > Returns to learn more how to 
do this. To learn about send effects in MPC Live, please see 
General Features > Effects > Send/Return Effects. 
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Keygroup Programs 

 

When using keygroup programs, Program Edit Mode lets 
you edit the parameters for each keygroup. 

To select a keygroup, press a pad within that keygroup. 
Its parameters will appear on the screen immediately. 
Alternatively, use the Keygroup field at the top of the 
touchscreen. 

To view a specific tab of parameters, tap the Master, 
Samples, Pan Velocity, Filter Env, LFO Modulation, or 
Effects button at the bottom of the touchscreen. You can 
tap the Samples button multiple times to cycle through its 
four available sections. 

 

 

Number of KG (keygroups) lets you create up to 128 
keygroups within a keygroup program. This is useful when 
working with multi-samples. For example, if you want to 
create a realistic piano, you can use different keygroups 
(e.g., 88 for a grand piano) with every keygroup containing its 
own sampled note (with up to four possible velocity layers). 

Tap the Keygroup field to select a keygroup to edit. You 
can also select All to edit all keygroups simultaneously. 

Tap the piano-keys icon to edit the note range of the 
current keygroup. This will open the Set Keygroup Note 
Range window. This lets you restrict the key range used 
for a sample’s playback. Only notes with a key number 
higher or equal (Low Key) or lower and equal (High Key) 
to the selected value will trigger a sound. 

Tips:  

Alternatively, you can set the current keygroup’s note range 
by using the Lo and Hi fields under Note Range in the 
Master tab. 

Set the Lo parameter to A0 and the Hi parameter to C8 to 
emulate the range of a standard 88-key piano. 

 

The automation button indicates the global automation 
state. This is shown in several modes. See General 
Features > Automation to learn about this.  
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Master 

In the Master tab, you can set the playback mode and 
tuning for the overall program. 

 

Polyphony sets the playback mode for the program’s 
keygroups. In Mono Mode, only one keygroup will sound at 
a time. If a keygroup is played while another (or the same 
one) is still playing its sample/samples, the new keygroup 
will immediately mute all other currently playing keygroups 
in that program. In Poly Mode, several keygroups can be 
triggered at the same time (limited only by the total number 
of voices available). 

 

Semi lets you tune the program up to 36 semitones up or 
down. 

 

Fine provides fine-tuning of the program up to 99 cents up or down. 

 

Transpose shifts the pitch of sample up to 36 semitones up or down. This function is identical to the Semi knob; it 
does not affect the transposition of any connected MIDI controller hardware. 

 

KG Select (Keygroup Select) lets you select a specific keygroup for editing. This parameter works in conjunction with 
the Number of KG (keygroups) parameter at the top of the touchscreen, which lets you create up to 128 keygroups 
within one keygroup program. A default keygroup program contains only one single keygroup. When you have 
created more than one keygroup with Number of KG, use KG Select to select any keygroup for editing. All selects 
all available keygroups of a keygroup program for simultaneous editing. 

 

Key Track allows you to switch a sample’s automatic transposition on or off. If this is off, you will always hear the 
same pitch of the sample, no matter which note is triggered by pads or a connected MIDI keyboard. 

 

Level controls the overall volume level of the loaded sample/samples. 

 

Pan controls the overall panning of the loaded sample/samples in the stereo field. 

 

Note Range lets you restrict the key range used for a sample’s playback. Only notes with a key number higher or 
equal (Lo) or lower and equal (Hi) to the selected value will trigger a sound. The settings for Lo and Hi are also shown 
in the virtual keyboard in the Edit Layers section. Alternatively, tap the piano-keys icon to open the Set Keygroup 
Note Range window. 

Tip: Set the Lo parameter to A0 and the Hi parameter to C8 to emulate the range of a standard 88-key piano. 

 

Semi lets you transpose the sample 36 semitones up or down, while Fine provides fine-tuning of each layer up to 99 
cents up or down.  

Tip: The Edit Layers section has some parameters similar to those in this section (Level, Pan, Semi, Fine, Note 
Range). Remember that Key Group parameters control the overall settings for the sample, while Edit Layer 
parameters control the settings for each layer (up to 4). 
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Use the KG Polyphony (keygroup polyphony) field to determine how the keygroup will play. When set to Mono, only 
one pad will sound at a time. If a pad is played while another (or the same one) is still playing its sample/samples, the 
new pad will immediately mute all other currently playing pads in that program. When set to Poly, several pads can 
be triggered at the same time, limited only by the total number of voices available. You can also select a specific 
number of pads (2–32) so that you can play up to this many pads at the same time (unless they exceed the total 
number of voices available). 

 

Use the Mute Group field to assign the selected pad to one of the 32 available groups. When pads assigned to the 
same mute group receive MIDI notes, the last pad played will silence all other pads in that mute group. A mute group 
affects pads within that program only; mute groups do not affect pads in other programs. 

 

Layer Play determines how multiple samples assigned to the same pad are played: 

• Cycle (Cyc): Each time the pad is played, it will play the next layer’s sample. In other words, the samples will 
cycle through the layers as follows: 1, 2, 3, 4, 1, 2, 3, 4… etc. 

• Velocity (Vel): The pad will switch between layers depending on how hard you press a pad.  

• Random (Ran): Each time the pad is played, it will play one of its layer’s samples at random.  

 

Sample Play determines how much of the sample is played: 

• One Shot: The entire sample will play from start to end. Use this when you want to play short sounds. 

• Note On: The sample will play only as long as the pad is held. This is better for longer samples so you can 
control a sound’s duration by pressing and holding its corresponding pad. 

 

 

Samples 

Each pad can trigger up to four samples, which are 
assigned in four individual layers. Each layer has identical, 
independently assignable parameters. 

Tap the Samples button to cycle through its four available 
sections. 

To turn Loop Lock on or off, tap the Loop Lock button. 
When on, the loop position is the same as the pad start (as 
determined in the third and fourth Samples tabs). When 
off, the loop position is independent from the pad start. 

 

Use the Sample field to select the sample file for that layer. 
Remember that the sample has to be loaded into the 
project’s sample pool beforehand. For information on how to 
load samples into a project, please see the Browser chapter. 

 

Semi lets you tune the selected layer 36 up to semitones 
up or down. 

 

Fine provides fine-tuning of each layer by cents. 

 

Level lets you adjust the each layer’s volume, letting you 
control the “balance” of the samples assigned to the 
keygroup. 
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Important: The parameters on the second, third, and fourth Samples tabs work in conjunction with Chop Mode (in 
Sample Edit Mode). Here’s how it works: 

When working in Sample Edit Mode and using Chop Mode to divide a sample into slices for your pads, you can 
convert a slice using Non-Destructive Slice or Pad Parameters. 

A Non-Destructive Slice will let its pad (keygroup) to refer to that slice when you press it; the original sample 
remains intact and each slice marker is like a “bookmark” for a pad. In Program Edit Mode, you’ll see that the 
pad/layer to which it’s assigned has its Slice drop-down menu set to the corresponding slice number in the original 
sample. Playing that pad will cause it to refer to that slice marker like a “bookmark” instead of creating an entirely 
new sample of that slice. This means that you no longer have to clutter your Project with a new sample for every slice 
(though you can still use this earlier method, if you prefer). 

A slice converted using Pad Parameters is very similar to a non-destructive slice described above. The difference is 
that in Program Edit Mode, the pads/layers they’re assigned to have their Slice drop-down menus set to Pad (instead 
of the slice number), and the Pad Start and Pad End points will correspond to the slice markers in the original sample. 

 

Use the Slice field to select what part/parts of the sample 
will play: 

All: The entire sample will play. 

Pad: The sample will play from the Pad Start position to 
the Pad End position, described below. This also lets 
you activate Pad Loop. 

Slice 1, 2, 3, etc.: If you have sliced the sample in Chop 
Mode, you can select which slice will play when you 
trigger the pad. 

 

Use the Direction selector to select in which direction the 
sample will play: 

Fwd: The sample will play in the normal forward direction. 

Rev: The sample will play in reverse. 

 

Use the Offset slider to determine a time offset for the 
sample’s playback.  

Positive values (right of center): When the pad is 
played, playback will start immediately but at a later 
point in the sample specified by the offset value.  

Negative values (left of center): When the pad is played, 
playback will be delayed by the amount specified by the 
offset value. 

 

Use the Pad Start slider to determine the position (in 
samples) where the pad’s playback will start. The minimum 
value is 0, and the maximum value is the Pad End value. 

Note: When Loop Lock is on, the loop position (as 
determined in the fourth Samples tab) is the same as the 
pad start. When off, the loop position is independent from 
the pad start. 

 

Use the Pad End slider to determine the position (in 
samples) where the pad’s playback will stop. The minimum 
value is the Pad Start value, and the maximum value is the 
sample’s total length (in samples). 
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Use the Pad Loop button to cycle through the available 
Pad Loop modes.  

Important: For Pad Loop to work, you must (1) set the 
Sample Play field to Note On instead of One Shot and (2) 
set the Slice field to Pad instead of All or a slice number. 

Off: The sample will not loop. 

Forward: You can hold down the pad to cause 
that sample to repeat from the Loop Position 
to the end of the sample. Release the pad to 
stop the repeating playback. 

Reverse: You can hold down the pad to cause 
that sample to play in reverse, repeating from 
the end of the sample to the Loop Position. 
Release the pad to stop the repeating playback. 

Alternating: You can hold down the pad to 
cause that sample to play from the Loop 
Position to the end of the sample and then play 
in reverse until it reaches the Loop Position 
again. This will repeat as long as you are holding 
the pad down. Release the pad to stop the 
repeating playback. 

 

Use the Loop Position slider to determine the position (in 
samples) where the pad’s playback will repeat when Pad 
Loop is activated. 

Note: When Loop Lock is on, the loop position is the 
same as the pad start (as determined in the third Samples 
tab). When off, the loop position is independent from the 
pad start. 

 

 

Pan Velocity 

 

Use the Pan knob to adjust the stereo placement of the 
respective layer. 

 

Use the Vel Start and Vel End knobs to define the velocity 
range of each layer. Set the values by doing one of the 
following: 

A range from 0 to 127 lets the layer respond to the entire 
velocity range which is input from the respective pad while, 
for example, a range from 100 to 127 lets the layer 
respond only to higher velocity levels. By assigning several 
samples of one instrument, you can create a realistic-
sounding “multi-sample” by adjusting the velocity ranges 
of each layer accordingly. 

For example, you may have three samples of a piano key 
with low force, medium force, and high force. You can set 
each sample to a layer and set the Velocity ranges so only 
low velocities trigger the low-force sample, only mid-range 
velocities trigger the medium-force sample, and only high 
velocities trigger the high-force sample. 
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Filter Envelope 

 

Use the Type field to select a filter for the selected pad. 
See Appendix > Glossary > Filter for an explanation of 
the available filter types. 

 

Use the Cutoff knob to set the cutoff frequency for low-
pass and high-pass filter types or the center frequency for 
band-pass and band-stop filter types. 

 

Use the Reso knob to set the resonance/emphasis of the 
frequencies around the cutoff point. 

Tip: Use values lower than 80 to give more brilliance to the 
sound. At values higher than 80, the sound will result in a 
strong audible boost around the cutoff frequency.  

 

Use the Env to determine the amount of influence the filter envelope has on the cutoff frequency. Higher settings will 
increase the modulation of the filter by the envelope; lower settings will result in only subtle changes of the filter 
Cutoff over time. 

Tip: To give a sound a more distinctive attack, increase the Env setting and set low Atk and Decay values as well 
as a medium-low Sust value of the Filter Envelope. This will start a sound with the filter opened and close it shortly 
afterward, giving it a bright start followed by a darker sustain. String sounds, on the other hand, can sound much 
more “alive” with low Env settings and a high Atk value, resulting in a slight fade-in of the higher frequencies.  

 

Use the Modulation Sources knobs to set how much velocity is required to modulate certain other parameters:  

Kbd>Flt (KeyboardFilter) sets how much aftertouch data (from a pad) is needed to modulate the cutoff frequency. 

Vel>Atk (VelocityAttack) sets how much velocity is needed (for a triggered pad) to modulate the Attack phase for 
the Amp envelope.  

Vel>Env (VelocityEnvelope) enables velocity information to control the amount of the filter envelope’s effect on 
the cutoff frequency. 

Vel>Flt (VelocityFilter) uses the velocity of a pad to modulate the cutoff frequency directly. 

 

The Filter Envelope controls affect the filter frequency. Use the fields or tap and drag the “handles” of the envelope 
to shape the envelope or time-variant modulation output. Adjust the envelope’s influence on the filter frequency with 
the Env knob. See Anatomy of an Envelope to learn about the envelope parameters. 

 

The Amp Envelope controls affect level changes over time. Use the fields or tap and drag the “handles” of the 
envelope to shape the envelope or time-variant modulation output. Adjust the envelope’s influence on the filter 
frequency with the Env knob. See Anatomy of an Envelope to learn about the envelope parameters. 
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LFO Modulation 

 

The Velocity Sensitivity controls determine how much the 
velocity affects the pitch of the sound (Pitch), the attack of 
the filter envelope (Attack), the volume level of the sound 
(Amp), and the panning of the sound (Pan). 

When you press a pad softly, only minimal modulation is 
applied. When you press it harder, the modulation amount 
also gets stronger depending on the setting of the 
corresponding knob. 

 

A low-frequency oscillator (LFO) generates a periodic 
waveform with an adjustable frequency and shape which 
can be used for modulation purposes. 

 

Use the Wave field to select the LFO waveform type: 

Sine (best suited for smooth modulations) 

Triangle (best suited for smooth modulations) 

S&H (samples a random value and holds it until the next value is generated) 

Saw (can generate interesting filter or volume changes) 

Saw Down (can generate interesting filter or volume changes) 

Square (interesting results with hard-panning modulations) 

Noise (generates random values and glides) 

 

Use the Rate field to determine the LFO frequency when Sync is on. At lower values, it might take some time for the 
LFO to complete a cycle, while higher values will come closer to audible range. 

 

Use the Sync field to set if the LFO’s rate is synchronized with the tempo. You can select one of several time 
divisions (a . indicates a dotted note; a T indicates a triplet-based time division). When None is selected, Sync is off. 

 

Use the Destinations sliders to determine how much the LFO affects the pitch of the sound (Pitch), the cutoff 
frequency of the filter (Filter), the volume level of the sound (Amp) and the panning of the sound (Pan). 

 

The Controller Mod section determines the influence of additional play controllers on various sound parameters. 

Important: To use these parameters, make sure that a connected MIDI device can send pitch bend messages as 
well as aftertouch and modulation wheel data. 

 

Pitch Bend sets the range (in semitones) of a connected MIDI keyboard’s pitch-bend wheel. 

 

Wheel>LFO determines how much a connected MIDI keyboard’s modulation wheel affects the LFO intensity. 

 

Aft>Filt (AftertouchFilter Cutoff) determines how much a connected MIDI keyboard’s aftertouch data affects the 
filter cutoff. 
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Effects 

 

You can select up to four insert effects for each keygroup. 
To learn how to use insert effects in MPC Live, please see 
General Features > Effects > Insert Effects. 

Important: When using keygroup insert effects, they will 
be applied to that keygroup only. Keep this in mind if you 
load insert effects to multiple keygroups with overlapping 
note ranges—the effects will overlap in that range as well. 

 

To add an effect: 

1. Double-tap the desired Inserts slot. A list of effects 
will appear. 

2. Swipe up or down to move through the list. 

You can tap the Type and Manufacturer buttons to 
sort your effects by those categories. 

3. To load an effect, double-tap it, or tap Select. 

To close the list, tap Close. 

 

To remove an effect from its slot, tap the trash can icon.  

 

To enable or disable the effect, tap the On/Off button for 
the slot. 

 

To enable or disable all four insert effects, tap the All 
On/Off button in the upper-right corner. 

 

To adjust the effect’s parameters, tap the pencil icon. 
Use the sliders to set the value of each parameter. These 
values affect only this instance of the effect; insert effects 
are not global. 

 

The audio of the program will be routed to send effects (if 
you have any loaded) at their designated send levels. The 
send effects will then return the audio at the designated 
return levels. 

Use the Send knobs to set the volume level of the signal 
the program will route to each send effect. 

You can select up to four send effects for each keygroup, 
but remember that they will be applied to that keygroup 
only. Keep this in mind if you load insert effects to multiple 
keygroups with overlapping note ranges—the effects will 
overlap in that range as well. 

Important: To use a send effect, you have to load an 
effect into the corresponding send effect slot in the Channel 
Mixer. See Channel Mixer > Returns to learn more how to 
do this. To learn about send effects in MPC Live, please see 
General Features > Effects > Send/Return Effects. 
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Clip Programs 

 

When using clip programs, Program Edit Mode lets you assign a 
sample (a loop called a clip) to each pad in a single bank. You can 
also edit various settings to determine how each pad launches its 
assigned clip. 

To select a pad, press it. Its parameters will appear on the 
screen immediately. 

To view a specific tab of parameters, tap Program or Pad the 
bottom of the touchscreen. The Program tab is where you 
assign clips to pads (see Program below). The Pad tab is where 
you determine how each pad plays its clip (see Pad below). 

 

Tap the location icon at the top of the touchscreen (between the 
Program and Pad fields) to open the Edit Zones window, which is 
a feature for drum programs and clip programs. This window 
displays an overview of any selected pads. Use the Mode selector 
to set how the selected pads will be edited: 

Current: Only the currently selected pad can be edited. 

Multiple: All selected pads can be edited simultaneously. 

All: All pads can be edited simultaneously. 

To close the window, tap Close, the X, or anywhere outside the 
window. 

 

The automation button indicates the global automation state. This 
is shown in several modes. See General Features > Automation 
to learn about this. 

 

The Settings window lets you configure certain Audio Edit Mode 
settings. 

To view the Settings, tap the gear icon. 

 

Use the Auto-Scroll selector to set how the screen behaves 
relative to the audio playhead while viewing the Pad tab. 

Follow: Depending on the zoom setting, the waveform display 
will scroll along in the background while keeping the audio 
playhead centered. 

Page: The waveform display will move to the “next page” to 
follow the audio playhead. 

Off: The waveform display will not move at all. 

These functions also apply to the sample waveform in Sample Edit 
Mode. 
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Program 

This tab is where you can assign clips to each pad and adjust the program’s overall tuning and quantization. 

 

 
 

To assign a sample to a pad, press or tap a pad to select it (it will play its assigned samples, if any). Tap the 
Sample field, and then use the data dial or –/+ buttons to select a clip. Alternatively, double-tap the Sample field, 
and then tap a clip to select it. 

 

To clear the assigned clip from a selected pad, assign a sample to a pad, but select None. 

 

Coarse lets you transpose the program up to 36 semitones up or down. 

 

Fine provides fine-tuning of the program up to 99 cents up or down. 

 

Use the Launch Quantize field to set the quantization of the program in bars (or subdivisions of a bar). 
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Pad 

The upper half of the touchscreen shows the clip 
waveform. The lower half shows the editing controls. 

The waveform display shows the “active” section 
of the clip waveform. Swipe left or right on the 
waveform to move through it. 

Above the waveform is the timeline, shown in 
bars, beats, and ticks. 

 

The green marker and red marker are the start point 
and end point (respectively). These two points 
define the region of the sample that will be played. 

To move the start point or end point of the 
selected region, do either of the following: 

• Tap and drag the S or E marker left or right. 

• Use the Start or End fields shown below 
the waveform. 

• Use the first bank Q-Link knobs to adjust the start point or the second bank of Q-Link knobs to adjust the 
end point. The top-most Q-Link knob provides coarse adjustment. The bottom-most Q-Link knob provides 
fine adjustment. 

 

Use the Zoom + or Zoom – buttons at the bottom of the touchscreen to zoom in or out (respectively) of the waveform. 

 

Below is a brief step-by-step process so you can get familiar with setting up a clip. Continue reading the rest of this 
chapter to learn how to use the parameters in this window. 

 

To assign and edit a clip: 

1. Assign a sample to a pad using the Program tab (described earlier). For example, start with a four-bar drum loop. 

2. In the Pad tab, note that the BPM field has a value, which is automatically detected. 

If the Warp button is not already on, tap it. The Warp function keeps the loop in time with the sequence tempo or 
the master tempo. 

3. If you need to edit the loop’s tempo manually, do any of the following: 

• Tap the BPM field, and then use the data dial or –/+ buttons to change the value. 

• Double-tap the BPM field, and then use the numeric keyboard that appears to enter a value. 

4. Let’s shorten the loop to a two-bar loop by doing any of the following: 

• Tap and drag the start point (S) or end point (E) marker. 

• Tap the beat, bar, or tick value of the Start or End fields, and then use the data dial or –/+ buttons to 
change the value. 

• Double-tap the beat, bar, or tick value of the Start or End fields, and then use the numeric keyboard 
that appears to enter a value. 

Set the locations properly to ensure the loop’s timing is correct—neither too short nor too long. When the loop 
repeats, it should feel seamless. 

5. If the Fade button is not already on, tap it. This applies a very small fade-in and fade-out at the start and end of 
the clip to prevent “clicks” and glitches if start point or end point is not at a “zero-crossing.” 

6. If you need to edit the loop’s pitch manually, do any of the following: 

• Tap the Coarse or Fine slider, and then use the data dial or –/+ buttons to change the value. 

• Use the bottom two Q-Link knobs in the first bank to change the value of the Coarse or Fine slider. 

• Double-tap the Coarse or Fine slider, and then use the numeric keyboard that appears to enter a value. 

The Coarse slider adjusts the pitch in semitones. The Fine value adjusts the pitch in cents. You will hear the pitch 
adjust in real time. 
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Tap Warp to lengthen or shorten the clip without changing its pitch, and use the BPM field to change the tempo. Use 
the Coarse and Fine sliders if you want to change the pitch. 

 

Use the Pad Play field to determine the clip is played.  

One Shot: When you press the pad, the entire clip will play from start to end and then stop. 

Toggle: When you press the pad, the entire clip will play from start to end and loop indefinitely. Pressing it again—
or launching another in the same mute group—will stop its playback. This is the most common usage. 

 

Use the Pad Quantize field to set the quantization of the pad in bars (or subdivisions of a bar). When set to Program 
so it uses the same quantization as the overall program (determined by the Launch Quantize field). When set to Off, 
the pad will not follow any quantization at all. 

 

Tap Reverse to reverse the clip’s audio. 

 

Coarse lets you transpose the pad up to 36 semitones up or down.  

 

Fine provides fine-tuning of the pad up to 99 cents up or down. 

 

Use the Mute Group field to assign the selected pad to one of the 32 available groups. When pads assigned to the 
same mute group receive MIDI notes, the last pad played will silence all other pads in that mute group. A mute group 
affects pads within that program only; mute groups do not affect pads in other programs. 

By default, each column of pads is assigned to the same mute group. This means only one pad from each column 
can be playing its clip at a time. You can use the Mute Group field to configure this any way you like, though. 

 

Use the Fade button to apply a very small fade-in and fade-out at the start and end of the clip. This can help prevent 
“clicks” and glitches that may occur if the start point or end point is not placed at the waveform’s “zero-crossings.” 

 

 

Plugin Programs 

 

For plugin programs, you will see an overview of all 
available plugin parameters with a slider for each. 

 

Use the sliders to set the value of each parameter. 

 

Use the six tabs at the bottom of the touchscreen to 
access the available parameters. 

 

To assign a parameter to one of the sliders, use the 
MPC software.  

Note: To see user guide in the MPC software and learn 
how to do this, click the Help menu and select MPC 
User Manual. 
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MIDI Programs 

 

For MIDI programs, you will see an overview of all 
available MIDI CCs with a slider for each. 

 

Use the sliders to set the value of each parameter. 

 

Use the six tabs at the bottom of the touchscreen to 
access the available parameters. 

 

To assign a parameter to one of the sliders, use the 
MPC software.  

Note: To see user guide in the MPC software and learn 
how to do this, click the Help menu and select MPC 
User Manual. 

 

 

CV Programs 

 

For CV programs, you will see an overview of all 
available CV outputs with a slider for each. Although this 
option is selectable, it is not available for MPC Live, 
which does not have CV outputs. 

 

The automation button indicates the global automation 
state. This is shown in several modes. See General 
Features > Automation to learn about this.  

 

Use the sliders to set the value of each parameter. 

 

Use the six tabs at the bottom of the touchscreen to 
access the available parameters. 

 

To assign a parameter to one of the sliders, use the 
MPC software. 

Note: To see user guide in the MPC software and learn 
how to do this, click the Help menu and select MPC 
User Manual. 
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Anatomy of an Envelope 

 

An envelope creates a variable control signal. It can be used, for instance, to modulate the filter settings of a sound 
over a given period of time. 

 

For drum programs, use the AD/AHDS selector to select an AD or AHDS envelope. 

Keygroup programs always use AHDS envelopes. 

 

With AHDS envelopes, the following happens when you 
trigger a sample: 

1. Within the period of time you have defined with the attack 
(Atk), the sample volume rises to its maximum value. 

2. The sample’s maximum volume will be maintained 
during the Hold phase. 

3. During the Decay phase, the sample’s volume will 
gradually drop to the sustain level. 

4. The sample’s volume will stay at the sustain level 
(Sust) until the pad is released.  

 

With AD envelopes, the following happens when you trigger 
a sample: 

1. Within the period of time you have defined with the attack 
(Atk), the sample volume rises to its maximum value. 

2. The sample’s maximum volume will be maintained until 
its Decay phase, when the sample’s volume will gradually 
drop to zero over the set duration. Click the Type drop-
down menu to select how the decay functions: 

Decay From Start: The volume will start decreasing 
immediately after reaching its maximum level. 

Decay From End: The maximum volume will be 
maintained for a hold phase until it reaches the 
decay phase. 
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Looper 
 

The Looper lets you record and overdub audio in real time—a great tool for live performance 
as well as spontaneous moments in the studio. You can export the loop as a sample to use in 
your project. 

 

To open the Looper, press Menu, and then tap Looper. 

 

 

 

Below is a brief step-by-step process so you can get started quickly. Continue reading the rest of this chapter to 
learn how to use the Looper in different cases. 

 

To get started using the Looper: 

1. Make sure to reduce the volume levels of your audio source and speakers/headphones/monitors before you 
make any connections to avoid “pops” or feedback. 

2. Connect a synthesizer, audio player, etc. to the input/inputs of your MPC Live.  

3. Turn the Rec Vol knob to set the input level while playing your audio source. You should now see the level in the 
meter. Make sure it does not exceed the maximum level (the meter should not be “peaking” constantly). 

4. Set the recording controls as desired (described in this chapter). 

5. Tap the Record To selector so Overdub is selected. 

6. Tap the Rec/Record button in the lower-right corner to record-arm the Looper. 

7. Play your audio source. The Looper will start recording immediately when the input level reaches the threshold 
value. Alternatively, tap /Play at the bottom of the touchscreen to manually start recording. 

Each time the Looper repeats, its contents are being overdubbed—a new layer of audio will be added each time 
you let the Looper repeat as it records.  

Tip: You can record a loop while playing a sequence in the background for reference. 

8. To stop recording, tap /Play at the bottom of the touchscreen.  

To export your loop as a sample, tap Export to open the Keep or Discard Sample window. 

To clear the contents of the Looper, tap Clear. 

 

The time counter at the top of the touchscreen the current playhead position. This is shown in most of the modes. 
See General Features > Time Counter to learn about this. 
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The upper-left Input Source field defines whether you are going to record an external 
audio signal (Input 1,2, Input 3,4, or one of Input 1–4) or an internal signal from within 
MPC Live (Resample L, Resample R, or Resample L+R). 

Resampling does not require an audio connection because the source is within MPC 
Live and is therefore recorded without any loss in audio quality. You can, for example, 
use Resample to record two or more samples by pressing the corresponding pads 
simultaneously. 

 

Use the second upper-left Mono/Stereo field to choose whether your recorded loop 
will be monaural (Mono) or binaural (Stereo). 

 

The Inserts field shows any enabled or disabled effects for the Looper. Tap the area under 
Inserts to open a window where you can load, change, and enable or disable the effects. 

Important: These effects are applied to the audio as you record it. This means that the 
effects cannot be “removed” from the sound later. Learn more about how effects work 
in General Features > Effects. 

 

Tap the Monitor button to enable or disable input monitoring. 

When on, the audio you hear in your headphones will be taken before it reaches the Looper, ensuring zero latency. 
You can turn input monitoring on only if the Input Source field is set to an input, not to a Resample setting. 

When off, the audio you hear in your headphones will be taken after it is processed in the Looper, so there may be 
some latency, but you will hear the audio source as it sounds in the recording. 

Tip: To avoid possible clicks or feedback while input monitoring, reduce the level of the audio sources. 

 

Use the threshold slider to adjust the threshold. Alternatively, turn the bottom-most Q-Link knob. The threshold 
slider will work only when Sync is off (see below). 

When the Looper is record-armed, it automatically starts recording when the level of the incoming source exceeds 
this setting. If you set it too high, the recording may not start when you play the input source, or the start of the 
material you wanted to record may be missing. If you set it too low, the recording may start too early, before you play 
the external source. Set this parameter to an appropriate level using the level meter. 

To reset the “peak hold,” which shows the highest level of your input signal in the level meter, tap it. 

 

Use the Bars field to define the length of your loop. Regardless 
of how much or how little audio you record, this is how long 
your loop will be. 

 

Use the Sync button to sync or un-sync the looper with 
sequence playback. When on, the Looper will stay in step with 
your current sequence. When you play or record into the Looper, 
it will wait until the sequence starts playing Bar 1 to start. 

 

Use the Record To selector to determine the loop recording 
behavior: 

Play: Before recording, you must first tap the /Play button 
on the touchscreen, which will start playing the Looper. 

Overdub: Before recording, you must first tap the Rec/Record 
button in the lower-right corner to record-arm the Looper. 

 

Use the Output Gain slider to set the output signal level of the 
Looper. 
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To record with the Looper: 

Important:  

To record without erasing any audio you’ve already 
recorded in the loop, use the Overdub button. 

To overwrite the audio you’ve already recorded, use 
the Replace button. 

If Record To is set to Play: 

To start recording, tap the Replace or Overdub 
button as the loop is playing. The Looper will start 
recording immediately. 

To stop recording, tap the Replace or Overdub 
button. The Looper will stop recording but continue 
playing. 

To stop playback and recording, tap the /Play 
button. 

If Record To is set to Overdub: 

To start recording, tap the /Play button on the touchscreen. 

If Sync is off, you can also play your audio source so that the input level reaches the threshold value. 

If Sync is on, you can also press the Play or Play Start button to start playing a sequence; recording will 
start when the sequence starts on Bar 1.  

To stop recording, tap Overdub. The Looper will stop recording but continue playing. 

To stop playback and recording, tap the /Play button, or press stop to stop sequence playback. 

 

To play or stop the loop (without recording), tap the /Play button on the touchscreen. 

 

To reverse loop playback, tap Reverse. If Sync is on, playback will reverse once the Looper’s playhead reaches 
the end of the loop. If Sync is off, playback will reverse immediately. 

 

To erase the loop immediately, tap Clear. 

 

To export the loop as a sample: 

1. Tap Export to open the Export Loop as a Sample window. 

2. Tap the Edit Name field and use the virtual keyboard that 
appears to enter a new name. 

3. Optional: Use the Program field to assign it directly to a 
program. To ignore this feature, select <none>. 

4. Optional: If you’re assigning the sample to a program, use the 
Assign to Pad field to assign it to a specific pad. Alternatively, 
just press the pad. To ignore this feature, select Off. 

5. Use the Root Note field to select the sample’s root note. 

6. Optional: Tap and hold your finger on Play to play the sample. 

7. Tap Do It to confirm your choice, or Cancel to cancel. 

When your loop is done exporting, it will be added to your 
project’s sample pool with the name you entered and will be 
assigned to the program and pad you selected (if any). 
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Track Mute Mode 
 

Track Mute Mode lets you easily mute tracks within a sequence or set track groups, enabling 
you to mute multiple tracks at once.  

 

To enter Track Mute Mode, press Menu, and then tap Track Mute.  

 

 

 

There are two tabs you can view in this mode: Track Mute or Track Group. Tap each button in the lower-left corner 
to select it. See the following Track Mute and Track Group sections to learn about each. 

 

Use the Sequence field at the top of the touchscreen to select a sequence. 

 

The time counter in the upper-right corner the current playhead position. This is shown in most of the modes. See 
General Features > Time Counter to learn about this. 

 

Time Correct lets you quantize track mutes. This is useful when you want your mutes to line up with a specific time 
division. For example, with Time Division set to 1 Bar, your mutes will always align with the beginning of the 
measure immediately after you press the pad. 

Tap Time Division at the bottom of the touchscreen, and select a value from 1/16 to 2 Bars (T indicates a triplet-
based time division).  

Tap TC at the bottom of the touchscreen to enable or disable the Time Correct feature. 

 

Tap Solo to turn track soloing on or off. When on, using Track Mute Mode will solo tracks instead of muting them.  
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Track Mute 
 

This is useful if you want to hear a sequence without a 
particular track (e.g., muting your keyboard track to focus on 
the bass) or if you want to isolate specific sounds or 
combinations of sounds that are separated by track.  

Tip: This function is similar to, but more convenient than, 
muting tracks one at a time in the Track View. 

 

To mute tracks in this mode: 

1. If the Track Mute tab in the lower-left corner is not 
already selected, tap it. 

2. Select the desired pad bank. Use the Pad Bank buttons or 
tap a pad bank shown on the left side of the touchscreen. 

3. To mute or unmute a track, press the corresponding 
pad or tap it in the touchscreen. Pads for muted tracks 
are lit red. Pads for unmuted tracks are lit yellow. Pads 
for unused tracks do not show any information. 

 

To assign tracks to track groups within this tab: 

1. Use the Q-Link button to select a row of four pads, outlined in the touchscreen. 

2. Turn each of the Q-Link knobs to assign each of the four outlined pads to a track group. The number of each 
pad’s track group is shown in its upper-right corner. 

 

 

Track Group 
 

The track group feature extends the concept of track mutes: 
you can mute or unmute multiple tracks (in a single 
sequence) by pressing one pad that you have assigned to a 
track group. This is useful if you want to hear a track without 
a particular group of sounds or if you want to isolate specific 
sounds in various combinations. You can create up to 16 
different track groups. 

 

To assign tracks to track groups: 

1. If the Track Group tab in the lower-left corner is not 
already selected, tap it. 

2. Select the desired pad bank by using the Pad Bank 
buttons. 

3. To select a track to add to a mute group, press the 
corresponding pad or tap it on the touchscreen. The pad 
for the selected track is lit green. If there are other pads for 
tracks in the same mute group, they will flash yellow. 

4. To add the track to a mute group, tap the number of 
the desired mute group. 

To remove the track from the mute group, tap Off. 

 

Alternatively, do the following: 

1. Use the Q-Link button to select a row of four pads, outlined in the touchscreen. 

2. Turn each of the Q-Link knobs to assign each of the four outlined pads to a track group. The number of each 
pad’s track group is shown in its upper-right corner. 
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Channel Mixer 
 

In the Channel Mixer, you can set levels, stereo panning, and other settings for your tracks, 
programs, returns, submixes (while using MPC Live in Controller Mode), and masters. 

 

To open the Channel Mixer, press Menu, and 
then tap Channel Mixer. 

 

The Channel Mixer works like an audio mixer with 
various settings for each channel, shown in a 4x4 
array. Their functionality is mostly identical. The 
name of the track, program, or channel is 
displayed at the top of each one. 

 

Use the Mixer field at the top of the touchscreen to 
select which mixer you want to view: MIDI Tracks, 
Audio Tracks, Programs, Returns, Submixes, or 
Masters. Each page has slight differences, described 
in each section. 

 

The following controls and tabs are available for all of the mixers (or most of them, as indicated). 

 

To select a channel, tap its corresponding pad on the touchscreen. Alternatively, use the field in the upper-left corner. 

To view more channels (while viewing tracks or programs), use the –/+ buttons at the top of the touchscreen. 

 

The time counter in the upper-right corner the current playhead position. This is shown in most of the modes. See 
General Features > Time Counter to learn about this. 

 

The automation button indicates the global automation state. This is shown in several modes. See General Features 
> Automation to learn about this.  

 

 

Levels 

When the Level tab is selected, use the data dial or –/+ buttons to adjust the velocity level or volume level of the 
currently selected track, program, return, submix, or master. 

The level sliders and meters in each pad show a visual representation of the level. Double-tap a pad in the 
touchscreen to open a large version of the level slider and meter. 

 

 

Panning 

When the Pan tab is selected, use the data dial or –/+ buttons to adjust the panning of the currently selected 
track, program, return, submix, or master. 

The pan sliders in each pad show a visual representation of the level. Double-tap a pad in the touchscreen to open 
a large version of a pan knob. 
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Mute/Solo/Rec Arm 

Tap this tab to cycle it through Mute, Solo, and Rec Arm functions. 

 

When Mute is selected, mute tracks, programs, returns, submixes, or masters by doing any of the following: 

• Turn or press the data dial. 

• Use the –/+ buttons. 

• Tap the pad in the touchscreen. 

• Use the Q-Link button to select a row of four pads, outlined in the touchscreen. Turn each of the Q-Link 
knobs to mute or unmute each of the four outlined pads. 

When a track, program, return, submix, or master is muted, its M button will light red. 

 

When Solo is selected, solo tracks, programs, returns, submixes, or masters by doing any of the following: 

• Turn or press the data dial. 

• Use the –/+ buttons. 

• Tap the pad in the touchscreen. 

• Use the Q-Link button to select a row of four pads, outlined in the touchscreen. Turn each of the Q-Link 
knobs to solo or unsolo each of the four outlined pads. 

When a track, program, return, submix, or master is soloed, its S button will light red while other tracks are muted 
with their M buttons lit red. 

The Solo tab is available for tracks and programs only.  

 

When Rec Arm is selected, record-enable tracks by doing any of the following: 

• Turn or press the data dial. 

• Use the –/+ buttons. 

• Tap the pad in the touchscreen. Press and hold Shift while tapping a pad in the touchscreen to record-
enable multiple tracks at once. 

• Use the Q-Link button to select a row of four pads, outlined in the touchscreen. Turn each of the Q-Link 
knobs to record-arm or disarm each of the four outlined pads. 

The Rec Arm tab is available for audio tracks only. 

 

 

Send Levels (Audio Tracks, Programs, and Submixes only) 

When the Send tab is selected, use the data dial or –/+ buttons to adjust the send level of audio tracks, programs, 
or submixes. 

The level sliders in each pad show a visual representation of the level. Double-tap a pad in the touchscreen to 
open a large version of the level slider. 

You can use up to four send channels. Tap Send to cycle through the four available slots for each. 

To learn how to use send effects, please see General Features > Effects > Send/Return Effects. 

Important: When using send channels, make sure you have already loaded at least one effect to it using the return 
mixer. See Returns below to learn how to do this. 
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Insert Effects (Audio Tracks, Programs, Returns, Submixes, and Masters only) 

When the Insert tab is selected, use the data dial or –/+ buttons to adjust the insert effect level of audio tracks, 
programs, returns, submixes, or masters. 

The level sliders in each pad show a visual representation of the level. Double-tap a pad in the touchscreen to 
open a large version of the level slider. 

You can select up to four insert effects for each audio track, program, return, submix, or master. Tap the Insert 
button to cycle through the four available slots for each. 

To learn how to use insert effects, please see General Features > Effects > Insert Effects. 

 

 

Routing (Audio Tracks, Programs, Returns, and Submixes only) 

When the Route tab is selected, use the data dial or –/+ buttons to select the output of the currently selected 
program, return, or submix. 

 

 

MIDI Tracks 
 

The MIDI Track Mixer shows levels, panning, and mute 
states for all used tracks. 

 

To view a specific setting on all tracks, tap Level, Pan, 
or Mute at the bottom of the touchscreen. Tap Mute/Solo 
to switch between them. 

 

When a track is selected, you can view and adjust all of its 
settings in the left side of the touchscreen rather than using 
the tab buttons at the bottom. 

When viewing the MIDI track channel strip: 

Note: This is the same as the MIDI track channel strip in 
Main Mode. 

• The first field shows the current track (which you 
can change). 

• The second field shows the current program the 
track is using (which you can change to a program 
of the same type). 

• To solo or mute the pad, tap Solo or Mute 
(respectively). 

• To change the panning or velocity of the track, 
adjust the pan knob or velocity slider. 
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Audio Tracks 
 

The Audio Track Mixer shows levels, mute/solo/record-arm 
states, send and insert effects, and routing for all used tracks. 

 

To view a specific setting on all tracks, tap Level, Pan, 
Mute/Solo/Rec Arm, Send, Insert, or Route at the bottom 
of the touchscreen. Tap Mute/Solo/Rec Arm to cycle 
through them. 

 

When a track is selected, you can view and adjust all of its 
settings in the left side of the touchscreen rather than using 
the tab buttons at the bottom. 

When viewing the audio track channel strip: 

Note: This is the same as the audio track channel strip in 
Main Mode. 

• The first field shows the current track (which you can change). 

• The second field shows the current program the track is using (which you can change to a program of the 
same type). 

• The Inserts field shows any enabled or disabled effects for that audio track. Tap the area under Inserts to 
open a window where you can load, change, and enable or disable the effects. 

• To solo or mute the pad, tap Solo or Mute (respectively). 

• To set how your audio track will be monitored, tap the Monitor button to cycle through its three states: 

When set to Auto, you will hear incoming audio while the track is record-enabled only. 

When on, you will hear incoming audio whether or not the track is record-enabled. 

When off, you will never hear any incoming audio. 

• To change the audio track’s automation, tap the automation button to cycle through its 
three states: 

When off, the audio track will ignore automation data. If you have already recorded or 
entered automation, tapping this will switch between Read (R) and Write (W) only, but you 
can override this and turn it off by pressing and holding Shift while tapping the button. 

Important: If you have already recorded automation and turn it off, the audio track will still 
use the effect and its parameter values at the point where you turned it off. 

When set to Read (R), the audio track will read automation data but will not record any 
additional automation over it. You can still manually edit and enter automation. (Think of this as 
a protective feature to prevent accidental changes to your automation while recording.) 

When set to Write (W), the audio track can record automation. (If you have any Q-Link knobs 
assigned to automatable parameters, make sure not to touch any accidentally while you are 
recording.) 

Tip: You can quickly set all programs and audio tracks to the same automation by tapping the 
global automation button in the upper-right corner of the touchscreen. See General Features 
> Automation to learn about this. 

• To change the panning or level of the track, adjust the pan knob or level slider. 

• To record-enable the track, tap the Record Arm button. When you begin audio recording, 
the audio signal will be recorded to this track. 

Tip: You can select multiple tracks in the Rec Arm tab by pressing and holding Shift and 
tapping each pad in the touchscreen. You can also do this in the Track View by pressing and 
holding Shift while tapping the Arm button to each track. 
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Programs 
 

The Program Mixer shows levels, panning, mute states, 
send and insert effects, and routing for all programs. 

 

To view a specific setting on all programs, tap Level, 
Pan, Mute/Solo, Send, Insert, or Route at the bottom of 
the touchscreen. Tap Mute/Solo to switch between them. 
Tap Send or Insert to cycle through the four available slots 
for each. 

 

When a program is selected, you can view and adjust all of 
its settings in the left side of the touchscreen rather than 
using the tab buttons at the bottom. 

When viewing the program channel strip: 

Note: This is the same as the program channel strip in 
Main Mode. 

• The first field shows the current program number and name (which you can change). 

• The second field shows where the program is routed (which you can change). 

• The Inserts field shows any enabled or disabled effects for that program. Tap the area under Inserts to open 
a window where you can load, change, and enable or disable the effects. 

• To solo or mute the program, tap Solo or Mute (respectively). 

• To change the program’s automation, tap the program automation button to cycle through its three states: 

When off, the program will ignore automation data. If you have already recorded or entered 
automation, tapping this will switch between Read (R) and Write (W) only, but you can 
override this and turn it off by pressing and holding Shift while tapping the button. 

Important: If you have already recorded automation and turn it off, the track will still use the 
effect and its parameter values at the point where you turned it off. 

When set to Read (R), the program will read automation data but will not record any 
additional automation over it. You can still manually edit and enter automation. (Think of this 
as a protective feature to prevent accidental changes to your automation while recording.) 

When set to Write (W), the program can record automation. (If you have any Q-Link knobs 
assigned to automatable parameters, make sure not to touch any accidentally while you are 
recording.) 

Tip: You can quickly set all programs and audio tracks to the same automation by tapping 
the global automation button in the upper-right corner of the touchscreen. See General 
Features > Automation to learn about this. 

• To change the panning or level of the program, adjust the pan knob or level slider. 
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Returns 
 

Pads, programs, and audio tracks can each be sent to up 
to four send channels. Their audio signals will be routed to 
the send channels at their designated send levels. After 
being processed by the effects on those channels, their 
signals are then sent back based on their return settings 
(levels, panning, etc.). This view displays the four return 
channels. The return mixer shows levels, panning, mute 
states, insert effects, and routing for all used tracks. 

 

To view a specific setting on all returns, tap Level, Pan, 
Mute, Insert, or Route at the bottom of the touchscreen. 
You can tap Insert multiple times to cycle through the four 
available slots. 

 

When a return is selected, you can view and adjust all of its 
settings in the left side of the touchscreen rather than using 
the tab buttons at the bottom. 

When viewing the return channel strip: 

• The first field shows the current return number 
(which you can change). 

• The second field shows where the return is routed 
(which you can change). 

• The Inserts field shows any enabled or disabled 
effects for that return. Tap the area under Inserts 
to open a window where you can load, change, 
and enable or disable the effects. 

• To mute the return, tap Mute. 

• To change the panning or level of the program, 
adjust the pan knob or level slider. 
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Submixes  

 

The Submixer shows levels, panning, mute states, send and 
insert effects, and routing for the eight available submixes. 

Important: Submixes are available only while using MPC 
Live in Controller Mode with the desktop version of the 
MPC software. 

 

To view a specific setting on all submixes, tap Level, 
Pan, Mute, Send, Insert, or Route at the bottom of the 
touchscreen. You can tap Send or Insert multiple times to 
cycle through the four available slots for each. 

 

When a return is selected, you can view and adjust all of its 
settings in the left side of the touchscreen rather than using 
the tab buttons at the bottom. 

When viewing the submixer channel strip: 

• The first field shows the current submix (which you 
can change). 

• The second field shows where the submix is routed 
(which you can change). 

• The Inserts field shows any enabled or disabled 
effects for that submix. Tap the area under Inserts 
to open a window where you can load, change, 
and enable or disable the effects. 

• To mute the submix, tap Mute. 

• To change the panning or level of the submix, 
adjust the pan knob or level slider. 

 

 

Masters 

 

The Master Mixer shows levels, panning, mute states, and 
insert effects for all used stereo pairs of outputs (Out 1,2–7,8 
in Standalone Mode, Out 1,2–31,32 in Controller Mode; 
MPC Live does not use Out 7,8 but displays them to 
maintain compatibility with MPC X, which does use them). 

 

To view a specific setting on all outputs, tap Level, Pan, 
Mute, or Insert at the bottom of the touchscreen. You can tap 
Insert multiple times to cycle through the four available slots. 

 

When viewing the master channel strip: 

Note: This is the same as the master channel strip in Main 
Mode. 

• The first field shows the current pair of outputs 
(which you can change). 

• The Inserts field shows any enabled or disabled 
effects for that pair of outputs. Tap the area under 
Inserts to open a window where you can load, 
change, and enable or disable the effects. 

• To mute that pair of outputs, tap Mute.  

• To change the panning or level of the master 
output, adjust the pan knob or level slider. 
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Song Mode 
 

Song Mode lets you arrange sequences in a specific order and/or repetition to create songs. 
You can edit the structure of a song during playback for easy, on-the-fly composing. 

A project can contain up to 32 songs, each consisting of up to 999 “steps.” Each step can have 
an assigned sequence as well as the number of times that sequence will repeat. 

 

To open Song Mode, press Menu, and then tap Song Mode. 

Important: If a sequence is currently playing, stop playback 
before entering Song Mode. You cannot enter Song Mode 
during playback. 

 

Use the Song field to select the song you want to show. 

 

 

 

 

 

Use the BPM field to adjust the tempo of the sequence.  

To set whether the sequence follows its own tempo (Seq) 
or a master tempo (Mst), tap the Seq/Mst button next to the 
BPM field. Alternatively, press and hold Shift+Tap Tempo. 

 

 

The sequence playlist on the left lists of the “steps” of a song. 

Each step has (in columns, left to right): 

• the step number (each song can contain up to 999 steps) 

• a sequence number and name 

• how many times the sequence plays (each step can 
play up to 999 times; set it to Hold [the 
lowest/minimum value] to set the sequence to repeat 
indefinitely until you stop playback) 

• the tempo of the sequence 

• the number of bars the step occupies (based on how 
many times it plays) 

 

 

 

Each used sequence is assigned to a pad. Empty pads 
correspond to unused sequences. Use the Pad Bank buttons 
to access the sequences assigned to pads in other banks. 
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To insert a step:  

1. Tap a step in the sequence playlist after which you want 
to insert a step. 

2. Tap Insert in the lower-right corner of the touchscreen.  

 

To change a step’s sequence: 

1. In the desired step, tap the sequence name. 

2. Use the data dial or –/+ buttons to select another sequence. 

 

To delete a step, tap it, and then tap Delete in the lower-right 
corner of the touchscreen. 

 

To clear the entire sequence playlist (delete all steps), tap 
Clear. 

 

To convert the current song to a single sequence: 

1. Tap Convert > Seq to open the Convert to Sequence 
window. 

2. Use the To Sequence field to select which sequence you 
want the song to export to. 

3. Use the Track Status field to select whether you want the 
song to Ignore Muted Tracks or Include Muted Tracks 
in the new sequence. 

4. To confirm your selections, tap Do It. 

To cancel the process, tap Close. 

 

To render/export your song as an audio file, tap Export to 
open the Audio Mixdown screen. See General Features > 
Audio Mixdown to learn how to use this screen to export 
your song. 
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Browser 
 

The Browser lets you navigate your MPC Live’s internal and external hard disks to load samples, 
sequences, songs, etc. Using filter buttons and user-definable folders, you can easily adapt it to 
your preferred workflow. You can also audition (preview) your samples before loading them. 

Important: You can install an additional SATA drive in your MPC Live, allowing for even more storage space. See 
Appendix > SATA Drive Installation to learn more about this. 

Important: MPC Live supports read and write capability for exFAT, FAT32, NTFS, and EXT4 file systems a well as 
read-only capability for HFS+ file systems. We recommend using an exFAT file system as it is the most robust one 
supported by both Windows and Mac OS X. 
 
To show the Browser, do any of the following: 

• Press Shift+Menu/Browse. 

• Double-press Menu/Browse. 

• Press Menu and then tap Browser. 

 
To browse for files, tap Browse in the lower-left corner. 

To view the project’s sample pool and pads, tap Sample Assign 
in the lower-left corner. 

 
When the Browse tab is selected, you can do any of the 
following: 

To browse your files by location, tap Places on the left 
side of the touchscreen. Internal is the MPC Live’s internal 
drive. MPC Documents is a shortcut to the MPC 
Documents folder on the internal drive. If you have USB 
drives connected to MPC Live’s USB ports, they will appear 
in this column, as well. 

To browse your files by content, tap Content and then 
tap the type of file: Drums, Instruments, Clips, Samples, 
Demos, or My Files (see below to learn about these 
content buttons). 

To move up one folder level, tap the folder/ icon in the 
upper-left corner. 

To move through a list, swipe up or down, turn the data 
dial or use the –/+ buttons. 

To select a file or folder, tap it once. 

To enter a folder, double-tap it or tap Open in the lower-
right corner. Alternatively, press the data dial to enter a 
selected folder. You can also tap one of the folder buttons 
(1–5) in the upper-right corner to jump immediately to those 
pre-assigned file paths (see below to learn how to assign 
these file paths). 

To load a selected file, double-tap it, tap Load, or press the data dial. If the file is a sample, it will be loaded to 
the project’s sample pool. If the file is a project, it will be loaded in its entirety (you will be asked if you want to 
close your current project). 

To load all files in a selected folder, press and hold Shift and then tap Load All in the lower-right corner. 

To delete a selected file, press and hold Shift and then tap Delete File at the bottom of the touchscreen. 

To preview a selected sound, tap and hold Play () at the bottom of the touchscreen. 

To enable or disable the audition function and set its volume level, tap Audition at the bottom of the 
touchscreen. In the screen that appears, tap Auto to enable or disable it, and tap and drag the level slider up or 
down to set the volume level. Tap Audition once more to hide the window. 

To show the information for the current drive, press and hold Shift and then tap Drive Info at the bottom of the 
touchscreen. The drive’s information will appear in a new window. Tap OK to return to the previous screen. 
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To get the most efficient use of the Browser, set the file paths to 
your favorite drive locations first. There are five folder buttons 
labeled 1–5 in the upper-right corner. You can set these to be 
shortcuts to five locations on MPC Live’s internal drive and/or any 
connected USB drives, giving you quick access to your files. 

 

To assign the current location to a folder button, press and 
hold Shift, and then tap one of the folder buttons (1–5). Now, 
when you tap that folder button again, the Browser will show that 
folder’s content immediately. 

 

Use the six filter buttons to show only specific types of files in the 
list below.  

To show project files only, tap the P/page icon. 

To show sequence files only, tap the bars icon. 

To show program files only, tap the four-squares icon.  

To show sample files only, tap the waveform icon. 

To show all file types, tap the three-pages icon. 

To show or hide MPC project folders, tap the MPC folder icon. 

 

Use the six Content buttons to show specific locations in MPC 
Live’s internal drive and filter them automatically by file type: 

Drums: Tap this button to enter the Expansions/The Vault 2 
folder on the internal drive, viewing program files only. 

Instruments: Tap this button to enter the Expansions/ 
Instruments folder on the internal drive, viewing program files 
only. 

Clips: Tap this button to enter the Expansions/Cliips folder on 
the internal drive, viewing program files only. 

Samples: Tap this button to enter the Expansions/The Vault 2 
folder on the internal drive, viewing sample files only. 

Demos: Tap this button to enter the Demos folder on the 
internal drive, viewing project files only. 

My Files: Tap this button to enter the MPC Documents folder, 
viewing all files. 
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When the Sample Assign tab is selected, you can do any 
of the following: 

To select a program in the project, double-tap the 
Program field at the top of the touchscreen. In the list 
that appears, tap the desired program. Alternatively, tap 
the Program field and then use the data dial or the –/+ 
buttons to select a location. 

To move through the sample pool, swipe up or down, 
turn the data dial, or use the –/+ buttons. 

To preview a selected sound, tap and hold Play () at 
the bottom of the touchscreen. 

To enable or disable the audition function and set its 
volume level, tap Audition at the bottom of the 
touchscreen. In the screen that appears, tap Auto to 
enable or disable it, and tap and drag the level slider up 
or down to set the volume level. Tap Audition once 
more to hide the window. 

To assign a sample to a pad, press it or tap it in the 
touchscreen so it lights green. Then, in the Sample Pool 
list, tap the desired sample. Alternatively, use the data 
dial or –/+ buttons to select a sample, and press the 
data dial to assign it. 

To clear a sample from a pad, press it or tap it in the 
touchscreen so it lights green. Then, tap Clear Pad at 
the bottom of the touchscreen. 
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Pad Perform Mode 
 

Pad Perform Mode lets you assign musical scales/modes, chords, or progressions to the pads 
for more creative performance. 

 

To enter Pad Perform Mode, press Menu, and then tap Pad Perform while using a keygroup program, MIDI 
program, plugin program, or CV program. (Although you can enter Pad Perform Mode while using a drum program or 
clip program, it does not work with these programs.) 

 

 

 

The touchscreen will show the current pad bank’s mapping of notes or chords. 
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Use the Type selector to determine what will be mapped over the pads: 

Notes: Each pad is assigned a note, ascending by one scale degree with each pad. 

Chords: Each pad is assigned a chord, the root note ascending by one scale degree with each pad. All available 
chords will play in the key determined by the Scale. 

Chromatic Chords: Each pad is assigned a chord, the root note ascending by one scale degree with each pad. 
You can play any chord type regardless of the key determined by the Scale. Essentially, this is like the Chords 
setting but with more options to play chords out of the set key. 

Progressions: Each pad is assigned a chord in a chord progression. You can play the pads in (or out of) order to 
construct songs quickly. The available chords are determined by the Chord field. 

 

  
Notes in Pad Perform Mode.  Chords in Pad Perform Mode. 

 

  
 Chromatic Chords in Pad Perform Mode.  Progressions in Pad Perform Mode. 

 

 

Use the Scale & Octave fields to determine the root note and the scale type. 

Root Note (pitch and register): This is the starting point of the scale. The available notes are all chromatic notes 
across the range of the pads. The pad that’s assigned the root note will be lit differently (and highlighted in the 
touchscreen) to indicate where the scale starts in each octave. 

Scale Type: This is the scale or mode based on the root note (this is disabled when Type is set to Progressions). 
The available scales are: 

Major Gypsy Dorian
Minor (melodic) Hungarian Gypsy Phrygian
Pentatonic Major Persian Lydian
Pentatonic Minor Major Bebop Mixolydian
Blues (minor) Whole Tone Aeolian
Flamenco Chromatic Locrian
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Use the Chord fields to determine what chord type will play when pressing a pad. The resulting chord will use those scale 
degrees based off of the pad’s root note. You can use this only when the Type is set to Chords or Chromatic Chords. 

When set to Chords, the available chords are: 

1-3-5 (major/minor) 1-3-5-7 (major7/minor7)
1-4-5 (sus4) 1-3-5-7b (dominant)
1-2-5 (sus2)  

 

When set to Chromatic Chords, the available chords are: 

Major Major7 Augmented
Minor Minor7 Diminished
Sus2 Major9 
Sus4 Minor9 

 

Use the Banks selector to determine how the notes are mapped across the pad banks. 

Start on Root: Pad 01 will always be the root note of the scale in every pad bank. 

Continuous: Pad 01 of one bank is always one scale degree higher than Pad 16 of the previous bank. 

 

You can use the buttons at the bottom of the touchscreen to quickly select different Types and Chords: 

Tap Notes to automatically set the Type to Notes. 

Tap 1-3-5 to automatically set the Type to Chords and set the Chord to 1-3-5 (major/minor). 

Tap 1-3-5-7 to automatically set the Type to Chords and set the Chord to 1-3-5-7 (major7/minor7). 

Tap Progressions to automatically set the Type to Progressions. 

Tap Octave –/+ to shift the pad assignments down or up by an octave. 

Press Shift+1-4-5 to automatically set the Type to Chords and set the Chord to 1-4-5 (sus4). 

Press Shift+1-3-5-7b to automatically set the Type to Chords and set the Chord to 1-3-5-7b (dominant). 

Press Shift+Note –/+ to shift the pad assignments down or up by a semitone, essentially raising or lowering the 
Root Note field by a half-step. 
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Pad Color Mode 
 

Pad Color Mode lets you assign specific colors to your pads in each program. 

 

 

To enter Pad Color Mode, make sure you have first 
selected a track that uses the desired program, and then 
press Menu, and tap Pad Color. 

Important: If you are already in Pad Color Mode and want 
to assign pad colors for another program, exit Pad Color 
Mode first, and then select a track that uses the desired 
program in another mode. 

 

Use the field in the upper-left corner to set how the pad 
lights will display: 

Off: The pads will be unlit whether you are playing them 
or not. 

Classic Velocity: The pads will be unlit while you are not playing them. When you press them, they will light with 
colors according to the velocity: red indicates a high velocity, yellow indicates a low velocity. 

Fixed: The pads will be lit with their assigned colors whether you are playing them or not. 

Off->Velocity: The pads will be unlit when you are not playing them. When you press them, they will light with their 
assigned color with a brightness that corresponds with the velocity. 

Dim->Velocity: The pads will be dimly lit when you are not playing them. When you press them, they will light with 
their assigned color with a brightness that corresponds with the velocity. 

Bright->Velocity: The pads will be brightly lit when you are not playing them. When you press them, they will light 
with their assigned color with a brightness that corresponds with the velocity. 

 

Use the Empty Pads field in the upper-left corner to set how empty pads will display: 

Empty pads off: Pads without any sounds will remain off. 

Empty pads dim: Pads without any sounds will remain more dimly lit than pads with sounds assigned. 

Empty pads normal: Pads without any sounds will appear the same as pads with sounds assigned. 

 

Use the Single Pad/All Pads select to determine whether you are setting the color for a Single Pad or All Pads. 

Tip: To quickly assign that color to all pads in the program, press and hold Shift while tapping a color button. 

 

Use the color buttons to select which color you are assigning. 

Tip: To select the color button corresponding a specific pad’s color, press and hold Shift, and then press the 
pad or tap it on the touchscreen. 

 

Press a pad on MPC Live or tap it on the touchscreen to assign the selected color to it. 

 

To make the current pad color settings the defaults for all programs on the same type (e.g., drum programs, 
keygroup programs, etc.), tap Make Default. In the window that appears, tap Do It to confirm your choice or Cancel 
to cancel. 
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Q-Link Edit Mode 
 

Q-Link Edit Mode lets you determine what the Q-Link knobs control in other modes. This is 
helpful when you want to use the Q-Link knobs to control parameters that might not be 
shown in the current mode—or parameters that are shown across different modes. 

 

 

 

To select an edit mode for the Q-Link knobs, tap one of the five buttons at the bottom of the touchscreen:  

Project: In this edit mode, the Q-Link knobs can control 16 parameters within the current project overall. 
See the following Project section to learn about this specific Q-Link Edit Mode. 

Program: In this edit mode, the Q-Link knobs can control 16 program parameters. See the following 
Program section to learn about this specific Q-Link Edit Mode. 

Pad Scene (for drum programs only): In this edit mode, the Q-Link knobs can control 16 parameters for the 
currently selected pad. See the following Pad Scene section to learn about this specific Q-Link Edit Mode. 

Pad Parameters: In this edit mode, the 16 Q-Link knobs correspond to the 16 pads, each one controlling 
the same parameter for each pad. This is useful if you need to adjust the same parameter on multiple pads 
at once rather than having to select and edit each pad individually. See the following Pad Parameters 
section to learn about this specific Q-Link Edit Mode. 

Screen: In this edit mode, the Q-Link knobs will control a parameter or group of parameters in your 
currently selected mode (e.g., Main Mode, Sample Edit Mode, etc.). These parameters are outlined in gold 
and sometimes have a Q in the corner. 

 

Use the Track field to select a track that uses the desired program (and therefore pad/pads). The contents of the 
screen below will vary based on (1) the type of program each track uses and (2) the Q-Link Edit Mode you selected. 
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Tap the Learn button to turn Learn Mode on or off. When on, adjusting a control in the MPC software window will 
immediately assign it to the currently selected Q-Link knob.  

This button is not available while in Screen Q-Link Edit Mode where the Q-Link knobs are unassignable. 

To assign a function to a Q-Link knob in Learn Mode: 

1. Tap Learn so the button is lit. (This will stop playback. Resuming playback will exit Learn Mode.) 

2. Touch or turn the desired Q-Link knob. 

3. In the MPC software on your computer, click and drag the slider or knob you want to assign to the Q-Link knob. 
The Q-Link knob will be able to control that parameter immediately. 

To assign functions to other Q-Link knobs, repeat Steps 2–3. 

To exit Learn Mode, tap Learn (or resume playback). 

 

The automation button indicates the global automation state. This is shown in several modes. See General Features 
> Automation to learn about this. 

 

At any time, in any mode, you can show the QLink window over the touchscreen’s current contents. These are the 
same parameters and settings as what is shown in Q-Link Edit Mode.  

To show the QLink window, press and hold the Q-Link button. 

To close the QLink window, release the Q-Link button. 

 

 

 

While the QLink window is shown: 

To select a column or row of knobs, tap it. 

To adjust the settings of the selected knobs, turn the corresponding Q-Link knobs on MPC Live. 

To select an edit mode for the Q-Link knobs, tap one of the five buttons at the bottom of the touchscreen: 
Project, Program, Pad Scene, Pad Parameter, or Screen. 

To turn Learn Mode on or off, tap Learn. (This button is not available while in Screen Q-Link Edit Mode where 
the Q-Link knobs are unassignable.) 

To enter Q-Link Edit Mode immediately (regardless of the current mode), tap Q-Link Edit at the bottom of the window. 
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Project 

 

In the Project Q-Link Edit Mode, the Q-Link knobs control 16 parameters within the current project. 

 

 

 

Next to the top row of Q-Link knobs in the touchscreen, tap one of these tabs to select the type of parameters you 
want to control with the Q-Link knobs: 

MIDI Track: MIDI track parameters. Use the MIDI Track field to select one of the MIDI tracks in your project. 

Audio Track: audio track parameters. Use the Audio Track field to select one of the audio tracks in your project. 

Program: program parameters. Use the Program field to select one of the programs in your project. 

Return: return parameters. Use the Return field to select one of Returns 1–4. 

Submix: submix parameters. Use the Submix field to select one of Submixes 1–8. 

Master: master parameters. Use the Master field to select one of the output pairs: Outputs 1/2–7/8 in Standalone 
Mode or Outputs 1/2–31/32 in Controller Mode (MPC Live does not use Outputs 7/8 but displays them to maintain 
compatibility with MPC X, which does use them). 

 

Next to the second row of Q-Link knobs in the touchscreen, tap one of these tabs to select the type of parameters 
you want to control with the Q-Link knobs: 

Mixer: general mixer parameters 

Program (in the Program tab if a drum program or clip program is selected): program parameters 

Insert 1–4 (not available in the MIDI Track tab or Program tab if a MIDI program is selected): parameters for its 
program insert effects 

 

If the Program tab is selected, use the Type selector to determine whether the Q-Link knobs will control the parameters 
of the entire program (Program) or for a single pad (Pad). 

To select a program, use the Program field next to the top row of Q-Link knobs in the touchscreen. 

To select a pad (if Type is set to Pad), use the Pad field. 

 

Use the Parameter field to select the parameter you want to control with the currently selected Q-Link knob. 

 

Tap the Momentary checkbox to turn momentary behavior on or off.  

When on, moving the Q-Link knob will adjust its parameter, but the parameter will immediately return to its original 
position (when you turned Momentary on) when you release the Q-Link knob. 

When off, moving the Q-Link knob will adjust its parameter, and the parameter will remain at its new setting when 
you release the Q-Link knob. 
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Program 

 

In the Program Q-Link Edit Mode, the Q-Link knobs control 16 parameters within the currently selected program. 

 

 

 

Next to the top row of Q-Link knobs in the touchscreen, tap one of these tabs to select the type of parameters you 
want to control with the Q-Link knobs: 

Mixer: general mixer parameters 

Program: program parameters 

Insert 1–4: parameters for its program insert effects 

 

Use the Type selector to determine whether the Q-Link knobs will control the parameters of the entire program 
(Program) or for a single pad (Pad).  

To select a program, use the Track field at the top of the touchscreen to select a track that uses it. The program 
name will appear in the Program field next to the top row of Q-Link knobs in the touchscreen. 

To select a pad (if Type is set to Pad), use the Pad field. 

 

Use the Parameter field to select the parameter you want to control with the Q-Link knobs. 

 

Tap the Momentary checkbox to turn momentary behavior on or off.  

When on, moving the Q-Link knob will adjust its parameter, but the parameter will immediately return to its original 
position (when you turned Momentary on) when you release the Q-Link knob. 

When off, moving the Q-Link knob will adjust its parameter, and the parameter will remain at its new setting when 
you release the Q-Link knob. 
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Pad Scene 

 

In the Pad Scene Q-Link Edit Mode, the Q-Link knobs control your favorite 16 parameters for the currently selected 
pad. You can select another pad simply by pressing it, allowing you to adjust the same 16 parameters for that new 
pad. (These 16 parameter assignments are automatically saved with other user settings. Any project you load will use 
these assignments.) 

 

 

 

To select a pad, press it. 

 

Next to the top row of Q-Link knobs in the touchscreen, tap one of these tabs to select the type of parameters you 
want to control with the Q-Link knobs: 

Mixer: general mixer parameters 

Program: pad parameters (i.e., parameters used in Program Edit Mode) 

 

Use the Parameter field to select the parameter you want to control with the Q-Link knobs. 

 

Tap the Momentary checkbox to turn momentary behavior on or off.  

When on, moving the Q-Link knob will adjust its parameter, but the parameter will immediately return to its original 
position (when you turned Momentary on) when you release the Q-Link knob. 

When off, moving the Q-Link knob will adjust its parameter, and the parameter will remain at its new setting when 
you release the Q-Link knob. 
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Pad Parameters 

 

In the Pad Parameters Q-Link Edit Mode, the Q-Link knobs control the same pad parameter for the each of the 16 
pads in the current pad bank. 

For example, if the Parameter is set to Level, the 16 Q-Link knobs will adjust the 16 independent Level settings for 
each pad in the current pad bank. You could then set the Parameter to Pan and use the Q-Link knobs to adjust the 
panning of all 16 pads. 

 

 

 

Next to the top row of Q-Link knobs in the touchscreen, tap one of these tabs to select the type of parameter you 
want to control with the Q-Link knobs: 

Mixer: general mixer parameters 

Program: pad parameters (i.e., parameters used in Program Edit Mode) 

  

Use the Parameter field to select the parameter you want to control with the Q-Link knobs. 

 

Tap the Momentary checkbox to turn momentary behavior on or off. 

When on, moving the Q-Link knob will adjust its parameter, but the parameter will immediately return to its original 
position (when you turned Momentary on) when you release the Q-Link knob. 

When off, moving the Q-Link knob will adjust its parameter, and the parameter will remain at its new setting when 
you release the Q-Link knob. 
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Screen 

 

In the Screen Q-Link Edit Mode, the Q-Link knobs will control only the parameter or group of parameters in your 
currently selected mode (e.g., Main Mode, Sample Edit Mode, etc.). These parameters are outlined in gold and 
sometimes have a Q in the corner. 
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MIDI Control Mode 
 

You can use MIDI Control Mode on your MPC Live to customize what MIDI messages are 
sent from certain controls on your hardware. This custom “control map” will then work 
whenever you are in MIDI Control Mode. The edits you make in MIDI Control Mode will be 
retained with the current MPC project 

In Standalone Mode, this feature enables you to use MPC Live to control external MIDI devices connected to its MIDI out. 

In Controller Mode, this is helpful when using MPC as a plugin: you can use MIDI Control Mode to use your MPC 
Live to control your host software, and then switch back to any other mode to control the MPC plugin.  

 

To enter MIDI Control Mode, press Menu, and then tap MIDI Control. 

Important: 

In Standalone Mode: Make sure your MPC Live is using the correct MIDI output. You can set this in the Preferences 
(see General Features > Menu > Preferences > Hardware). 

In Controller Mode: In your host software, make sure your MPC Live is selected as a MIDI controller device. 

 

To select a control to edit, do any of the following: 

• Press or turn it. In the lower-left corner, tap the Hardware tab to edit a pad, button, or Q-Link knob, or tap 
the XY tab to edit the XY pad. 

• Tap the Control field in the upper-left corner, and then turn the data dial to select one. 

• Double-tap the Control field, and then tap a control name in the menu that appears. 

Note: The Control field menu will show many more hardware controls than are actually available on your MPC Live. 
This is because the list includes all possible controls from all current MPC models (MPC Renaissance, MPC Studio, 
MPC Touch, etc.). You can edit only the controls that are described in this chapter. 

 

In the touchscreen, use the following fields and selectors to set each control’s parameters to your preference. The 
available parameters depend on its type: a pad, or button, a Q-Link knob, or each axis of the XY pad. When you 
have set all of the parameters as desired, you can select another control or enter another mode. 

 

The software window will also display a graphical interface resembling your MPC Live. Editable controls show their 
current MIDI message. Pads and Q-Link knobs show their current MIDI channels. 
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Pads 

 

These are the MIDI parameters you can edit for each pad: 

Control: This is the hardware control you are currently 
editing (Pad 1–Pad 16). 

Bank: This is the pad bank the pad belongs to. If you 
check the Set All box, the pad’s messages and 
parameters will be identical across all eight banks. 

Set All: When this box is checked, the pad’s messages 
and parameters will be identical across all eight banks. 
When this box is unchecked, the pad’s messages and 
parameters will apply to the current pad only. 

Light LED: This determines how the pad’s LEDs will behave. 

When set to Never, the LEDs will always be off. 

When set to MIDI Input, the LEDs will light up when 
the software receives a MIDI message that matches 
the pad. 

When set to Local, the LEDs will light up when you 
press the pad and/or MIDI input is received. 

MIDI Channel: This determines which MIDI channel (1–16) the pad will use to send its message to the software. 

Note: This is the MIDI note number the pad will send to the software when you press it (0–127 or C-2 to G8). 

Velocity: This determines whether the pad will be velocity-sensitive (On) or not (Off). When set to Off, pressing the 
pad will send a note at full-level (127) always. 

Aftertouch: This determines how the pad’s aftertouch (pressure applied to the pad after the initial press) behaves. 

Off: The pad will not send any aftertouch messages. 

Channel: If you press multiple pads that have this setting, the aftertouch messages they send will be identical. 

Poly: If you press multiple pads, the aftertouch message each pad sends will be independent from the others. 

 

Buttons 

 

These are the MIDI parameters you can edit for each button. 
You can edit the Erase, Tap Tempo, Undo/Redo, or 
Copy/Delete buttons: 

Control: This is the hardware control you are currently 
editing (Erase, Tap Tempo, Undo, or Copy).  

Light LED: This determines how the button’s LED (or 
multiple LEDs) will behave. 

When set to Never, the LEDs will always be off. 

When set to MIDI Input, the LEDs will light up when 
the software receives a MIDI message that matches 
the button. 

When set to Local, the LEDs will light up when you 
press the button and/or MIDI input is received. 

MIDI Channel: This determines which MIDI channel (1–16) 
the button will use to send its message to the software. 

CC Number: This determines what MIDI Control Change 
number the button will send to the software. 

Type: This determines whether the button will behave as a 
Momentary switch or Toggle (latching) switch. 
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Q-Link Knobs 

 

These are the MIDI parameters you can edit for each Q-Link 
knob: 

Control: This is the hardware control you are currently 
editing (QLink 1–4). 

Light LED: Although you can edit this parameter, it does 
not actually have a function on MPC Live. 

When set to Never, the LEDs will always be off. 

When set to MIDI Input, the LEDs will light up when 
the software receives a MIDI message that matches 
the Q-Link knob. 

When set to Local, the LEDs will light up when you 
touch or turn the Q-Link knob and/or MIDI input is 
received. 

MIDI Channel: This determines which MIDI channel (1–16) the Q-Link knob will use to send its message to the software. 

CC Number: This determines what MIDI Control Change number the Q-Link knob will send to the software. 

Mode: This determines how the Q-Link knob will control its parameter. 

Absolute: The Q-Link knob’s current position determines its parameter’s value; moving it may cause its 
parameter to “snap” to a new position if you’re using it to control different parameters in different modes. 

Relative: Moving the Q-Link knob will increase or decrease its parameter regardless of its physical position. 

Low Range: This is the Q-Link knob’s lowest possible value (0–127). 

High Range: This is the Q-Link knob’s highest possible value (0–127). 

Touch Sense: This activates or deactivates the Q-Link knob’s touch-capacitive circuitry. 

On: You can touch the Q-Link knob to send a Note On message to the software (this is how your MPC Live 
normally works). 

Off: The Q-Link knob will not send any Note On messages; it will only send CC messages when you turn it. 

Note: This is the MIDI note number the Q-Link knob will send to the software when you touch it (0–127 or C-2 to 
G8). Touch Sense must be set to On for this to work. 

 

 

XY Pad 

 

These are the MIDI parameters you can edit for each axis of 
the XY pad: 

Control: This is the axis you are currently editing (XYFX 
X-Axis or XYFX Y-Axis). This field will be hidden if you 
tapped the XY tab to show the XY pad’s parameters. You 
can tap the Hardware tab to show this field. 

Mute: This button determines whether the axis is muted 
or not. When muted, its MIDI output is disabled. You must 
be viewing the Settings to do this.  

MIDI Channel: This determines which MIDI channel (1–16) 
the axis will use to send its message to the software. 

CC Number: This determines what MIDI Control Change 
number the axis will send to the software. 

Low Range: This is the axis’s lowest possible value (0–127). 

High Range: This is the axis’s highest possible value (0–127). 
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Appendix 
 
Effects & Parameters 
 

This chapter lists the available effects. To learn more about how effects work in MPC Live, please see General 
Features > Effects. 

Note: Some of these effects have a “sync” version (e.g., Flanger Sync, Autopan Sync, etc.) whose rates will be 
affected by the current tempo. While viewing the rate of these effects, a “.” next to the time division indicates a 
triplet-based rate. 

 
 
Reverbs 
 

Options: Reverb Small, Reverb Medium, Reverb Large, Reverb Large 2, Reverb In Gate, Reverb Out Gate 

 

Reverb Small 

This is a spatial effect, designed to emulate a small room. Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50

Pre-Delay 1–100 50

Early Reflection 0–100 50

Density 0–100 50

Diffuse 0–100 50

Decay 0–100 50

Lo-Cut 0–100 15

Hi-Cut 0–100 10

 

Reverb Medium 

This is a spatial effect, designed to emulate a medium room. Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50

Pre-Delay 1–100 50

Early Reflection 0–100 50

Density 0–100 50

Diffuse 0–100 50

Decay 0–100 50

Lo-Cut 0–100 15

Hi-Cut 0–100 10
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Reverb Large 

This is a spatial effect, designed to emulate the sound of a 
large hall. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50

Pre-Delay 1–100 50

Early Reflection 0–100 50

Density 0–100 50

Diffuse 0–100 50

Decay 0–100 75

Lo-Cut 0–100 10

Hi-Cut 0–100 10

 

Reverb Large 2 

This is a less CPU-intensive spatial effect, emulating the 
sound of a large hall. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50

Pre-Delay 1–100 50

Early Reflection 0–100 50

Density 0–100 50

Diffuse 0–100 50

Decay 0–100 75

Lo-Cut 0–100 10

Hi-Cut 0–100 10

 

Reverb In Gate 

This is a hall reverb with an additional control. The reverb 
effect is cut off when the input drops below the level set in 
the Gate In parameter. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50

Pre-Delay 1–100 50

Early Reflection 0–100 50

Density 0–100 50

Diffuse 0–100 50

Decay 0–100 75

Lo-Cut 0–100 10

Hi-Cut 0–100 10

Gate In 0–100 0
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Reverb Out Gate 

This is a hall reverb that has an additional control. The reverb 
effect is cut off when the output drops below the level set in 
the Gate Out parameter. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50

Pre-Delay 1–100 50

Early Reflection 0–100 50

Density 0–100 50

Diffuse 0–100 50

Decay 0–100 75

Lo-Cut 0–100 10

Hi-Cut 0–100 10

Gate Out 0–100 0

 
 
Delays 
 

Delays the original signal for a specified period of time and plays it back over an adjustable period of time. 

Options: Delay Mono, Delay Mono Sync, Delay Stereo, Delay Sync (Stereo), Delay LP, Delay HP, Delay Analog, 
Delay Analog Sync, Delay Tape Sync, Delay Ping Pong, Delay Multi-Tap 

 

Delay Mono 

 Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50

Time 2–2000 ms 100

Feedback 0–100 25

Damping 0–100 100

 

Delay Mono Sync 

 Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50

Time 1 bar – 1/16 triplets 1/4

Feedback 0–100 25

Damping 0–100 100

 

Delay Stereo 

Stereo Delay operates similarly to Mono Delay but in true 
stereo. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50

Time 2–2000 ms 100

Feedback 0–100 25

Damping 0–100 100
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Delay Sync (Stereo) 

Stereo Delay operates similarly to Mono Delay but in true 
stereo. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50

Time 1 bar – 1/16 triplets 1/4

Feedback 0–100 50

Damping 0–100 100

 

Delay LP 

LP Delay is identical to the Mono Delay, but it uses a 
resonant low-pass filter in the delay line. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50

Time 2–2000 ms 500

Feedback 0–100 50

Cutoff 0–100 50

Resonance 0–100 20

 

Delay HP 

HP Delay is identical to the Mono Delay, but it uses a 
resonant high-pass filter in the delay line. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50

Time 2–2000 ms 100

Feedback 0–100 50

Cutoff 0–100 33

Resonance 0–100 33

 

Delay Analog 

Analog Delay is similar to the Mono Delay, except that it’s 
designed to emulate an analog “Bucket Brigade”-style delay. 
This delay has a unique character to it that gives a warmer 
sound by adding subtle inaccuracies in phase and timing. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50

Time 2–2000 ms 100

Feedback 0–100 25

 

Delay Analog Sync 

Analog Delay is similar to Mono Delay, except that it’s 
designed to emulate an analog “Bucket Brigade”-style delay. 
This delay has a unique character to it that gives a warmer 
sound by adding subtle inaccuracies in phase and timing. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50

Time 1 bar – 1/16 triplets 1/4

Feedback 0–100 50

Ramp 0–100 50
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Delay Tape Sync 

Tape Delay emulates a delay system using an analog tape 
loop and a series of tape heads to produce an echo effect. 
This delay type yields a very distinct echo sound often heard 
in reggae and dub-style music. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50

Time 1 bar – 1/16 triplets 1/4

Feedback 0–100 50

Ramp 0–100 50

Head 1 0–100 100

Head 2 0–100 0

Head 3 0–100 0

Head 4 0–100 0

Tone 0–100 50

Spread 0–100 50

Wow & Flutter 0–100 50

 

Delay Ping Pong 

This stereo delay allows you to set different delay times for 
its left and right repeats. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50

Time, Left 2–2000 ms 100

Time, Right 2–2000 ms 100

Feedback 0–100 25

Damping 0–100 100

 

Delay Multi-Tap 

This delay is a mono delay which has three delay generators 
with independently adjustable delay times and stereo 
position. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50

Time 1 2–2000 ms 100

Time 2 2–2000 ms 100

Time 3 2–2000 ms 100

Feedback 0–100 25

Pan 1 0–100 50

Pan 2 0–100 50

Pan 3 0–100 50

Damping 0–100 100

Gain 1 0–100 25

Gain 2 0–100 25

Gain 3 0–100 25
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Flangers 
 

A flanger is a modulated delay to emulate the sound created when running two analog tape machines in parallel with 
a slight time disalignment. Slow Rate settings can produce a “whooshing” jet engine sound, while faster rates result 
in more of a “warble.” 

Options: Flanger, Flanger Sync 
 
Flanger 
 Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Rate 0–100 10

Feedback -100 – 100  0

Delay 0–100 20

Width 0–100 80

 
Flanger Sync 
 Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Rate 8 bars – 1/16 triplets 1/4

Feedback -100 – 100 0

Delay 0–100 20

Width 0–100 80

 
 
Chorus 
 

A chorus effect uses an LFO to modulate the pitch and a delay of the input signal, which are then added to the dry 
signal. In small amounts, this creates the illusion of multiple voices playing at once. Turn up the Feedback and 
Depth for more pronounced “shimmering” and “watery” sounds. 

Options: Chorus 2-Voice, Chorus 4-Voice 
 
Chorus 2-Voice 
 Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Delay 0–100 20

Amount 0–100 80

Width 0–100 80

Feedback 0–100 50

Rate 0–100 10

 
Chorus 4-Voice 
 Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Delay 0–100 20

Amount 0–100 80

Width 0–100 80

Feedback 0–100 50

Rate 0–100 10
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Autopans 
 

This effect uses an LFO to move the incoming signal back and forth across the stereo field, creating a rotary effect. 

Options: Autopan, Autopan Sync 

 

Autopan 

 Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Rate 0–100 10

 

Autopan Sync 

 Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Rate 8 bars – 1/32 1/4

 
 
Tremolos 
 

This effect uses an LFO to increase and decrease the volume of the signal. Depending on the LFO shape, this can 
produce a smooth wave effect (sine wave) or a stuttering “on-off” effect (square wave). 

Options: Tremolo, Tremolo Sync 

 

Tremolo 

 Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Rate 0–100 10

Sine to Square 0–100 (sine–square) 0

 

Tremolo Sync 

 Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Rate 1 bar – 1/16 triplets 1/4

Sine to Square 0–100 (sine–square) 0
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Phasers 
 

The phaser is a classic effect, created by multiple ganged all-pass filters to create “notches,” or sharp spikes, in the 
frequency spectrum. The frequencies of these all-pass filters are usually modulated by an LFO to create a sweeping 
sound. 

Options: Phaser 1, Phaser 2, Phaser Sync 

 

Phaser 1 

 Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Rate 0–100 10

 

Phaser 2 

 Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Rate 0–100 10

 

Phaser Sync 

 Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Rate 1 bar – 1/16 triplets 1/4

 
 
HP (High-Pass) Filters 
 

Options: HP Filter, HP Filter Sweep, HP Filter Sync, HP Shelving Filter 

 

HP Filter 

This effect is a static filter without modulation. Parameter Value Range Default Value

Frequency 10–19999 Hz 1500

Resonance 0–100 0

 

HP Filter Sweep 

This effect is a high-pass filter with its cutoff frequency 
modulated by an LFO. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 80

Low Frequency 0–100 50

High Frequency 0–100 100

Resonance 0–100 33

Rate 0–100 10
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HP Filter Sync 
This effect is a high-pass filter with its cutoff frequency 
modulated by an LFO. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Low Frequency 0–100 0

High Frequency 0–100 100

Resonance 0–100 50

Rate 8 bars – 1/32 1/4

 

HP Shelving Filter 
This filter differs from the standard filter type, as it attenuates 
all frequencies after the cutoff point equally. 

Parameter Value Range Default Value

Frequency 10–19999 Hz 1500

Resonance 0–100 0

Gain -18.0 – 18.0 dB 0.0

 
 
LP (Low-Pass) Filters 
 

Options: LP Filter, LP Filter Sweep, LP Filter Sync, LP Shelving Filter 

 

LP Filter 
This effect is a static filter without modulation. Parameter Value Range Default Value

Frequency 10–19999 Hz 1500

Resonance 0–100 0

 
LP Filter Sweep 
This effect is a low-pass filter with its cutoff frequency 
modulated by an LFO. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 80

Low Frequency 0–100 0

High Frequency 0–100 100

Resonance 0–100 33

Rate 0–100 10

 
LP Filter Sync 
This effect is a low-pass filter with its cutoff frequency 
modulated by an LFO. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Low Frequency 0–100 0

High Frequency 0–100 100

Resonance 0–100 50

Rate 8 bars – 1/32 1/4

 
LP Shelving Filter 
This filter differs from the standard filter type, as it attenuates 
all frequencies after the cutoff point equally. 

Parameter Value Range Default Value

Frequency 10–19999 Hz 1500

Resonance 0–100 0

Gain -18.0 – 18.0 dB 0.0
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Parametric EQs 
 

Options: PEQ 2-Band, 2-Shelf, PEQ 4-Band 

 

PEQ 2-Band, 2-Shelf 

This effect is a combination of one two-band parametric 
equalizer and two shelving filters. 

Parameter Value Range Default Value

Low Frequency 22–1000 Hz 220 

Frequency 1 82–3900 Hz 820 

Frequency 2 220–10000 Hz 2200 

High Frequency 560–19999 Hz 5600 

Q1 0–100 0

Q2 0–100 0

Low Gain -18.0 – 18.0 dB 0.0 

Gain 1 -18.0 – 18.0 dB 0.0 

Gain 2 -18.0 – 18.0 dB 0.0 

High Gain -18.0 – 18.0 dB 0.0 

 

PEQ 4-Band 

This effect is a powerful four-band parametric equalizer with 
four independent EQ ranges. 

Parameter Value Range Default Value

Low Frequency 22–1000 Hz 220

Frequency 1 82–3900 Hz 820 

Frequency 2 220–10000 Hz 2200 

High Frequency 560–19999 Hz 5600 

Q1 0–100 5

Q2 0–100 5

Q3 0–100 5

Q4 0–100 5

Gain 1 -18.0 – 18.0 dB 0.0 

Gain 2 -18.0 – 18.0 dB 0.0

Gain 3 -18.0 – 18.0 dB 0.0 

Gain 4 -18.0 – 18.0 dB 0.0 
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Distortions 
 

Options: Distortion Amp, Distortion Fuzz, Distortion Grimey, Distortion Overdrive, Distortion Custom 

 

Distortion Amp 

This effect is designed to reproduce the sound of a tube 
amplifier at high volumes. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Drive 0–100 50

Tone 0–100 50

Dynamics 0–100 50

Output 0–100 50

 

Distortion Fuzz 

This popular effect uses hard clipping of the audio signal, 
which, at extreme settings, can turn a standard waveform 
into a square wave, producing a “razor” effect. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Drive 0–100 50

Output 0–100 50

Low 0–100 50

Low-Mid 0–100 50

High-Mid 0–100 50

High 0–100 50

 

Distortion Grimey 

This is a unique distortion effect that distorts a frequency
range in a selectable band. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Drive 0–100 50

Grime 0–100 50

Center 0–100 50

Width 0–100 50

Resonance 0–100 50

Output 0–100 50

 

Distortion Overdrive 

This distortion is designed to sound like a mildly distorting 
amplifier at medium volumes. It is the smoothest distortion 
type available. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Drive 0–100 50

Tone 0–100 50

Output 0–100 50
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Distortion Custom 

This effect is a highly customized distortion, capable of a 
wide range of useable sounds. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Drive 0–100 50

+Soft 5–75 2

+Clip 5–50 25

–Soft 5–75 2

–Clip 5–50 25

Low -18.0 – 18.0 dB 0.0 

Mid -18.0 – 18.0 dB 0.0 

High -18.0 – 18.0 dB 0.0 

Output -18.0 – 18.0 dB 50 

 
 
Compressors 
 

A compressor is an effect that changes the dynamic range of a signal by automatically reducing its gain. 

 

Options: Compressor Master, Compressor Opto, Compressor VCA, Compressor Vintage 

 

Compressor Master 

This is the most transparent compressor, able to perform 
substantial volume adjustments without artifacts. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Attack 0–100 50

Release 0–100 50

Threshold -50 – 0 dB 0

Ratio 1–20 1

Oldskool Off, On Off

Output -6 – 24 dB 0

 

Compressor Opto 

The Opto Compressor is modeled after a vintage 
compressor type using an optical circuit to control the 
volume reduction of the input signal. These compressors are 
usually associated with soft and unobtrusive attack and 
release characteristics. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Input -6 – 18 dB 0

Attack 0–100 50

Release 0–100 50

Threshold -50 – 0 dB 0

Ratio 1–20 1

Knee 1–100 1

Output -6 – 24 dB 0
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Compressor VCA 

This compressor is more modern-sounding, with a slightly 
more transparent sound. A VCA Compressor tends to have 
quicker attack and release times than an Opto Compressor. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Input -6 – 18 dB 0

Attack 0–100 50

Release 0–100 50

Threshold -50 – 0 dB 0

Ratio 1–20 1

Knee 1–100 1

Output -6 – 24 dB 0

 

Compressor Vintage 

This compressor has a sound similar to classic tube 
compressors, with their gentle yet pumping response and a 
dash of tube saturation. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Input -6 – 18 dB 0

Attack 0–100 50

Release 0–100 50

Threshold -50 – 0 dB 0

Ratio 1–20 1

Knee 1–100 1

Output -6 – 24 dB 0

 
 
Bit Reducers 
 

Options: Decimator, Resampler 

 

Decimator 

Decimator down-samples the incoming signal by removing 
bits from the digital signal. The difference between 
decimation and resampling is that Decimator does not use 
any filtering to mask or correct digital artifacts. The result is 
an effect ranging from mild to almost completely pure digital 
distortion, depending on the setting and the source material. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Decimate 0–100 0

Bit Reducer 4–32 32 

 

Resampler 

Resampler is similar to Decimator in that it removes bits from 
an incoming signal. The difference is that Resampler applies 
a complex suite of filters and anti-aliasing to attempt to 
retain the original sound quality. This is a method used by 
popular vintage samplers and sampling drum machines from 
the 1980s. Resampler can be used to achieve a “dirty” 
sound on drum loops, without the harshness of distortion. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Rate 0–100 0

Decimate 0–100 0

 

 



 

 
204 

 

 
Other 
 

Options: Auto Wah, Frequency Shifter, Transient Shaper 

 

Auto Wah 

This effect is a low-pass filter modulated by an envelope that 
yields a classic funky “wah-wah”- like sound. The envelope 
is triggered by the incoming signal’s amplitude. The amount 
of the envelope on the cutoff frequency is user-definable. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Resonance 0–100 75

Attack 0–100 30

Release 0–100 30

Center 0–100 50

Sensitivity 0–100 50

 

Frequency Shifter 

A frequency shifter changes the frequencies of an input 
signal by a fixed amount and alters the relationship of the 
original harmonics. This can produce a chorus-like effect as 
well as very crazy artificial timbres. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Frequency -1000 – 1000 0

Asynchrony 0–1000 0

A Pan 0–100 0

B Pan 0–100 100

A Gain 0–100 75

B Gain 0–100 75

 

Transient Shaper 

A transient shaper can be used to enhance or soften the 
Attack and Release phases of audio material. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100

Attack 0–100 50

Release 0–100 50

Output 0–100 50
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Glossary 
 

A lot of the terms in this manual are based on the MPC parameter names. This glossary briefly explains many of the 
technical terms used throughout. 

 

Aftertouch The majority of contemporary keyboards are capable of generating aftertouch messages. On this 
type of keyboard, when you press harder on a key you are already holding down, a MIDI aftertouch 
message is generated. This feature makes sounds even more expressive (e.g., through vibrato). 

Aliasing Aliasing is an audible side effect arising in digital systems as soon as a signal contains harmonics 
higher than half the sampling frequency. 

Amount Describes to which extent a modulation source influences a given parameter. 

Amplifier An amplifier is a component that influences the volume level of a sound via a control signal. It 
can be modulated by a control signal (e.g., generated by an envelope or an LFO). 

Attack An envelope parameter. This term describes the ascent rate of a time-relevant process (e.g., an 
envelope from its starting point to the point where it reaches its highest value). The attack phase 
is initiated immediately after a trigger signal is received (e.g., after you play a note on a trigger 
pad or a keyboard). 

Bit Rate Bit rate (also known as word length), is the number of bits used to store the level information of 
each single sample slice within a whole sample. The higher the bit rate, the more precise the 
information about a sample (i.e., its dynamics’ resolution). Normal audio CDs are 16-bit. MPC 
supports full 24-bit resolution. 

Clipping Clipping is a sort of distortion that occurs when a signal exceeds the maximum value that can be 
handled by a signal processing system it is fed into. The curve of a clipped signal is dependent 
on the system where the clipping occurs. In the analog domain, clipping effectively limits the 
signal to a given maximum level. In the digital domain, clipping is similar to a numerical overflow, 
resulting in negative polarity of the signal’s portions exceeding the maximum level. 

Control Change 
(Controllers) 

MIDI messages enable you to manipulate the behavior of a sound generator to a significant
degree. This message essentially consists of two components: 

• The controller number, which defines the parameter to be influenced. It can range from 0 
to 127. 

• The controller value, which determines the extent of the modification. 

Controllers can be used for effects such as slowly swelling vibrato, changing the stereo panning 
position and influencing filter frequency. 

Cutoff The cutoff frequency is a significant factor for filters. A low-pass filter for example dampens the 
portion of the signal that lies above this frequency. Frequencies below this value are allowed to 
pass through without being processed. 

Decay Decay describes the descent rate of an envelope once the attack phase has reached its 
maximum and the envelope drops to the level defined by the sustain value. 

Envelope An envelope is used to modulate a sound-shaping component within a given time. For instance, 
an envelope that modulates the cutoff frequency of a filter opens and closes this filter over a 
period of time. An envelope is started via a trigger, usually a MIDI note. The classic ADSR 
envelope consists of four individually variable phases: attack, decay, sustain, and release. 
Attack, decay and release are time or slope values, while sustain is an adjustable level. Once an 
incoming trigger is received, the envelope runs through the attack and decay phases until it 
reaches the programmed sustain level. This level remains constant until the trigger is terminated. 
The envelope then initiates the release phase until it reaches the minimum value. 
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Filter A filter is a component that allows some of a signal’s frequencies to pass through it and dampens 
other frequencies. The most important aspect of a filter is the filter cutoff frequency. Filters generally 
come in four categories: low-pass, high-pass, band-pass, and band-stop. These are the available 
filters in MPC Live: 

A low-pass filter (the most common type) dampens all frequencies above the cutoff frequency. 

A high-pass filter in turn dampens the frequencies below the cutoff.  

A band-pass filter allows only those frequencies around the cutoff frequency to pass. All others 
are dampened. 

A band-stop filter does the opposite of a band-pass: it dampens only the frequencies around the 
cutoff frequency. 

A band-boost filter boosts the frequencies around the cutoff frequency, similar to what a band on 
an equalizer would do. All other frequencies pass through normally. 

The number of poles in a filter’s “slope” determines how extreme or subtle the effect of the filter 
will be. Filters with one or two poles produce a more subtle sound while filters with six or eight 
poles are much more pronounced. 

In MPC Live, the Model filters are analog-style emulations of famous vintage synth filters. Model1 
is a four-pole filter that distorts at high input levels. Model2 uses a mellow resonance with a 
“fattening” distortion in the lower frequencies. Model3 can produce howling, piercing resonances 
and extreme sub frequencies—watch your speakers! 

In MPC Live, the Vocal filters are formant filters that emulate the human voice. Vocal1 produces 
“ah” and “ooh” vowel sounds. Vocal2 uses three bands to produce “oh” and “ee” vowel sounds. 
Vocal3 uses five bands to emulate an idealized model of the vocal tract. 

In MPC Live, MPC3000 LPF is a dynamic, resonant low-pass filter (12 dB/oct) that was used on 
the original MPC3000, released in 1994. 

Please also see the entry for Resonance, an essential characteristic of a filter’s sound. 

LFO LFO is an acronym for low-frequency oscillator. The LFO generates a periodic oscillation at a low 
frequency and features variable waveshapes. Similar to an envelope, an LFO can be used to 
modulate a sound-shaping component. 

MIDI MIDI stands for musical instrument digital interface. Developed in the early 1980s, MIDI enables 
interaction between various types of electronic music instruments from different manufacturers. At 
the time a communications standard for heterogeneous devices did not exist, so MIDI was a 
significant advance. It made it possible to link various devices with one another through simple, 
standardized connectors. 

Essentially, this is how MIDI works: One sender is connected to one or several receivers. For 
instance, if you want to use a computer to play a MIDI synthesizer, the computer is the sender and 
the synthesizer acts as the receiver. With a few exceptions, the majority of MIDI devices are 
equipped with two or three ports for this purpose: MIDI In, MIDI Out and in some cases MIDI Thru. 
The sender transfers data to the receiver via the MIDI Out jack. Data are sent via a cable to the 
receiver’s MIDI In jack. 

MIDI Thru has a special function. It allows the sender to transmit to several receivers. It routes the 
incoming signal to the next device without modifying it. Another device is simply connected to this 
jack, thus creating a chain through which the sender can address a number of receivers. Of course 
it is desirable for the sender to be able to address each device individually. To achieve this, a MIDI 
channel message is sent with each MIDI event. 

MIDI Channel This is a very important element of most messages. A receiver can only respond to incoming 
messages if its receive channel is set to the same channel as the one the sender is using to transmit 
data. Subsequently, the sender can address specific receivers individually. MIDI Channels 1–16 are 
available for this purpose. 

MIDI Clock The MIDI clock message transmits real-time tempo information to synchronize processes among 
several connected devices (e.g., a sound generator’s delay time to a MIDI sequencer). 
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Modulation A modulation influences or changes a sound-shaping component via a modulation source. 
Modulation sources include envelopes, LFOs or MIDI messages. The modulation destination 
is a sound-shaping component such as a filter or a VCA. 

Note On & Note Off This is the most important MIDI message. It determines the pitch and velocity of a generated 
note. A note-on message will start a note. Its pitch is derived from the note number, which 
can range from 0 to 127. The velocity lies between 1 and 127. A velocity value of 0 is 
equivalent to a note-off message. 

Normalize Normalization is a function to raise the level of a sample to its maximum (0 dB) without 
causing distortion. This function automatically searches a sample for its maximum level and 
consequently raises the entire sample’s level until the previously determined maximum level 
reaches 0 dB. In general this results in a higher overall volume of the sample. 

Panning The process or the result of changing a signal’s position within the stereo panorama.

Pitch-Bend Pitch-bend is a MIDI message. Although pitch-bend messages are similar in function to 
control change messages, they are a distinct type of message. The resolution of a pitch-
bend message is substantially higher than that of a conventional controller message. The 
human ear is exceptionally sensitive to deviations in pitch, so the higher resolution is used 
because it relays pitch-bend information more accurately. 

Program A program is a file that contains a list of all samples to be used, and settings for each sample 
(e.g., pad assignments, loop points, pitch tuning, effects, etc.) MPC’s Program Edit Mode is 
where you can edit and assign samples. You can have a total of 128 programs in a project. 

There are two kinds of programs that use samples for their sound source: drum programs, 
mostly used for creating drum programs and easy and quick assigning of samples to a pad, 
and keygroups programs. With keygroup programs, you can use one sample (or more) and 
spread it across two or more keys and play the sample chromatically over a keyboard. That 
way, there is no need to sample every key of, for instance, a piano. 

Program Change These are MIDI messages that select sound programs. Programs 1 through 128 can be 
changed via program change messages. 

Release An envelope parameter. This term describes the descent rate of an envelope to its minimum 
value after a trigger is terminated. The release phase begins immediately after the trigger is 
terminated, regardless of the envelope’s current status. For instance, the release phase may 
be initiated during the attack phase. 

Resonance Resonance or emphasis is an important filter parameter. It emphasizes the frequencies around 
the filter cutoff frequency by amplifing them with a narrow bandwidth. This is one of the most 
popular methods of manipulating sounds. If you increase the emphasis to a level where the 
filter enters a state of self-oscillation, it will generate a relatively pure sine waveform. 

Root Key The root key defines the original pitch of a recorded instrument or of a sample. Samples in 
MPC Live contain the dedicated root key information. This information will be created 
automatically during recording or importing. 

Sample When you tap the pads on your MPC hardware, you can trigger sounds that we call 
samples. Samples are digitized snippets of audio that can be recorded using the recording 
(sampling) function of your MPC Live or loaded from the Browser. 

You can edit and process a sample in different ways. For example, a sample can be 
trimmed, looped, pitch-shifted or processed, using various effects. When you have finished 
editing your sample, you can assign it to one or more drum pads to play it. Samples can be 
either mono or stereo. 

Sample Rate This is the frequency representing the amount of individual digital sample scans per second 
that are taken to capture an analog siginal digitally. For normal CD audio recordings, 44100 
samples per second are used, also written as 44.1 kHz. MPC Live offers sampling rates up 
to 96 kHz. 
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Sequence A sequence is the most basic building-block of music you can compose on MPC Live. MIDI 
information from the MPC hardware pads, buttons, and Q-Link knobs are recorded to the 
tracks of a sequence. Each sequence contains 64 tracks. Each project can store up to 128 
separate sequences. 

The length of a sequence can be set from 1 to 999 bars, which would be enough to create an 
entire song using only one sequence. However, MPC Live has a dedicated Song Mode that 
lets you chain sequences together to create a song. 

Song MPC Live’s Song Mode that allows you to arrange different sections (verse, chorus, hook, 
etc.) in order to build a song. Each song can have up to 999 “steps” (stages in which a 
sequence may play one or more times). Each project can store up to 32 songs. 

Sustain This term describes the level of an envelope remaining constant after it has passed the attack 
and decay phases. Once reached, the sustain level is kept until the trigger is terminated. 

Track A sequence contains 64 tracks and each track can record notes and controller data. For 
example, you can record the verses of a song on Track 1, while recording the choruses on 
Track 2. Alternatively, you can record different instruments on each track. 

Note that your performances are recorded as MIDI events and the actual digital audio is not 
recorded onto a track. That way, you can edit your performance in many different ways once 
the performance has been captured. 

Trigger A trigger is a signal that initiates events. Trigger signals are very diverse. For instance, a MIDI 
note or an audio signal can be used as a trigger. The events a trigger can initiate are also 
very diverse. A common application for a trigger is its use to start an envelope. 

 

 

SATA Drive Installation 
 

To create more internal storage space on your MPC Live, you can purchase a SATA (Serial ATA) drive and install it 
yourself, but read this chapter first. 

Your MPC Live can support nearly any standard 2.5” SATA drive on the market—either a solid-state drive (SSD) or 
hard-disk drive (HDD). Make sure it uses a 2.5” (63.5 mm) form factor and uses (or can use) one of these file systems: 
exFAT, FAT32, NTFS, or EXT4 (for read and write capability) or HFS+ (for read-only capability). 

Note: We recommend using an exFAT file system as it is the most robust one supported by both Windows and Mac OS X. 

Note: Alternatively, you could install an mSATA (mini-SATA) drive, but make sure you also purchase an adapter that 
enables it to fit into a typical 2.5” SATA interface. 

 

1. Locate the SATA drive panel in the center of the bottom panel of MPC Live. Use a Phillips-head screwdriver to 
remove the screws (don’t lose them!), and remove the SATA drive panel. 

2. Gently pull the SATA connector and cable out from inside MPC Live. Be careful not to disturb anything inside—
handle just the SATA connector and cable. 

3. Connect your SATA drive to the SATA connector. Make sure the connection is secure. 

4. Use four 3x5mm mounting screws (included with MPC Live or with your SATA drive) to secure the SATA drive 
to the SATA drive panel. Do not overtighten the screws, but make sure the drive is secure and does not shake.  

5. Place the SATA drive panel back onto the bottom panel of MPC Live, and use the original screws to secure it in 
place. 

You can now access this drive while using MPC Live! 

In Standalone Mode, this drive will appear as a second internal drive. 

In Controller Mode, this drive will appear as another drive connected to your computer (just as a USB drive or SD 
card connected to MPC Live does). 
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Technical Specifications 
 

Pads (16) velocity- and pressure-sensitive pads, RGB-backlit 

(8) banks accessible via Pad Bank buttons 

Knobs (4) 360° touch-sensitive Q-Link knobs

(4) Q-Link knob columns accessible via Q-Link button 

(1) 360° encoder for navigation and selection via push 

Buttons (22) dedicated function buttons; red-, amber-, or green-backlit 

Display 6.9” / 176 mm (diagonal)

5.9” x 3.7” / 150 x 93 mm (width x height) 

Full-color LED-backlit display with touch interface 

CPU Processor: 1.8 GHz quad-core ARM® Cortex® A17 processor 

RAM: 2 GB 

Storage: 16 GB (user storage, 10 GB pre-installed content), 4 GB (MPC operating system) 

File System Compatibility exFAT (read & write) (recommended)

FAT32 (read & write) 

NTFS (read & write) 

EXT4 (read & write) 

HFS+ (read only) 

Connections (2) 1/4” (6.35 mm) TRS inputs (1 stereo pair)

(6) 1/4” (6.35 mm) TRS outputs (3 stereo pairs) 

(1) 1/8” (3.5 mm) stereo headphone output 

(2) RCA inputs (1 stereo pair) 

(2) 5-pin MIDI inputs 

(2) 5-pin MIDI outputs 

(2) USB Type-A ports 

(1) USB Type-B port 

(1) SD card slot 

(1) power adapter input 

Power via power adapter: 19 V, 3.42 A, center-positive, included 

via battery: lithium-ion, rechargeable, up to 4 hours of battery life 

Dimensions  
(width x depth x height) 

16.7” x 8.8” x 2.7”

424 x 224 x 69 mm 

Weight 5.9 lbs. 

2.7 kg 

 
Specifications are subject to change without notice. 
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Trademarks & Licenses 
 

Akai Professional and MPC are trademarks of inMusic Brands, Inc., registered in the U.S. and other countries. 

AAX and RTAS are trademarks or registered trademarks of Avid Technology, Inc. in the U.S. and other countries. 

ARM and Cortex are registered trademarks of ARM Limited (or its subsidiaries) in the EU and/or elsewhere. All rights 
reserved. 

ASIO, Cubase, and VST are trademarks of Steinberg Media Technologies GmbH. 

The Bluetooth word mark and logos are registered trademarks owned by Bluetooth SIG, Inc. and any use of such 
marks by Akai Professional is under license. 

MPC software incorporates élastique Pro V3 by zplane.development. 

Mac and OS X are trademarks of Apple Inc., registered in the U.S. and other countries. 

SD and SDHC are registered trademarks of SD-3C, LLC. 

Windows is a registered trademark of Microsoft Corporation in the United States and other countries. 

All other product names, company names, trademarks, or trade names are those of their respective owners. 

For complete legal information, visit akaipro.com/product-legal 

 

 

http://www.akaipro.com/product-legal
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